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Autodesk Civil 3D algkursus

Sissejuhatus

Kursuse eesmirgiks on anda esmased teadmised Autodesk Civil 3D tarkvarast detailplaneeringu
koostamise seisukohast, kaasates nii olemasoleva maapinnamudeli importimist, sdidutee
projekteerimist, torustike planeerimist aga ka projekti 16pp-dokumentatsiooni véljatriikki.
Algkursusel ei poorata tdhelepanu erinevate seadistuste tegemisele, mis on vajalikud niiteks
tarkvara rakendamiseks firma- ja/voi standarditest 1ahtuvalt.

Eeldused

Kursus on mdeldud ennekdike neile, kes on ldbinud AutoCAD / AutoCAD LT sissejuhatava
kursuse ning kasutanud tarkvara aktiivselt oma t60s ennekdike 2D tasemel (AutoCAD
edasijoudnute kursuse ldbimine soovituslik). Koolitusprogramm on {iles ehitatud {ihe
tervikprojekti nditel, kus tegeletakse pohisammude Oppimisega. Soovitav on omada ka
pohiteadmisi operatsioonisiisteemist Windows 10.

Koolitusmaterjal

Kursuse néiteiilesannete sammud on salvestatud eraldi failidesse. Seega kui moni {ilesanne jddb
pooleli saad seda hiljem jitkata monest eelsalvestatud failist. Koolitusmaterjalis on viidatud
failinimele, millest tuleks protseduure jétkata.

PGhiteemade kohta leiab tdiendavalt ka eesti keelseid videoid aadressilt:
http://www.youtube.com/eraido, esitusnimekiri Autodesk Civil 3D.
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Autodesk Civil 3D kasutajaliides
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Nimetus Asukoht Mirkus
(1) | Application Ulal vasakus nurgas Failidega seotud tegevused
Menu (uue faili loomine, avamine,
printimine, eksport jt)
(2) | Ribbon Késureale (8): ribbon Pohitéovahendid jaotatuna
paanidele (Home, Insert, ...).
Iga paan oma tahvlite ning
toovahenditega. To6vahendid,
mis ei mahu dra — ndidatakse
viikese noolekesega.
(3) | Toolspace Paan (2): Home > Palettes Autodesk Civil 3D keskne
Késureale (8): toolspace palett, kus asuvad objektid,
seaded (stiilid).
(4) | Inquiry Tool Paan (2): Analyze > Inquiry To6vahend, mis voimaldab
Késureale (8): showinquiry saada infot sinu poolt lisatud
objektidelt
(5) | Panorama Paan (2): Home > Palettes Dialoog, mille kaudu saab
Késureale (8): showpanorama vaadata/redigeerida joonise
infot ning parameetreid.
(6) | Properties Paan (2): Home > Palettes Objektide omadused, seaded.
Késureale (8): ch
(7) | Transparent Paan (2): View > User Interface > | Eritd6vahendid.
Commands > Toolbars > Civil
(8) | Command Paan (2): Home > Palettes Késurida.
Window Kiirvalikuklahv: CTRL+9
(9) | Drawing area Joonise ala.
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Tooleht - Autodesk Civil 3D kasutajaliides

Antud iseseisva t60 eesmirk on proovida leida tarkvara kdige olulisemaid kasutajaliidese
komponente ning viia 1dbi lihtsaid tegevusi Autodesk Civil 3D tarkvaras.

Tarkvara failimeniiii (Application menu) kasutamine

1)
2)
3)
4)

Kaéivita Autodesk Civil 3D tarkvara

Vali Application menu > Open > Drawing

Vali fail 01 _User Interface.dwg.

Ava uuesti Application menu ning pane tdhele, et enamus késkusid on seotud faili
endaga (loomine, avamine, salvestamine, printimine jne).

Riba (ribbon) kasutamine

1)
2)

3)
4)

5)

Vali paan Home (tegemist on paaniga, kus on enamkasutatavad toovahendid)

Liigu tahvlile Create Design, ning pane tdhele selle nime korval olevat allapoole
suunatud kolmnurka, kliki sellel — avaneb lisat6ovahendite tahvel

Liigu paanile Insert (tegemist on paaniga, kus saad sisestada erinevaid teisi joonise
tiitipe)

Navigeeri ka teisi paane ning piitia kokku viia paani nimetus ning seal olevad
toovahendid.

Vasakus jooniseaknas suurenda joonist kuniks néed tee telgjoont (tegemist on Autodesk
Civil 3D objektiga Alignment). Kliki iihel telgjoontest ning pane téhele, et kuvatakse
uus riba paan.

Toolspace kasutamine — Prospector paan

1)
2)
3)
4)

S)

Ava Toolspace, mille leiad Home paanilt.

Vali paan Prospector

Kliki ridade ees olevatel plussmérkidel, et ndha alamstruktuuri

Vali Alignment > Centerline Alignments > Main Road A > Profiles (profiil on seotud
telgjoonega)

Kliki vasakus vaateaknas. Seejarel Prospector > parem klikk Side Road B peal > Zoom
to. Pane tihele, et Prospector teab, kus asub Side Road B ja suurendab vastavalt.

Toolspace kasutamine — Settings paan

1)
2)

3)

Vali Toolspace > Settings

Laienda Surface > Surface Styles. Pane tdhele, et kuvatakse stiilide nimekiri. Need
stiilid mééravad, kuidas ndidata maapinda joonises.

Laienda Surface > Label Styles > Contour. Siin all olevad stiilid kontrollivad siltide
esitust, mida kasutatakse pinnaobjekti annoteerimisel.
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Panorama kasutamine

2)

Ava Home paan, laienda sektsioonis Palettes ja vali Event Viewer.

Vajuta ESC klahvi, et tiihistada teiste objektide valik. Vali iiks kontuurjoontest,
kuvatakse riba paan Tin Surface: Existing Ground.

Vali Analyze > Volumes Dashboard.

Pane tihele, et valitud paani kuvatakse Events paani kdrval (Panorama aknas).

Sulge Panorama aken.

Transparent Commands kasutamine

1)
2)
3)
4)
S)
6)

Sisesta kdsureale kdsk Line ning vajuta ENTER.

Kui palutakse valida alguspunkt, vali mistahes punkt vasakus vaateaknas.

Kui palutakse valida jargmine punkt, vali Transparent Commands > Bearing Distance.
Kui palutakse valida Enter quadrant, sisesta 1 voi vali hiirega iilemine parem sektor.
Kui palutakse sisestada Bearing, sisesta 45 ning vajuta ENTER.

Kui palutakse sisestada distants, sisesta 150 ning vajuta ENTER. Vajuta ESC klahvi
kaks korda, et vdljuda késust. Sellega joonestasid sa joone, mis on 150 meetrit pikk ning
suunaga N 45° E.

Inquiry Tool kasutamine

1)
2)
3)

4)
S)
6)

Vali Analyze > Inquiry Tool.

Select an inquiry type > Point > Point Inverse.

Kui palutakse médrata esimene punkt hoia all Shift klahvi, parem klikk ning vali
Endpoint (avanevast meniiiist).

Kliki eelnevalt joonestatud joone 16pp-punkt.

Vali uuesti Shift+parem klikk ning vali niiiid teine joone otspunkt.

Vaata Inquiry Tool aknas sektsioone Direction ning Horizontal Distance. Pane téhele,
et need kuvavad sama infot, mida eelnevalt sisestasid.
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Autodesk Civil 3D diinaamiline keskkond

Autodesk Civil 3D joonis pOorleb objektide ning objekti stiilide timber. Objekt on joonise
intelligentne tiikike, mis sisaldab endas infot aga ka voimet mdjutada teisi objekte joonises. Stiil
on seadete grupp, mis méérab objekti esituse ning kditumise. Objektid on nditeks pinnaobjekt
(surface), telgjoon (alignment), profiil (profile), krunt (parcel). Koiki neid objekte saab
kontrollida stiilide kaudu. Sildid, mis esitavad mingit infot objekti kohta, on samuti
klassikalised objektid, mida saab redigeerida l&bi stiili. Silte on erinevat tiitipi. Niiteks
korgusmargi silt (spot elevation label), telgjoone positsiooni nihke silt (alignment station ofset
label), profiili kallaku muutuse silt (profile grade break label), krundi segmendi silt (parcel
segment label). Uks olulisemaid Autodesk Civil 3D omadusi on objektide omavaheline siduvus.
Naiteks tee disaini juures lood sa esmalt 2D telgjoone, seejiarel paned paika korguslikud
erinevused olemasoleva olukorraga, viimaks disainid sdidurajad, sdiduteeddrise (ddrekivi),
konnitee, - mis koik ldhtuvad sellest 2D telgjoonest. Lisaks on vaja disainida ka sdidutee dérsed
kraavid (tagamaks sademete dravoolu). Juhul kui 2D telgjoone paigutust/parameetreid on vaja
muuta, siis mdjutab see ka kdiki teisi objekte, mis sellega on seotud. Uks lihtne objektipunktiga
teostatud muudatus pdhjustab terve rida erinevaid automatiseeritud tegevusi, mis ongi Autodesk
Civil 3D diinaamilise keskkonna suur eelis. Uhes objekti (vdi selle parameetri) muutusega
muutub ka sellega seotud sildi andmestik.

Autodesk Civil 3D on mudelprojekteerimise tarkvara, mis voOimaldab kaasata
ehitusinfomodelleerimise kontseptsiooni (BIM - Building Information Modelling). Autodesk
Civil 3D mudeleid saab eksportida masinkoodi nii, et ehitusmasinad saavad projekteeritu GPS
koordinaatide jérgi teostada. Lisaks saame teostada erinevat liiki simulatsioone, 4D (3D mudel
+ aeg) ning 5D (3D + aeg + maksumus) ja visualiseerida projekti olemust erinevatele
partneritele/klientidele.

Meeskonnatdds on oluline, et ithe joonise objektid oleksid kittesaadavad teise joonise
objektidele. Teisisonu, et erinevad osapooled saaksid omavahel sama ja kdige virskemat infot
jagada (aluseks votta). Selleks kasutatakse andmestiku linke (data shortcut).
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Tooleht - Autodesk Civil 3D diinaamiline keskkond

Jargnev ndide kaasab endas objekti stiilide vahetamist.

1)
2)
3)
4)

S)
6)
7)
8)

9)

Ava joonis 02_Objects and Styles.dwg.

Vali iiks kontuurjoontest, et valida pinnaobjekt.

Vali Home > Properties.

Properties paletil muuda Style > Elevation Banding (2D) (kuvatakse korgusvahemikud
varvikoodis).

Vali Style > Contours & Triangles (nn kolmnurk esitus).

Vali Style > 0.5m and 2.5m (Design).

Vali Style > 0.5m and 2.5m (Background) (kuvatakse kontuurjooned).

Pinnaobjekt on endiselt valitud. Riba pealt Tin Surface: Existing Ground ning vali
Surface Properties > Edit Surface Style.

Vali paan Display, kliki Major Contour > Color veerus.

10) Vali moni muu vérvitoon ning vajuta OK. Vajuta veelkord OK, et véljuda dialoogist.

Pane tihele, et osad kontuurjoonte vérvitoonid on muutunud.

Jargnev ndide kisitleb siltide stiilide redigeerimist ning kuva.

1)
2)
3)
4)
5)

6)
7)

8)

Ava joonis 02 _Labels and Styles.dwg.

Ulemises paremas vaateaknas vali silt ning seejérel riba peal Home > Properties.
Muuda Station Offset Label Style > Station and Offset.

Muuda Station Offset Label Style > Station and Offset — Existing.

Endiselt on silt valitud, vali riba paanil Labels — Alignment Station Offset Label > Label
Properties > Edit Label Style.

Dialoogis Station Offset Label Style > vali Edit Current Selection.

Dialoogis Label Style Composer vali paan Dragged State. Vali Leader > Visibility >
False.

Vajuta OK nuppu (kaks korda), et vdljuda dialoogidest. Silti on uuendatud l&htuvalt
stiilide parameetritest.

Jargnev ndide késitleb objektide omavahelisi seoseid.

1)
2)
3)
4)

5)

Ava joonis 02_Object Relationships.dwg.

Liilita vdlja Osnap (nditeks F3 klahviga).

Vali iilemine parempoolne vaateaken (sdidutee profiili vaade). Must joon esitab
kdrgusjoone, sinine joon sademeveetoru.

Vali must joon. Suurenda vaadet, kuni nded kolmnurkset objektipunkti (kahe joone
murdepunktis).

Tiri objektipunkti otse iiles (vorgustiku iilemisse serva). Pane tdhele, kuidas tlilejaanud
vaadetes disaini kuva muutub (nditeks sademeveesiisteemi kaev Inlet 2).
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Jargnev ndide demonstreerib siltide automaatset uuenemist.

1) Ava joonis 02_Objects and Labels.dwg. Pane tihele silti, mis esitab 57.92.

2) Kiliki iihel tumehallil kontuurjoonel. Riba pealt vali Edit Surface > Paste Surface.

3) Vali Main Road A FG ning kliki OK. Pane tdhele, kuidas sildi info uueneb (niiiid 57.07).

4) Keskendu niitid sildile 0+333. 96 ning nihkesildile 20.88m L (eelmisest 1duna pool). Vali
soidutee telgjoon, kuvatakse selle objektipunktid. Vali kolmnurkne objektipunkt ning
tiri seda ld4nde (soidutee lddnepoolse serva ligidusse). Korgusmargi silt uueneb taas,
mis néitab niilid endist vairtust (kuna silt pole enam seotud sdidutee mudeliga).

Jargnev ndide demonstreerib andmelingi funktsionaalsust.

1) Avajoonis 02 _Surface.dwg.

2) Veendu, et Toolspace oleks avatud.

3) Liigu paanile Prospector, parem klikk Data Shortcuts ning vali Set Working Folder.
Kuvatakse dialoog Browse for Folder.

4) Vali kataloogina sama kataloog, kust avasid ka néidisjoonise. Kliki OK.

5) Parem klikk Data Shortcuts peal ning vali New Data Shortcuts Project Folder.
Kuvatakse dialoog New Data Shortcut Folder.

6) Sisesta reale Name > Ndidisprojekt. Kliki OK.

7) Salvesta joonis. Liigu riba paanile Manage ning vali Create Data Shortcuts. Kuvatakse
dialoog Create Data Shortcuts.

8) Vali kastike Existing Ground ees ning kliki OK.

9) Avajoonis 02 Alignment.dwg.

10) Korda samme 7-8 telgjoone Main Road A osas.

11) Ava joonis Profile.dwg.

12) Prospector > Data Shortcuts > Surfaces. Parem klikk Existing Ground peal, vali Create
Reference.

13)Kliki OK, et noustuda vaikimisi seadetega dialoogis Create Surface Reference. Pane
tdhele, et joonisel kuvatakse niiiid kontuurjooned.

14) Korda samme 12-13 telgjoone andmestiku Main Road A osas. Telgjoon lisatakse
joonisele.

15) Riba paanil Home > Profile > Create Surface Profile. Kuvatakse dialoog Create Profile
from Surface.

16) Kliki Add nupul ning seejdrel vali Draw in Profile View. Kuvatakse dialoog Create
Profile View — General.

17) Vali Create Profile View. Vali iilemises parempoolses vaateaknas profiili sisestuspunkt.
Luuakse uus profiil, mis on tegelikult loodud kolme erineva faili andmestiku baasil.
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Olemasoleva olukorra hinnang, t66 moodistusandmetega

Enne uue projekti loomist tuleb hinnata olemasolevat olukorda, mis enamikel juhtudel eeldab
ka moddistustodd. Mdodistustod eesmérk on saada kdrgusinfot mdddetud punktandmestiku
ndol. Mdddistustddd teostatakse suure tdpsusega (ca 3mm piires) ning kolmemdotmelisena
(kolm koordinaati). Projekteerija saab seejdrel need punktid omavahel iihendada, et
moodustuks joonis/mudel. Mdddistuspunktid sisaldavad iildjuhul ka lisainfot (kirjete kood),
mis madratleb punkti olemuse (mida see esitab). Mdddistusandmeid hallatakse 1dbi moddistuste
andmebaasi, mida hoitakse joonisest endast lahus. Peale andmebaasi loomist imporditakse
moddistusandmestik. Autodesk Civil 3D vdimaldab mdddistusandmestikku importida ka otse
joonisesse, kuid sellisel juhul on selle andmestikuga ka viiksemad redigeerimisvdoimalused.
Selleks saad kasutada Insert > Points from File. Pane téhele, et joonisesse importimisel on
punkte maérksa lihtsam nihutada, kuid see pole ainus asi, mille jargi valida meetodit.
Andmebaasi kaudu on voimalik andmestikku paremini nii-6elda kaitsta ning luua lisavéértuseid
(joongraafikat). Punktandmestikust saab joonise info jargmiste lisatdovahenditega: (a)
Linework Code Set (sisaldab margistikku, mis iitleb punktile, kas sellest algab uus joon voi
hoopis 10peb; vdib-olla tdhistab hoopis kaarjoone alguspunkti — teisisonu me rddgime
moddistuskeele tolkimist Civil 3D keelde); (b) Point styles (punktide stiilid, mida kasutatakse
kindlate punktide tdhistamiseks siimboliga nagu kaevu kaas, puu); (c) Point label styles (juhuks
kui soovid siltide lisamist teostada automaatselt, nditeks kaevukaane korgusmirk voi puu
nimetus); (d) Description keys (kirjeldab moddistuspunkti olemust/tiitipi nagu néiteks PP vdib
tdhendada Power Pole, lisaks vdidakse tdnu sellele lisada see punkt kihile Elekter ning lisada
ka kirjeldus Elektriliin); (e) Figure prefix database (tdhistab kihi seadeid, millele punktiga
téhistatud joon joonestatakse; nditeks EP voib tdhistada pinnaobjekti vélisserva, inglise keeles
ka kui breakline ehk hard edge); (f) Point groups (punkti grupid, mille kaudu saab korraga
mojutada paljusid punkte samaaegselt).

Mo6o6distuspunkt

COGO punkt

Kuvatakse paanil Survey

Ei kuvata paanil Survey

Kuvatakse paanil Prospector

Punktide ees on ikoon, mis kujutab risti
ringjoones

Punktide ees on ikoon, mis kujutab
ristkiilikus olevat liivakella

Punkte saab nihutada, isegi AutoCAD
tavaversiooniga (move kisk)

Punkte ei saa nihutada

Punkte saab redigeerida Properties paleti
vahendusel

Punkte ei saa redigeerida 1dbi Properties
paleti
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Tooleht - Olemasoleva olukorra hinnang, t66 moodistusandmetega

Jargnev ndide késitleb moddistuste andmebaasi loomist.

Loo uus, tiihi joonis (kasuta malli kataloogist 03/Essentials.dwt).

Vali Toolspace > Survey.

Parem klikk Survey Databases peal ning vali Set Working Folder peal.

Vali 03 kataloog. Kliki OK.

Parem klikk Survey Databases peal, vali New Local Survey Database.

Sisesta uue andmebaasi nimeks Moodistusandmed, kliki OK.

Vastavat andmebaasi kuvatakse Survey paanil. Pane tdhele andmebaasi
alamkomponente nagu Import Events, Networks, Figures, Survey Points. Andmebaas
loob ning haldab eeltoodud komponentide omavahelisi linke.

Jargnev ndide kisitleb moddistusandmestiku sissetoomist (eeldab eelmise sammu l&bimist).

9

Ava joonis 03/Import Survey Data.dwg.

Riba paanil Home > Import Survey Data.

Vali Essentials 1 mdodistusandmestik ning kliki Next.

Vali Data Source Type > Point File.

Vali sektsioonis Selected Files plussmirgi ikoonil ning mirgi kataloog 03.

Vali Files of type > Text/Template/Extract File (*.txt). Seejérel vali Topo Survey.txt,
kliki Open.

Sektsioonis Specify Point File Format > PNEZD (comma delimited)

Kliki Next. Dialoogis Specify Network veendu, et <none> oleks valitud kui olemasolev
vork. Kliki Next.

Dialoogis Import Options vali kastikesed Process linework during import ning Insert
survey points.

10) Veendu, et valikud Current figure prefix database = Sample ning Current linework code

set = Sample.

11) Kliki Finish.
12) Suurenda joonist ning vaata imporditud tulemust.

Jargnev ndide kasitleb joongraafika koodigrupi (linework code set) sidumist joonisele
imporditud punktidega.

1)
2)
3)

4)
S)

6)

8)

9)

Ava joonis 03/Linework Code Set.dwg.

Ava paan Toolspace > Survey.

Juhul kui sulle ei kuvata Essentials 2 mdddistusandmestikku alamstruktuuri, tee parem
klikk Essentials 2 peal ning vali Open for Edit.

Laienda Import Events. Parem klikk Topo Survey.txt peal ning vali Properties.

Kliki Browse ikoonil, mille leiad File to open rea 10pus. Pane tihele, et tekstifailis on
muuhulgas ka kirjed BEG, ECV, END. Need on koodid, mida kasutatakse joongraafika
iseloomustamiseks nagu Begin Feature, Begin Curve, End Curve, End Feature. Lisaks
peaksid leidma ka lithendi CLS = Close Feature.

Sulge tekstifail ning vajuta Cancel, et sulgeda dialoog Import Event Properties.

Vajuta Toolspace > Survey paani llemisel vasakul nupul (Survey User Settings), et
redigeerida moddistusinfo kasutaja seadeid.

Vali Linework Code Sets Path > Browse > kataloog 03. Kliki OK. Kliki veelkord OK,
et sulgeda dialoog Survey User Settings.

Paanil Survey, parem klikk Linework Code Sets peal ning vali Refresh. Vali plussmirk
Linework Code Sets ees. Peaksid ndgema Essentials rida.
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10) Tee parem klikk Essentials peal ning vali Make Current.

11) Sektsioonis Linework Code Sets, parem klikk Essentials peal ning vali Edit. Pane téhele,
et niilid koodid Begin, End, Begin Curve, End Curve ning Close kattuvad sellega, mida
ndgid tekstifailis. Koodid Sample koodigrupis olid erinevad ja sestap jooni ei
joonestatud vilja (punktide importimise kdigus).

12) Kliki Cancel, et sulgeda dialoog Edit Linework Code Set.

13) Sektsioonis Import Events, parem klikk Topo Survey.txt peal ning vali Re-Import.

14) Vali Current Linework Code Set > Essentials ning kliki OK.

15) Dialoogis Duplicate Point Number veendu, et Resolution = Overwrite. Seejdrel vali
kastike Apply to all duplicate point numbers ning kliki OK. Niiiid joonestatakse ka
joongraafika kui andmestikku imporditakse.

Jargnev ndide kaasab kirjelduse mérgistiku (description key) puid esitavatele punktidele.

1) Avajoonis 03/Description Keys.dwg.

2) Ava Toolspace > Settings > Point > Description Key Sets.

3) Parem klikk Essentials peal ning vali Edit Keys.

4) Vali TR* rea veeru Style lahter. Kuvatakse Point Style dialoog.

5) Vali punkti stiilina Tree ning kliki OK.

6) Vali Panorama akna iilal paremas servas olev roheline linnuke, et palett sulgeda.

7) Vali Prospector > Points.

8) Punktide nimekirjas (paleti allosas) reasta punktid veergu Raw Description jargi.

9) Liigu nimekirja ldppu ning pane tdhele 7R algavaid punkte.

10) Vali iiks 7R nimetusega punkt, parem klikk ning Apply Description Keys. Pane tihele,
et iks punkt joonisel omab niitidsest puu stimbolit.

11) Vali kdik 7R algavad read ning rakenda Apply Description Keys. Niiiid kuvatakse koik
puud vastava stimboliga.

12) Naase paanile Settings ning redigeeri Essentials kirjeldust veelgi. Lisa punkti stiil
Description Only reale TR* Rakenda muudatus. Pane tdhele, et niiiid on puud ka
tekstilise infoga.

13) Redigeeri veelkord TR * kirjeldust. Veerus Format sisesta $1mm $2. Rakenda muudatus
joonisele. Niiiidsest kuvatakse tekstiline info loetavamalt, néiteks 375mm MAPLE.
Mirkus: $ tdhendab, et voetakse kirje esimene (0), teine (1) voi kolmas (3) kirje
komponent ning vajadusel lisatakse sellele mingi lisatdhis, niiteks ,,mm-.

Jargnev ndide késitleb joongraafika eesliite seadete kaasamist (figuure prefix database).

1) Avajoonis 03/Figure Prefix Database.dwg.
2) Vali Toolspace > Survery paan > kliki nupul (iilal vasakus servas) Edit Survey User

Settings.
3) Valireal Figure Prefix Database Path > Browse. Ning vali sama kataloog, mis ka antud
niitefail.

4) Kliki OK, et sulgeda Survey User Settings dialoog. Parem klikk Figure Prefix Databases
peal ning vali Refresh. Kliki plussmirgi ikoonil Figure Prefix Databases ees ning
laienda selle sisu. Sa peaksid ndgema niiiid ka rida Essentials.

5) Parem klikk Essentials peal ning vali Make Current. Tee uuesti parem klikk Essentials
peal ning vali Manage Figure Prefix Database.

6) Vaata veergu Name ning seal sisalduvat infot. Need vastavad koodidele, mida nigid ka
tekstifailis (mdddistusandmestik). Pane tdhele, et moned koodid on tdhistatud kui
breaklines (niiteks EP — edge of pavement, TOPD — top of ditch, TOB — top of bank).
Pane samuti tdhele kihtide seadeid.
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7) Kliki Cancel, et sulgeda dialoog Figure Prefix Database Manager.

8) Juhul kui Essentials 3 mooddistusandmestik ei ole nihtav, parem klikk ning vali Open
for Edit.

9) Laienda sektsioonis Import Events. Parem klikk Topo Survey.txt peal ning vali Process
Linework.

10) Dialoogis Process Linework vali Current Figure Prefix Database > Essentials ning
kliki OK. Autodesk Civil 3D joonestab joongraafika iile, kuid niilid paigutab need ka
oigetele kihtidele (néiteks piirdeaed — fence line).

Jargnev ndide késitleb punkti gruppide loomist.

1) Ava joonis 03/Point Groups.dwg.

2) Prospector > parem klikk Point Groups peal ning vali New.

3) Dialoogis Point Group Properties, paanil Information, sisesta Name = Buildings. Vali
Point style = Basic ning Point label style = <none>.

4) Vali paan Raw Description Matching. Vali kastike BLD* korval ning kliki OK.

5) Laienda sektsioonis Point Groups, kliki Buildings. Pane tdhele, et koik punktid
sisaldavad kirjeldust BLD.

6) Loo veel jargnevad punkti grupid (lihes kirjeldustega). Kasuta Point style = Basic ning
Point label style = <none>.

a. Breaklines: BOB, BOTD, SWL, TOB, TOPD
b. Roads: CLRD, DW, EP, ES

c. Vegetation: ESHB, TL, TR

d. Fences: FNC

e. Ground Shots: GS

7) Mine paanile Settings, laienda sektsiooni Point > Description Key Sets.

8) Parem klikk Essentials ning vali Edit Keys.

9) Hoia all SHIFT klahvi ning vali koik read vélja arvatud 7R*. Seejirel tee parem klikk
Style veeru pdisel ning vali Edit.

10) Vali <default> ning kliki OK. Sulge Panorama palett rohelisest linnukesest (iilal
paremal).

11) Prospector > Point Groups > parem klikk A/l Points peal > Apply Description Keys.
See rakendab viimati tehtud valiku <default> koikidele punkti gruppidele, vilja arvatud
puud. Puntki stiilist 1ahtuvalt on niiiid enamus punktide esitus ringjoon.

12) Prospector > Point Groups > parem klikk Ground Shots peal > Properties.

13) Paanil Information vali Default point style = Ground Shot; Default point label style =
Elevation Only. Kliki OK ning pane téhele, mis selle punkti grupi punktidega juhtub.

14) Vali riba paan Output ning seejirel Export Points.

15) Vali kastike Limit points to point group ning vali punkti grupp Roads.

16) Vajuta OK ning vali kataloogiks sama kataloog, mis see néitefailgi. Faili nimeks pane
nditeks Road Points, vajuta Open. Seejérel sulge dialoog Export Points.

Jargnev ndide kisitleb moddistuspunkti redigeerimise aspekte.

1) Ava joonis 03/Edit Survey Points.dwg. Juhul kui mdddistusandmebaas on avatud, tee
parem klikk ning sulge see.

2) Leia ning suurenda joonist punaselt véarvitud punkti ligidusse. Vali punkt ning pane
tahele, et Properties aken kuvab punkti kohta infot Raw Description = TTR 300 PINE,
mis on vigane kirje. Tegelikult peaks olema 7R 300 PINE. Samas ei saa sa seda
redigeerida otse, kuna see info tuleb moddistusandmebaasist.
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Punkt on endiselt valitud, vali riba pealt Survey Point Properties. Kuvatakse dialoog,
mis iitleb, et sa pead avama mdddistusandmebaasi.

Kliki OK, et sulgeda teavitus. Tee parem klikk Survey > Essentials 4
moddistusandmestikul ning vali Open for Edit.

Endiselt on punane punkt valitud, vali riba pealt Survey Point Properties.

Redigeeri kirjeldust: TR 300 PINE ning kliki OK.

Vajuta ENTER, et 10petada késk. Sul vdidakse paluda uuendada niitid ka joongraafikat.
Vasta No, kuna see muudatus ei mdjuta joongraafikat.

Vali uuesti punane punkt, parem klikk ning valik Apply Description Keys. Niiid
lisatakse punkt digele kihile, lisatakse siimbol ning ka tekstiline info (silt) kui 300mm
PINE.

Jargnev ndide kisitleb moddistusgraafika (survey figure) redigeerimist.

1)
2)
3)

4)

S)

6)
7)

8)
9)

Ava joonis 03/Edit Survey Figures.dwg.

Veendu, et moodistusandmebaas Essentials 5 oleks avatud.

Paremas vaateaknast leia hoone, millel puudub pdhja kiilg. Vali hoone joongraafika
ning riba pealt vali Survey Figure Properties. Pane tihele, et punkt 285 ei oma koodi
CLS (close), mis aitaks hoone perimeetri sulgeda.

Vali punkt 285, seejérel vali Closed = Yes ning kliki OK. Niiiid on hoone perimeeter
suletud. Kuna sa kasutasid Survey Figure Properties kdsku on joonis ning
moddistusandmebaas omavahel siinkroniseeritud.

Vajuta ESC klahvi, et tithistada eelnev valik. Liigu kagu suunal, kuniks nided hoonet,
mis paikneb /50mm PINE kdorval. See hoone peaks ilmuma tegelikult kahe erineva
hoonena. Vali hoone perimeeter, seejérel riba pealt Survey Figure Properties.
Dialoogis Figure Properties kliki punktil 288 ning seejérel vajuta nuppu, mis tdhistatud
punase ristiga. Eemalda ka punktid 289, 290, 291 samal moel.

Vajuta OK, et sulgeda Figure Properties dialoog. Niiiid kuvatakse vaid hoone
pohjapoolne osa.

Parem klikk Survey > Figures, vali Create Figure Interactively.

Kui palutakse sisestada graafika nimetus, sisesta BLD2 ning kliki OK.

10) Vali neli punkti, mis moodustavad védiksema hoone ning vajuta ENTER.
11) Dialoogis Figure Properties vali Closed = Yes. Vajadusel muuda punktide jarjekorda,

et moodustuks eelvaates ristkiilik (kasuta selleks noolega téhistatud nuppe). Vajuta OK,
et sulgeda dialoog. Niilidsest kuvatakse kaks eraldiseisvat hoonet.

Jargnev ndide kisitleb lisapunktide loomist.

1)

2)
3)

4)

S)
6)

7)

Ava joonis 03/Stake Out.dwg. Selles joonises lisad sa punktid, mis esitavad krundi
nurgapunkte.

Riba paanil Insert > Points from File.

Dialoogis Import points > vali PNEZD (comma delimited). Vali kataloogina sama
kataloog, kus ka see ndide.

Files of type = Text/Template/Extract File (*.txt). Vali fail Found Corners.txt ning kliki
Open.

Kliki OK, et sulgeda Import Points dialoog.

Dialoogis Duplicate Point Number, sektsioonis Resolution > Add an Offset. Sisesta Add
and offset from = 1000, kliki OK.

Prospector > Point Groups > parem klikk Found Corners peal ning vali Update.
Sellega rakendame vaikimisi punkti grupi stiili vérskelt imporditud punktidele. Need
kuvatakse niiiid punaselt (koos tekstiga).
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8) Pane tihele, et louna perimeetril puudub 2 punkti, ida perimeetril 1 punkt ning loodes
ka 1 punkt (kokku neli). Need punktid on vajalik koha peal iiles leida.

9) Riba paanil Home > Points > Point Creation Tools.

10) Nupupaanil Create Points > Miscellaneous Manual. Vasakus vaateaknas haara kinni
puuduolevatest puntkidest.

11) Prospector > Corners to be found > parem klikk > Update. Need punktid kuvatakse
sinise tooniga.

12) Nupupaanil Create Points > laienda nupupaani vaadet.

13) Laienda Points Creation, sisesta BORE kui vaikimisi kirjeldus.

14) Vali nupupaani vasakus servas Measure Object.

15) Vali iiks lilladest sdidutee telgjoontest. Vajuta ENTER klahvi kolm korda, et ndustuda
vaikimisi alg- (starting stationi), 10pp (ending station) positsiooniga ning nihkega
(offset).

16) Sisesta intervalliks 80 ning vajuta ENTER. Mo6dda sinu poolt valitud sdidutee telgjoont
kuvatakse punktid sammuga 80m.

17) Prospector > Test Borings > parem klikk > Update.

18) Korda samme 14-17 ka iilejddnud sdidutee telgjoontega.

19) Riba paanil Output > Export Points.

20) Vali Format > PNEZD (Comma delimited). Vali kastike Limit to Points in Point Group
ning vali Corners to be Found.

21)Kliki OK ning vali kataloogiks 03. Sisesta faili nimeks Corners to be Found.txt.

22)Korda samme 19-21 punktigrupile Test Boring, et luua fail Terst Borings.txt.
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Olemasoleva maapinnamudeli modelleerimine

Eelnevalt oleme sisse importinud moddistusandmed, mille baasil loonud ka joongraafikat.
Jargmise sammuna liigume aga juba kolmandasse modtmesse ning kisitleme pinnaobjekti
moistet (surface). Autodesk Civil 3D kasutab maapinna mudeli loomiseks Triangular Irregular
Network (TIN) algoritmi. Algoritmi {ilesanne on iihendada iiks punkt vdhemalt kahe
naaberpunktiga, mille tagajirjel moodustub kolmnurkmudel. Kuna punktandmestik on
ebakorrapéraselt jaotatud, on ka kolmnurkade suurused ebakorrapérased. Kui kdik punktid on
omavahel joonte kaudu iithendatud, moodustub pinna vorgustik.

Lisaks kolmnurkade loomisele on algoritm
vOimeline arvutama mistahes punkti
kdrgusmérgi. Valmis 7I/N mudelit saab
pOorata/ldigata mistahes vOtmes, mille
alamtegevusi nimetatakse erinevat tiilipi
analiitisideks.

Pinnaobjektil  vOib  eristada  erinevaid
komponente, mida néeb ka Prospector >
Surfaces > pinnaobjekti nimetus >
Definition alamkategooriatena.

Komponentidest voib loetleda: (a) boundaries (pinnaobjekti vilisperimeeter); (b) breaklines
(juhtjooned, et mdjutada algoritmi kolmnurkade servade kulgemist, néiteks piki kraavi); (c)
contours (kontuurjooned); (d) DEM files (digital elevation model — mahukama
kaardiandmestiku esitamiseks); (¢) Drawing Objects (vdimaldab kasutada erinevaid AutoCAD
standardobjekte pinnaobjekti kujundamiseks); (f) Edits (pinnaobjekti redigeerimised); (g) Point
Files (punktandmestiku kaasamine pinnaobjekti loomisesse); (h) Point Groups (pinnaobjekti
loomine lébi punkti gruppide).

Pinnaobjektiga on vdimalik lisaks kontuurjoonte néditamisele teha ka palju enamat, nditeks viia
1dbi erinevat tiilipi analiilise. Muuhulgas saad analiitisida korguseid, kaldeid.

Pinnaobjekte saab annoteerida siltidega, milleks on niiteks korgusmaérgi silt, langu/kalde silt
ning kontuurjoonte sildid.
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Tooleht - Olemasoleva maapinnamudeli modelleerimine

Jargnev ndide késitleb pinnaobjekti loomist mdddistusandmestikust.

Ava joonis 04/Create an EG Surface.dwg.

Prospector > Surfaces > parem klikk > Create Surface.

Dialoogis Create Surface > sisesta Name = EG.

Vali Style = C-Existing Contours (0.5m). Kliki OK, et sulgeda dialoog.

Prospector > Surfaces > EG > Definition. Jdlgi alamkomonente.

Parem klikk Point Groups > Add.

Vali Ground Shots ning kliki OK. Pinnaobjekt muutub niiiid néhtavaks plaanilisel vaatel
(kontuurjooned), alumisel 3D vaatel kui varjutatud mudel.

Alumises paremas vaateaknas vali visuaalseks stiiliks Shaded. Niilid nded ka 77N jooni.
Vali sama akna visuaalseks stiiliks Conceptual ning vaata mudelit erinevate nurkade all.
Tegemist on nii-6elda vettpidava mudeliga.

Jargnev ndide kisitleb juhtjoonte (breaklines) lisamist pinnaobjektile.

1)
2)

3)
4)
S)

6)
7)

8)

9

Ava joonis 04/Add Breaklines.dwg.

Toolspace > Survey paan > parem klikk Survey Databases peal ning vali Set Working
Folder.

Vali sama kataloog, mis on ka niidisfaili asukohaks. Sa peaksid ndgema
moddistusandmebaasi nimetusega Essentials.

Parem klikk Essentials peal ning vali Open for Edit.

Laienda Essentials andmebaasi. Parem klikk Figures peal ning vali Create Breaklines.
Jélgi graafika nimekirja ning pane tdhele, millised neist on kui juhtjooned. Kliki OK.
Dialoogis Add Breaklines, sisesta Mid-ordinate Distance = 0.1 ning kliki OK (sisuliselt
me tdiustame moddistusandmebaasi, et pinnaobjekti tdpsemini ,,juhtida*). Pane tihele,
et niitidsest kontuurjooned katavad ka pohjas olevat tee ala. Pinnaobjekt on seal puhtalt
juhtjoontel pdhinev.

Parempoolses iilemises vaateaknas vali iiks kontuurjoontest ning vali riba pealt Surface
Properties.

Dialoogis Surface Properties > paan Information > Surface style = Triangles. Kliki
OK. Pane tdhele, et niilid 7/N jooned ei 1dika juhtjooni.

10) Ava dialoog Surface Properties uuesti. Paanil Definition vota dra linnuke Add

Breakline. Kliki OK, seejdrel Rebuild the Surface. Pane tihele, et sellega sa eemaldasid
juhtjoonte arvestamise ajutiselt. Niiiid moodustavad TIN jooned méirksa ebaselgemaid
serva jooni, kus peaks olema sirge 10ik.

Jargnev niide késitleb vélisperimeeterjoonte lisamist hoone iimber, et eemaldad pinnaobjekti
andmestik hoone alt.

1)
2)

3)

4)

5)

Ava joonis 04/Surface Boundaries.

Vali lilemises paremas vaateaknas iiks kontuurjoontest ning riba peal kliki 7in Surface:
EG, seejirel Add Data > Boundaries.

Sisesta Name = Bld1, vali Type = Hide. Veendu, et oleks valitud kastike Non-
destructive breakline, kliki OK.

Vali iilemises parempoolses vaateaknas liks hoonetest ning vajuta ENTER. Sa peaksid
koheselt nidgema alumises parempoolses aknas hoone all auku. Antud tegevuse
tagajérjel hoone alt eemaldatakse pinnaobjekti kontuurjooned.

Korda samme 2-4 iilejdédnud hoonetega isegi siis kui need hetkel ei 14bi hoonet. Kasuta
nimetusena midagi muud kui Bld1.
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6)

Pane alumiselt parempoolselt vaatelt tahele ehitiste aluseid tiihimikke.

Jargnev nédide késitleb olemasolevate TIN joonte eemaldamist.

1)
2)

3)
4)

S)

6)

Ava joonis 04/Delete TIN Lines.dwg.

Vali iilemises parempoolses vaateaknas iliks pinnaobjekti kontuurjoon, seejdrel riba
pealt Surface Properties.

Paanil Information muuda Surface style = Triangles ning kliki OK.

Vasakpoolses vaateaknas suurenda pinnaobjekti 1dunaservale ning pane tihele, et TIN
jooned pikenevad iile serva.

Vali iiks TIN joontest ning riba pealt vali Edit Surface > Delete Line. Vali liigsed jooned
ning vajuta ENTER.

Vajadusel kustuta veel liigseid jooni.

Jargnev ndide késitleb pinnaobjekti punktide redigeerimist.

7)

Ava joonis 04/Editing Points.dwg. Selles failis on iiks punkt vale kdrgusmaérgiga.

Vali pinnaobjekt iihest selle kontuurjoonest. Vali Surface Properties.

Dialoogis Surface Properties > paan Information > Surface style = Triangles and
Points. Kliki OK. Kuvaesitus nditab niitid punkte pluss-mérgina.

Vali mistahes 7IN joon, et valida pinnaobjekt, seejarel kliki Edit Surface > Modify
Point.

Kui palutakse valida punkt, tee seda 3D vaatest. Vali teistest madalam punkt. Vajuta
ENTER.

Késureale sisesta 58.144 ning vajuta ENTER. Pane tdhele, et pinnaobjekti
redigeeritakse, kuid joongraafika voib jddda osalt alles. Selle redigeerimist tuleb
kontrollida juba ldhteandmestikus.

Vajuta ENTER, et viljuda Modify Point kédsust. Vali pinnaobjekti stiiliks uuesti C-
Existing Contours (0.5m). Pane tihele, et enam ei eksisteeri liksteisega korvuti olevaid
kontuurjooni.

Jargnev néide késitleb korguslikku analiiiisi pinnaobjektil.

1)
2)
3)
4)
)
6)

7)

Ava joonis 04/Elevation Analysis.dwg.

Vali pinnaobjekt tihest selle kontuurjoonest. Vali Surface Properties.

Muuda pinnaobjekti stiili: Elevation Banding (2D).

Vali paan Analysis. Veendu, et Analysis type = Elevations ning Number of ranges = 8.
Kliki allapoole suunatud noolel, et lisada Range Details sektsiooni vajalikud read.
Kliki OK, et naasta joonisele. Joonisel tdhistab punane kdige madalamat kdrgust ning
lilla koige korgemat.

Vali pinnaobjekti stiiliks niitid Elevation Banding (3D). 3D vaade kuvab niiiid tdstetud
pinnaobjekti.

Jargnev ndide késitleb pinna kallete analiitisi.

1)
2)
3)
4)
5)

6)

Ava joonis 04/Slope Analysis.dwg.

Vali pinnaobjekt tihest selle kontuurjoonest, seejdrel kliki Surface Properties.
Dialoogis Surface Properties > paan Information > vali stiiliks Slope Banding (3D).
Liigu paanile Analysis. Vali Analysis type = Slopes ning kliki allapoole suunatud noolel.
Kliki OK. 3D vaatel kuvatakse tumepunasega jarsemad alad. Selle teemakaardi pdhjal
saad oelda, et pdohjas on maapind iisna tasane, kuid ldunas iisna jarsk.

Ava uuesti Surface Properties ning vali stiiliks niitid Slope Arrows.
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7)
8)

Paanil Analysis vali Analysis type = Slope Arrows ning kliki allapoole suunatud noolel.
Kliki OK, et naasta joonisele. Joonises kuvatakse niitid tume sinise ning mustaga
jarsemad alad, kusjuures nooleots on alati suunatud allapoole. Sa peaksid muuhulgas
niiiid tdhele panema, et pinnaobjekti voib pohimotteliselt poolitada keskelt, kus siis
ilemine osa langeb pdhja serva ning alumine osa lduna serva.

Jargnev ndide késitleb kdrgusmargi siltide lisamist pinnaobjektile.

1)

2)
3)
4)
)
6)

Ava joonis 04/Labeling Surfaces.dwg. Pane tihele, et lilemine parem vaateaken on
suurendatud asukohta, kus lilla sdidutee telgjoon 1dikub olemasoleva sdidutee
telgjoonega.

Vali iiks kontuurjoontest, seejérel riba pealt Add Labels > Add Surface Labels.
Dialoogis Add Labels > Label type = Spot Elevation.

Elevation label style = Elevation Only — Existing ning Marker style = Spot Elevation.
Kliki Add. Vali lilla joone otspunkt. Lisatakse silt.

Joonis jddb avatuks jirgmise ndite tarvis.

Jargnev néide kisitleb kalde sildi lisamist pinnaobjektile.

1)

2)
3)
4)
S)

6)
7)

8)

Jétka eelmisest nditeks 04/Labeling Surfaces.dwg. Liigu veidi allapoole, kuniks nied
soidutee telgjoone podramist 90 kraadi all. Sinu soov on mdota siin maapinna kallet, et
voOtta vastu otsus, kas ka eramuid saab siia kaarele ehitada voi kas sdiduteele tuleb lisada
turvapiire.

Juhul kui dialoog Add Labels on endiselt avatud, liigu jirgmise sammu juurde. Kui ei
ole, siis vali pinnaobjekt selle kontuurjoonest, Add Labels > Add Surface Labels.

Vali Label Type = Slope

Veendu, et Slope Label Style = Percent-Existing ning kliki Add.

Kui késurida ootab sinupoolset sekkumist vajuta ENTER, et ndustuda vaikimisi
vaartusega <One-point>.

Kliki sdidutee 1dunaservas, et lisada kalde silt. Vajuta ESC klahvi, et véljuda késust.
Vali silt ning seejdrel selle nelinurk-objektipunkt. Nihuta silti iile pinnaobjekti ja pane
tdhele, kuidas selle vaartus muutub.

Joonis jadb avatuks jargmise ndite tarvis.

Jargnev ndide késitleb kontuurjoontele siltide lisamist.

1))
2)
3)

4)

Juhul Add Labels dialoog on avatud, liigu jirgmise sammu juurde. Kui ei ole, siis vali
kontuurjoonest pinnaobjekt ning riba pealt Add Labels > Add Surface Labels.

Vali Label Type > Contour — Multiple. Veendu, et koikide siltide stiili nimetused
algavad Existing ning kliki Add.

Vali joonisel kaks punkti, mis haaravad enda alla mitu kontuurjoont. Kontuurjoonte
sildid kuvatakse sinu poolt valitud mdttelise joone all.

Vajuta ESC klahvi, et katkestada eelmine késk. Seejdrel vali iiks viimati tehtud
siltidest. Pane tdhele joont, mis taustal kuvatakse. Vali liks objektipunktidest ning tiri
see teise asukohta. Sildid liiguvad joonega kaasa. Kui joone nihutamisega iiletatakse
veel monda kontuurjoont, lisatakse uus silt.

Raido Puust | Autodesk Civil 3D algkursus [PAV/EE]



Telgjoontel pohinev 2D disain

Peale olemasoleva olukorra modelleerimist saab litkuda uue disaini loomisprotsessi juurde.
Uldjuhul alustatakse uue disaini loomist mdne 2D komponendi maha mirkimisega. Kuna selles
koolitusmaterjalis keskendutakse peaasjalikult sdidutee disainile tdhendab 2D komponent siin
soidutee telgjoone mahamarkimist. Soidutee telgjoone all me mdtleme kesktelge, mille jargi
tilejddnud komponendid hakkavad joonduma. Telgjoone objekte saame luua nii
olemasolevatest objektidest (nt poliijoon) voi luua need nii-6elda nullist (4lignment Creation
Tools). Uldiselt on soovitav, et esialgu loome iildise disaini ning hakkame seejirel seda
tdpsustama. Tadpsustamise juures on aga oluline, et selleks leidub ka t6ovahendeid. Autodesk
Civil 3D on just selliselt {iles echitatud, et redigeerimine oleks vodimalikult lihtne ning
laiapohjaline. Esmalt on sul voimalik redigeerida 14bi objektipunktide, kuid ka
eritdovahenditega, mis on leitavad nupupaanilt Alignment Layout Tools (sisuliselt on tegemist
sama nupupaaniga, mida kasutasime telgjoone esmaseks mahamérkimiseks). Juhul kui
soovitakse redigeerimisi 14bi viia tabelformaadis, siis selleks saab kasutada todvahendit
Alignment Grid View, mis avaneb Panorama paletil. Lisaks tabeli vaatele saab numbriliselt
redigeerida ka komponendi kaupa. Sellisel juhul kuvatakse numbriline info vaid sinu poolt
valitud telgjoone komponendi osas. Selleks kasutad téovahendit Alignment Layout Tools >
Sub-entity Editor, misjdrel valid komponendi 1dbi Pick Sub-entity toovahendi.

Disainimisel peame me iildjuhul jirgima teatud standardeid voi kui mone lokaalsema projekti
juures ei olegi need nii rangelt fikseeritud, siis disaini héid tavasid. Autodesk Civil 3D tarkvaras
on voimalik iiles seadistada need standardid, et tarkvara hoiataks kui peaks tekkima vastuolu.
Uks toovahenditest koondab disaini kontrollmehhanisme (gruppe), mis on seadistatav
Toolspace > Settings paani alt ning teine to6vahend pdhineb disaini kriteeriumi failil, mille sa
seod olemasoleva joonisega ning mida saab redigeerida spetsiaalse todvahendiga Design
Criteria Editor. Emba kumba viisi sa kasutad, siis pdhimotteliselt nende eesmérk on sama,
kontrollida disaini vastavust teatud kriteeriumitele.
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Tooleht - Telgjoontel pohinev 2D disain

Jargnev néide késitleb telgjoonte loomist olemasolevatest objektidest.

1)
2)
3)
4)
S)

6)

7)

8)

Ava joonis 05_Alignment from Objects.dwg.

Riba paanilt Home > Alignment > Create Alignment from Objects.

Kui késureal palutakse sul valida objekt, vali kdige pikem lilla poliijoon nimetusega
Jordan Court.

Vajuta ENTER. Poliijoonele peaks seejdrel tekkima must nool, mis esitab telgjoone
arvata suuna.

Kui nool on suunatud lduna poole vajuta ENTER. Juhul kui see on suunatud pohja,
sisesta R ning vajuta ENTER.

Dialoogis Create Alignment from Objects teosta veel jargmised tegevused:

Sisesta Name = Jordan Court

Type = Centerline

Site = <None>

Alignment Style = Proposed

Alignment Label Set = No Labels

Eemalda linnuke kastist Add curves between tangents

Veendu, et oleks tdhistatud kastike Erase existing entities.

Kliki OK.

Vali viimati tehtud telgjoone objekt, seejdrel vali olemasolev lilla joone objekt. Pane
tahele, et objektipunktid on neil erinevat liiki/tiiiipi. Proovi neid objektipunkte
nihutada, et harjuda nende kditumisega. Pane tihele, et telgjoone objektipuntkide
nihutamisel piititakse hoida alles puutujat, et sdiliks tee sujuv kurv.

Korda samme 2-6 loomaks ka Madison Lane ning Logan Court telgjoon.

SR e oo o

Jargnev néide késitleb telgjoone objekti loomist nii-6elda nullist.

1)
2)

3)
4)
5)

6)
7)

8)

9

Ava joonis 05_Alignment Creation Tools.dwg.

Avanevas joonises pane tihele sinist geomeetriat ning toodud moodtusid ja mérkuseid.
Need mérkused lisatakse iildjuhul disaini, mis muuhulgas késitlevad ka ndudeid
ehitatavale laiendusele (projektile).

Riba paanilt Home > Alignment > Alignment Creation Tools.

Dialoogis Create Alignment — Layout kliki OK, et ndustuda vaikimisi seadetega.
Nupupaletil Alignment Creation Tools kliki esimese nupu mustal, allapoole suunatud
kolmnurgal, et ndeksid lisatodvahendeid. Seejérel vali Tangent-Tangent (With curves).
Haara kinni ringjoone A keskpunktist.

Haara kinni ringjoone B kuni E keskpunktidest ning vajuta ENTER. Sellega oled
loonud Jordan Court telgjoone.

Loo ka Madison Lane telgjoon (jargi samme 3-7 ning haara kinni ringjoone
keskpunktidest F kuni H).

Loo ka Logan Court telgjoon (jargi samme 3-7 ning haara kinni esmalt ringjoone
keskpunktist I ning seejérel haara kinni risti olevast punktist Madison Lane-il).

Jargnev néide késitleb telgjoonte redigeerimise toovotteid 1dbi objektipunktide.

1)
2)

Ava joonis 05_Graphical Editing.dwg.

Vali Jordan Court telgjoon, et kuvada selle objektipunktid. Vali teise kaare iilespoole
suunatud kolmnurk ning tiri see teise asukohta. Pane tdhele, et podrde raadius sellest ei
muutu.
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3)

4)

S)

6)

7)

Vali kaare tliks ringjoone objektipunktidest ning tiri see teise kohta. Nende nihutamisel
muutub raadius, kuid puutuja tingimus jaéb samaks. Nende punktide kaudu saame
mdiirata kurvi tipse alg- ja 16pppunkti.

Vali ringjoone objektipunkt kurvi keskel ning nihuta seda teise kohta. Selle punkti
kaudu saame ette anda, et kurv 1ébib teatud punkti, kusjuures alles hoitakse puutuja
tingimust (muudetakse raadiust).

Vali kolmnurkne objektipunkt kaare keskpunkti 1dheduses ning nihuta see teise kohta.
Selle punkti kaudu saab mdjutada kurvi raadiust, kuid puutujatingimus jaab samaks.
Vali Jordan Court telgjoone 1opus olev nelinurkne objektipunkt ning nihuta see teise
asukohta. Seda tiilipi objektipunkti leiab nii telgjoone alguses kui I6pus. Kui seda
nihutada, siis liigub sellega kaasa ka iihendatud geomeetria. Néiteks sellega tihendatud
kaarjoon muudab alg- ja Idpppunkti asukohta, et séiliks puutuja tingimus.

Vali telgjoone viimase 18igu keskmine nelinurk ning nihuta seda teise punkti. Selle
punkti kaudu saab nihutada tervet 16iku.

Jargnev ndide kasitleb telgjoone redigeerimist 1dbi nupupaani Alignment Layout Tools.

1)
2)

3)

4)

5)
6)

7)
8)
9)

Ava joonis 05_Editing Tools.dwg.

Vali Jordan Court telgjoon, seejérel kliki riba peal Geometry Editor. Kuvatakse
nupupaan Alignment Layout Tools.

Nupupaanil Alignment Layout Tools vali Insert PI. Seejirel vali joonisel mérgitud
ringjoone A keskpunkt.

Vali seejirel Delete Sub-entity ning vali kaarjoon punkti B 1dheduses.

Seejérel eemalda joon punktide A ja B vahel.

Laienda Curve nuppu ning vali More Floating Curves > Floating Curve (From entity
end, radius, length).

Vali joon punkti A ldheduses.

Sisesta kdsureale 0, vajuta ENTER, et mérkida vastupédeva suund.

Sisesta raadiusena 30.

10) Sisesta kaare pikkus 30. Lisatakse liihike kaarjoon 15igu 1dppu.
11) Nupupaanil Alignment Layout Tools laienda Curve nuppu ning vali Free Curve Fillet

(Between two entities, radius).

12) Vali viimati tehtud kaarjoon.

13) Vali punane joon, mis algab punkti B juurest.

14) Vajuta ENTER, mérkimaks lahendit, mis on vdhem kui 180 kraadi.

15) Vajuta R klahvi ning seejarel ENTER, millega kinnitada, et tegemist on tagurpidi

kaarega.

16) Sisesta 30 raadiuseks ning vajuta ENTER, et 10petada késk. Joonisele lisatakse uus

kaarjoon.

Jargnev nédide kisitleb telgjoone redigeerimist l1dbi toovahendi Alignment Grid View.

Ava joonis 05 Numerical Editing.dwg.

Vali telgjoon Jordan Court, seejérel kliki riba peal Geometry Editor.

Vali Alignment Grid View, et avada Alignment Entities paan, mis kuvab telgjoone info
tabelina.

Muuda ridade 2 ja 3 raadiuse véértust kui 45. Pane tdhele, et joonisel uuendatakse
telgjoont automaatselt.
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Selles niites kasutame telgjoone numbriliseks redigeerimiseks todvahendit Sub-entity Editor.

1) Jatka eelmisest nditest voi ava joonis 05 Numerical Editing.dwg.

2) Sulge Panorama palett. Vali Alignment Layout Tools > Sub-entity Editor (pane téhele,
et see dialoog on esialgu tiihi).

3) Vali Pick Sub-entity ning seejérel vali jooniselt Jordan Court telgjoone alumine 90
kraadine kaar. Alignment Layout Parameters dialoogis kuvatakse niitid andmestik.

4) Muuda raadiust Radius = 15.

5) Sulge Alignment Layout Parameters dialoog, sulge ka Alignment Layout Tools
nupupaan.

Selles nidites scome me joonisega disaini kontrollgrupi (design check set).

1) Avajoonis 05 Design Check Set.dwg.

2) Vali Jordan Court telgjoon, seejdrel vali riba pealt Alignment Properties.

3) Dialoogis Alignment Properties kliki paanil Design Criteria.

4) Muuda Design Speed = 40.

5) Vali kastike Use Criteria-based design.

6) Eemalda linnuke kastist Use design criteria file.

7) Veendu, et oleks valitud Use design check set ning vali Subdivision.

8) Kliki OK, et sulgeda dialoog Alignment Properties. Vajuta ESC klahvi, et tiihistada
objektipunktide valik. Sa peaksid ndgema kolme kollast hiitiumérki.

9) Liigu hiirega 1dunapoolse kurvi hiitiumaérgile. Sulle peaks kuvatama teavitus, et
vastuolu on Subdivision Curve disaini kriteeriumiga.

10) Kasutades objektipunkte, redigeeri kurvi raadiust kuniks hiitiumark kaob.

11) Vali Jordan Court telgjoon, seejirel kliki riba pealt Geometry Editor.

12) Nupupaanil Alignment Layout Tools vali Alignment Grid View. Pane tdhele, et ka
selles vaates kuvatakse sulle vastuolud iihes vdértusega, millega probleem on.

13) Sisesta rea 3 osas uueks raadiuseks 45. Pane téhele, et hoiatus kaob ning rasvases
triikis esitus kaob.

Selles ndites kasutad sa disaini kriteeriumi failil pdhinevat kontrolli.

1) Ava joonis 05_Design Criteria Files.dwg. Pane tihele, et selles joonises on hetkel iiks
hoiatus.

2) Vali Jordan Court telgjoon ning vali riba pealt Alignment Properties.

3) Vali paan Design Criteria. Vali kastike Use design criteria file.

4) Kliki faili rada miératleval nupul ning kasuta faili Autodesk Civil 3D Metric (2004)
Roadway Design Standards.xml. Kliki Open.

5) Eemalda linnuke kastist Use design check set.

6) Kliki OK ja vajuta ESC klahvi, et tiihistada objektipunktide valik. Pane tdhele, et
disaini kriteeriumi failist tulevad nduded on mérksa karmimad kui eelmises niites.

7) Liigu hiirega koige pohjapoolsemale hiiiiumérgile. Teavitusena mérgitakse, et vajalik
raadius peab olema 47m.

8) Vali telgjoon, seejérel riba pealt Geometry Editor.

9) Vali Alignment Layout Tools > Alignment Grid View.

10) Pane tdhele, et Panorama vaates kuvatakse Minimum Radius. Muuda raadiust ridade
2, 3 ning 7 osas ning sisesta 48. Hetkel dra redigeeri rida 5, see peaks jddma véirtusele
15.

11) Sulge Panorama vaade ning vaata tehtud muudatuste moju. Kui vilja arvata iiks joon,
siis niitidne telgjoon on vastavuses nduetele.
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Telgjoonte kuvamine ning annoteerimine

Telgjoone objektid pdhinevad stiilidel, mis omakorda mééravad telgjoone esituse. Lébi stiili
saame me esitada telgjoont sellisena nagu standard voi tava ette nideb. Uks joon aga iitleb
tildjuhul liiga vdhe meie disaini kohta, mistdttu saab telgjoonele lisada ka erinevaid liike
annotatsioone (silte). Telgjoone stiili muudatusega void sa pohimotteliselt luua mistahes joone
esituse (kasvoi nditeks krundipiiri kui selleks peaks olema soov). Stiil defineerib, millised
telgjoone komponendid on ndhtavad, kuid lisaks ka millisele kihile see kuulub, mis on
vérvitoon ning joone tiiiip.

Telgjoontele saab lisada eritiilipi annotatsioone, kas siis tervele telgjoonele korraga voi teatud
vahemikule (positsioonidele). Annotatsioon kordab ennast teatud sammu tagant voi kui
kohtutakse kindlat tiilipi geomeetriat. Seda tiilipi annotatsioon on intelligentne ehk siis see
muutub vastavalt telgjoone muutusega. Kokku saad lisada seitset erinevat tiilipi annotatsiooni
(silti). Koige olulisemad on: Major Station Labels (pdhipositsioonidele lisatud), Minor Station
Labels (alampositsioonidele lisatud), Geometry Point Labels (kindlatesse geomeetrilistesse
punktidesse paigutatuna). Kuna tihtipeale me kasutame annoteerimiseks mingit kindlat siltide
kogumit, siis on vOoimalik see eelsalvestada nii, et jirgmise telgjoone annoteerimisel saame teha
seda iihe korraga. Me kasutame selleks funktsionaalsust Alignment Label Sets. Telgjoone siltide
redigeerimine on moneti erinev teiste siltide redigeerimisest, kuna telgjoone sildid esinevad
gruppides ning kui sa valid iihe siltidest, siis valitakse ka kdik tilejddnud. Kui sa aga peaksid
soovima redigeerida vaid thte silti, siis vali see CTRL klahvi kasutades.

Lisaks siltidele, mida saab rakendada gruppidena, eksisteerivad ka sildid, mis on nii-delda
iiksikud. Selle nditeks on Station/Offset Label, millega tihistatakse kaugust telgjoonest (néiteks
kaevukaas). Seda tiilipi silte saab luua fikseeritult (jadvad oma koha peale) voi nii-6elda
liuglevatena (sdilitab méargitud vahekauguse telgjoonest).

Juhul kui soovitakse tdhistada aga telgjoonte 16ikusid (nt pikkus, nurk), siis kasutame sildi
tiilibina Segment Labels. Ka 1dikude sildid on igaiiks eraldiseisev, kuid neid on vodimalik
korraga luua (néiteks koikidele kaarjoontele).

Monel juhul on maistlik panna telgjoone geomeetriline info tabelisse ning mitte otse joonisele.
Sellisel juhul on meie joonis monevorra puhtam ning saame kasutada annoteerimist monede
teiste objektide osas. Selleks kasutad sa Tag Labels toovahendit lihes tabelitega. Tag label all
me motleme mingit tdhistust (viidet), mille kaudu me viitame tabeli teatud reale. Neid silte saab
luua ka olemasolevate siltide baasil (konverteerida). Telgjoone tabeleid on kokku nelja liiki
(line, curve, spiral, segment). Viimane (segment) koondab endas kolme esimest (/ine, curve,
spiral). Tabeli loomisel saad arvestada, milliseid tdhiseid soovid sinna kaasata (kas koiki voi
tiksikuid). Tabelid on seotud joonise objektidega, seega kui nditeks telgjoont redigeerida, siis
tabelit uuendatakse automaatselt. Tabel on voimeline isegi tekitama uusi ridasid automaatselt
kui moni telgjoone komponent lisatakse.
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Tooleht - Telgjoonte kuvamine ning annoteerimine

Jargnev nédide késitleb telgjoone stiiliga tehtavaid muudatusi.

1)

6)
7)

8)

Avajoonis 06 _Alignment Styles.dwg. Selles joonises on palju erinevaid telgjooni, mida
kasutatakse erineval otstarbel. Hetkel ndevad koik telgjooned iihtemoodi vilja, kuna
neile on lisatud stiil Standard.

Vali telgjoon, mis esitab Emerson Road kesktelje. Parem klikk ning vali Properties.
Muuda stiil kui C-ROAD-CNTR-E. Vajuta ESC, et tiihistada objekti valik.

Vali Jordan Court kesktelg ning vali stiiliks C-ROAD-CNTR. Vaata muutunud esitust.
Vali niiiid stiill C-ROAD-CNTR with Markers. Niitid kuvatakse eraldi markerid joone
komponentide punktides. Seda stiili kasutad sa 16pp-disaini juures, kuid ilmselt mitte
disainimise kdigus.

Muuda Madison Lane telgjoone stiil Layout peale. Seda stiili saab kasutada niiteks
erinevate analiiiiside 1dbiviimiseks.

Muuda Jordan Court keskteljega paralleelseid telgjoonte (kdige ddrmised) stiili kui C-
ROAD-RWAY.

Ulejiinud telgjoontele vali C-ROAD-EDGE.

Jargnev ndide késitleb annotatsioonide lisamist telgjoonele.

1)
2)
3)

4)

5)

6)

7)

8)

9)

Ava joonis 06_Alignment Labels.dwg.
Vali Jordan Court telgjoon. Riba pealt vali Add Labels > Add/Edit Station Labels.
Dialoogis Alignment Labels:

a. Vali Type = Major Stations.

b. Major Station Label Style = Parallel with Tick.

c. Kliki Add.
d. Sisesta Increment = 20.
e. Kliki OK.

Suurenda joonist vastavalt ning jirgi siltide lisamist. Pane tdhele, et mérk ja silt on
lisatud 20 meetri tagant.
Vali Jordan Court telgjoon ning kéivita kdsk Add/Edit Station Labels (sama, mis
sammul 2).
Dialoogis Alignment Labels:

a. Type = Minor Stations

b. Minor Station Label Style = Tick.

c. Kliki Add.
d. Muuda Minor Station Increment = 5.
e. Kliki OK.

Vaata telgjoont uuesti. Niilid peaksid tidhele panema, et kahe peamise sildi vahel on 3
alamtéhistust.
Kaivita uuesti Add/Edit Station Labels kds. Dialoogis Alignment Labels:
a. Type = Geometry Points.
b. Geometry Point Label Style = Perpendicular with Tick and Line.
c. Kliki 4dd.
d. Dialoogis Geometry Points vota dra linnukesed vélja arvatud Tangent-Curve
Intersect, Curve-Tangent Intersect ning Reverse Curve-Curve Intersect.
e. Kliki OK, et sulgeda dialoog Geometry Points.
f. Kliki OK, et sulgeda dialoog Alignment Labels.
Uuri lisatud silte ldhemalt.
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Jargnevas néites lood sa siltide grupi ning rakendad seda teisele telgjoonele.

1)
2)
3)
4)

8)

Ava joonis 06_Alignment Label Sets.dwg.

Vali Jordan Court telgjoon. Riba pealt Add Labels > Add/Edit Station Labels.
Dialoogis Alignment Labels vali Save Label Set.

Dialoogis Alignment Label Set sisesta Name = M20 Stations & m5 Ticks & Geometry
Points.

Kliki OK, et sulgeda Alignment Label Set dialoog.

Kliki OK, et sulgeda Alignment Labels dialoog.

Vajuta ESC klahvi, et tithistada Jordan Court telgjoon. Vali Madison Lane telgjoon
ning riba pealt vali Add Labels > Add/Edit Station Labels.

Dialoogis Alignment Labels vali Import Label Set.

Vali M20 Stations & m5 Ticks & Geometry Points, kliki OK.

10) Kliki OK, et sulgeda dialoog Alignment Labels.
11) Vaata Madison Lane telgjoont, ning pane téhele, et sellele on rakendatud sama siltide

esitus, mis ka Jordan Court juures.

Selles ndites redigeerid sa olemasolevaid silte.

1)
2)

3)
4)
5)
6)

7)

Ava joonis 06_Editing Alignment Labels.dwg.

Vali iiks Jordan Court telgjoone geomeetrilistest siltidest. Riba peal vali Edit Label
Group.

Vali Geometry Points > veerg Style. Vali Perpendicular with Tick and Line — Offset,
kliki OK.

Kliki OK, et sulgeda Alignment Labels dialoog. Niilid kuvatakse sildid véljaspool tee
serva.

Hoia all CTRL klahvi ning esimene PC punkt, seejirel riba pealt vali Flip Label. Silt
peegeldatakse teisele poole teed.

Suurenda joonist Madison Lane ning Jordan Court ristumispunkti. Pane téhele, kuidas
0+000 positsiooni Madison Lane silt on konfliktis Jordan Court keskteljega.

Vali 0+000 positsiooni silt (Madison Lane) ning vali nelinurk objektipunkt. Nihuta selle
kaudu silt vabamasse joonise alasse. Kuvatakse viitjoon, mis osutab positsiooni
tegelikule asukohale.

Jargnev ndide kasitleb Station/Offset Label lisamist.

1))

Ava joonis 06_Station Offset Labels.dwg. Joonis avaneb Jordan Court ning Madison
Lane ristumispunktis. Sinu eesmirk on tihistada ristmiku kaarjoonte otspunktid.

Vali Jordan Court telgjoon, kliki Add Labels > Station/Offset — Fixed Point.

Hoia all SHIFT klahvi ning parem klikk, vali Endpoint.

Vali pohjapoolse kaare pohjapoolne punkt. Luuakse uus silt.

Hoia all SHIFT klahvi, parem klikk, vali Endpoint. Kliki 1dunapoolse kaare
1dunapoolsel punktil. Lisatakse uus silt.

Vajuta ESC klahvi kuniks ei ole valitud telgjoont. Vali Madison Lane telgjoon, seejérel
Add Labels > Station/Offset - Fixed Point.

Hoia all SHIFT klahvi, parem klikk vali Endpoint. Vali pdhjapoolse kaare ladnepoolne
punkt.

Hoia all SHIFT klahvi, parem klikk vali Endpoint. Vali ldunapoolse kaare ladnepoolne
punkt. Kaks viimati lisatud silti on seotud Madison Lane telgjoonega.

Vajuta ESC klahvi, et tiihistada telgjoone valik. Nihuta soovi korral viimati lisatud
sildid paremini loetavasse asukohta (1dbi nelinurk objektipunkti).
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Jargnev néide késitleb segmendi siltide lisamist.

1) Avajoonis 06 Segment Labels.dwg.
2) Vali Madison Lane telgjoon, riba pealt Add Labels > Add Alignment Labels.
3) Dialoogis Add Labels:
a. Label Type = Single Segment.
b. Line Label Style = Bearing over Distance.
c. Curve Label Style = Curve Data.
d. Kliki 4dd.
4) Suurenda vaadet nii, et saaksid valida ithe Madison Lane joone. Pane téhele lisatud silti.
5) Vajuta ESC klahvi, et Idpetada siltide lisamine. Vali viimati lisatud silt ning riba pealt
omakorda Flip Label. See vahetab pikkuse ja nurga viljad.
6) Vali veelkord see silt, niilid riba pealt Reverse Label. Pane tdhele, et niilid kuvatakse
SW asemel NE (v0i vastupidi), kuid numbrid ei muutu.
7) Add Labels dialoogis vali uuesti Add. Vali ka teised jooned Madison Lane peal.
8) Vajuta ESC klahvi, et I0petada sildistamise kdsk. Vali kaare silt ning tiri selle
nelinurksest objektipunktist teise asukohta. Lisatakse viitjoon.
9) Dialoogis Add Labels > Label Type = Multiple Segment. Curve Label Style = Curve
Data.
10)Kliki Add ning seejdrel mistahes punktis Jordan Court telgjoonel. Koik jooned
tahistatakse korraga.
11) Vajadusel nihuta viimati lisatud silte, et need oleksid paremini loetavad.

Jargnev ndide késitleb tihise siltide loomist (tag labels).

1) Avajoonis 06 Tag Labels.dwg.

2) Vali Jourdan Court telgjoon, riba pealt vali Add Labels > Add Alignment Labels.

3) Dialoogis Add Labels vali Label type = Multiple Segment.

4) Veendu, et Line Label Style = Circle Tag ning Curve Label Style = Circle Tag.

5) Kliki Add ning seejdrel mistahes Jordan Court telgjoone punktis. Pane tihele, et luuakse
tahiste sildid, kuid numbrid ei ole nii nagu vaja. Seda korrigeerid sa jargmises niites.

Jargnev ndide késitleb tdhise numbrite vahetamist.

1) Avajoonis 06 Renumber Tags.dwg.

2) Vali Jordan Court telgjoon, seejirel riba pealt Renumber Tags.

3) Kasureale sisesta s (Settings) ning vajuta ENTER.

4) Dialoogis Table Tag Numbering muuda kdik vaértused kui 1. Kliki OK.

5) Alustades Jordan Court telgjoone algusest kliki igal tdhise numbril algusest 16puni.

Jargne niide kasitleb téhiste tabeli loomist.

1) Avajoonis 06 Create Table.dwg.

2) Vali Jordan Court telgjoon, seejdrel riba pealt Add Tables > Add Segments.

3) Dialoogis Alignment Table Creation vali site Select by Label or Style.

4) Juhul kui sa ei saa lugeda siltide stiili nimetusi, tiri dialoogi alumisest paremast nurgast
suuremaks. Seejirel tee laiemaks veergu Label Style Name.

5) Vali kastikesed Apply veerus Alignment Curve: Circle Tag ning Alignment Line: Circle
Tag osas.

6) Kliki OK. Vali joonise vabas alas punkt, kuhu lisada tabel. Tabel kuvab niiiid telgjoone
geomeetrilist andmestikku.
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Vertikaalplaneerimine labi profiilide

Peale telgjoone mahamérkimist on vaja ldbi viia esialgne vertikaalanaliilis, millega
analtiiisitakse maapinna korguslikku kulgemist telgjoone kohas. Muuhulgas vastatakse selle
kéigus kiisimustele, kas nditeks on vaja 14bi viia mahukaid kaevetoid vdi pinnast hoopis olulisel
madral juurde tuua. Vertikaalanaliilisiks kasutad saad profiilide loomise tédvahendeid.
Profiilide loomine aitab muuhulgas sul disainida iilejadnud lineaarsed mahtusid nagu sdiduteid,
kanaleid, torustikke jne. Peale profiili loomist nimetatakse seda kui pinnaobjekti profiiliks, mis
on iiks-iiheselt lingitud maapinnamudeliga. Seega kui maapinnamudel muutub, siis muutub ka
profiili esitus. Profiili kuvamiseks kasutatakse Autodesk Civil 3D tarkvaras moistet profiili
vaade (Profile view), mis on lihtsalt iiks vorgustik, kus x-teljel jooksevad positsiooni numbrid
ning y-teljel kdrgusmargid. Sellel vorgustikul kuvatakse ka profiili joon, mis jargib maapinda
etteantud telgjoont pidi. Profiili vaade sisaldab ka erinevaid silte (annotatsioone). Peale esmase
maapinna profiili loomist saab litkuda jargmisesse etappi — luua sdidutee disainprofiil.
Profiilide juures eksisteerivad samad mdisted nagu ka telgjoonte juures — sirged 16igud ning
kaarjooned. Sestap on disainprofiili loomine iisna sarnane telgjoone loomisele. To6vahendite
valik on sisuliselt sama, nupupaani nimetatakse lihtsalt teise nimetusega. Kui esialgse disaini
kdigus piliiiad sa disainprofiiliga jargida voimalikult 1dhedalt olemasolevat maapinda (sest see
on odavam kaevetoode mahtude mdistes), siis lisaks tuleb sul arvestada ka teiste asjaoludega
nagu soOidutee iildised nduded (takistused, dravoolud). Profiilide redigeerimiseks on seetdttu
kittesaadavad terve rida erinevaid toovahendeid. Sarnaselt telgjoone redigeerimisele saad
kasutada objektipunkti pohist redigeerimist, valida todvahendeid nupupaanilt Profile Layout
Tools, redigeerida numbriliselt 1abi Geometry Editor vdi komponent pohiselt. Sarnaselt
soidutee telgjoontele, saab ka profiilide juures iiles seadistada disaini kriteeriume, mis aitavad
sul disaini ldbi viia vastavalt eelseadistatud nduetele. Oluline on siiski rohutada, et need nouded
on sinu t66 holbustamiseks, ning igat ndidatud korvalekallet tuleb analiiiisida. Teisisonu need
aitavad viidata punktidele, mida sa nagunii juba tead, mitte vastupidi (anda uusi teadmisi).
Profiilide juures saab kasutada kahte tiilipi kontrollvotteid: joonte ning kaarjoonte osas. Kui
tekib konflikt disaini ja kriteeriumi vahel, kuvatakse vastav siimbol probleemses kohas koos
lisainfoga.
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Tooleht - Vertikaalplaneerimine ldbi profiilide

Jargnev néide késitleb pinnaobjekti profiili loomist.

Ava joonis 07 _Surface Profile.dwg.

Vali Jordan Court telgjoon, seejdrel riba pealt vali Surface Profile.

Dialoogis Create Profile from Surface veendu, et valitud oleks Jordan Court telgjoon.
Sektsioonis Select Surfaces, vali EG.

Kliki Add ning seejirel OK.

Prospector paanil, laienda Alignments > Centerline Alignments > Jordan Court >
Profiles. Sa peaksid ndgema sektsioonis Profiles: EG — Surface (1).

Parem klikk EG — Surface (1) ning vali Properties.

Dialoogis Profile Properties, paanil Information muuda Name = Jordan Court EGCL.
Kliki OK.

Mairkus: Ehkki Prospector niitab, et profiil on sellega loodud, siis graafiliselt seda veel ei
eksisteeri. Graafiliseks esituseks on sul vaja profiili vaadet.

Jargnev ndide késitleb profiili vaate loomist.

1)
2)
3)
4)

Ava joonis 07 _Profile View.dwg.

Vali Jordan Court telgjoon, seejérel vali riba pealt Profile View.

Dialoogis Create Profile View — General, kliki Create Profile View.

Kui palutakse valida profiili vaate sisestuspunkt, vali punkt joonise ala tiihjas kohas.
Profiil lisatakse seejérel joonisele.

Jargnev nédide késitleb disainprofiili loomist.

1)
2)
3)
4)

S)

6)
7)

Ava joonis 07_Design Profile.dwg.

Vali tiks profiili vaate vorgujoonest ning seejérel vali riba pealt Profile Creation Tools.
Dialoogis Create Profile — Draw New, sisesta Profile Name = Jordan Court FGCL.
Veendu, et Profile style = Design Profile ning Profile Label Label set = No Labels.
Kliki OK.

Nupupaanil Profile Layout Tools vali kdige vasakpoolsemalt nupult kolmnurk, et
laiendada t66vahendeid, vali Draw Tangents With Curves.

Vali OSNAP seadetest Center (lilejdénud liilita vilja).

Vali ringjoone A keskpunkt, seejirel iilejddnud tdhistatud ringjoonte keskpunktid
vasakult paremale. Peale ringjoone G keskpunkti valimist vajuta ENTER. Virskelt
loodud profiil koosneb PVI tiilipi punktidest. Kuna sa valisid Draw Tangents With
Curves, siis koik punktid (vélja arvatud alguses ning Iopus) sisaldavad endas ka
vertikaalset kaarjoont.

Raido Puust | Autodesk Civil 3D algkursus [FERVAE]



Jargnev nédide késitleb profiilide redigeerimist 1ébi objektipunktide.

1)
2)

3)

4)

5)

6)

Ava joonis 07_Graphical Editing.dwg.

Vali sinine Jordan Court FGCL profiil, et ndha selle objektipunkte. Vali {ilespoole
suunatud kolmnurkne objektipunkt Al ldheduses ning tiri see A2 punkti keskele.
Sellega nihutad sa PVI punkti, mis muudab mdlemat puutujat, samas kaarjoone pikkus
jaab samaks ning samaks jddvad ka puutujad mdlemas otsas.

Punkti B1 l1dheduses vali parempoolne kolmnurkne objektipunkt ning tiri see ringjoone
B2 keskpunkti. Seda tiiiipi objektipunkt nihutab PVI punkti piki kallet puutuja sihis.
Vali punkti C1 keskel olev nelinurkne objektipunkt ning tiri seda punkti C2 keskpunkti.
See objektipunkt nihutab puutujat, kuid kalle jadb konstantseks. Selle tulemusena
tostetakse voOi1 langetatakse PVI punkti {ihes otsas ning sellega seoses uueneb ka
kaarjoone geomeetria.

Vali punkti D1 keskel olev ringjoone objektipunkt ning tiri seda punkti D2 keskpunkti.
Sellega nihutame 1dbimispunkti, ehk siis kaarjoon peab ldbima meie poolt nihutatud
punkti muutes sellega kaarjoone pikkust.

Vali punkti E1 keskel olev ringjoone objektipunkt ning tiri seda punkti E2 keskpunkti.
Sellega nihutame me kaarjoone 16pppunkti, mis iihtlasi nihutab ka alguspunkti ning
seetdttu muutub ka kaarjoone pikkus.

Jargnev ndide kisitleb profiili redigeerimist 14bi Profile Layout Tools todvahendite.

1)
2)

3)
4)
5)
6)
7)
8)

9)

Ava joonis 07 _Editing Tools.dwg.

Vali Jordan Court FGCL profiil ning vali seejirel riba pealt Geometry Editor.
Kuvatakse nupupaan Profile Layout Tools.

Nupupaanil Profile Layout Tools vali Insert PVI. Hoide all SHIFT klahvi, tee parem
klikk ning vali Endpoint.

Suurenda profiili vaadet ning vali punkt A-ga tdhistatud keskpunktis. See terav
murdepunkt on olemasoleva sdidutee serv, millega uus sdidutee peab ithenduma.
Nupupaanil Profile Layout Tools vali Delete PVI. Kliki seejérel punkti B 1dheduses. See
kustutab PVT selles punktis ning eemaldab ka kerge murde profiililt.

Nupupaanil Profile Layout Tools kliki Insert PVIs — Tabular.

Dialoogis Insert PVIs, sisesta Station = 0+582 ning Elevation = 53.000.

Vajuta ENTER, et luua uus joon. Seejdrel sisesta Station = 0+655 ning Elevation =
52.750. Kliki OK. See loob kaks uut PVI punkti punktide C ja D ldheduses.
Nupupaanil Profile Layout Tools vali kaarjoonte punkti kdrval olev must kolmnurk, et
ndha mentiid. Vali More Free Vertical Curves > Free Vertical Parabola (PVI Based).

10) Kliki punkti C sees. Sisesta 45 ning vajuta ENTER, et anda kaarjoone pikkus.
11) Kliki punkti D sees. Késureale sisesta 60 kui kaarjoone pikkus ning vajuta ENTER.
12) Vajuta ENTER, et 10petada késk. Sa oled edukalt redigeerinud disainprofiili 1ébi

nupupaani Profile Layout Tools.

Jargnev ndide késitleb profiilide redigeerimist numbriliselt.

Ava joonis 07 _Numerical Editing.dwg.

Vali profiil Jordan Court FGCL, seejirel riba pealt Geometry Editor.

Kliki Profile Grid View, et avada paan Profile Entities ning kuvada profiili numbriline
esitus.

Muuda Station vairtust komponendi 3 osas: 0+080.00 ning PVI Elevation = 57.00.
Muuda ka jargnevate komponentide véértuseid:

\ Komponent | Station | PVI Elevation |
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4 0+260 | 60.0

9]

0+320 | 57.5

6 0+515 [50.0

6)

Sulge Panorama palett. Joonis ei pruugi olla oluliselt teistsugune, kuna tehtud
muudatused olid vaid kergemat laadi. Jata Profile Layout Tools nupupaan ning ka joonis
avatuks jargmise ndite tarvis.

Jargnev ndide kasitleb profiilide redigeerimist komponent pohiselt.

1)
2)

3)

4)
5)

Juhul kui sul ei ole avatud joonis 07_Numerical Editing.dwg, siis tee seda.

Ava nupupaanilt Profile Layout Tools > Profile Layout Parameters. Kuvatakse dialoog
Profile Layout Parameters. See dialoog on esmakordsel avamisel tiihi.

Vali Select PVI nign seejérel Jordan Court FGCL madalaima kaarjoone alumise punkti
laheduses. Niiiid tdidetakse dialoog Profile Layout Parameters andmetega.

Muuda Profile Curve Length = 80.

Sulge Profile Layout Parameters dialoog ning ka Profile Layout Tools nupupaan.
Jéllegi tasub rohutada, et tehtud muudatus oli kergemat laadi, ning see ei pruugi joonisel
viga vélja paista.

Jargnev ndide késitleb disaini kontrollvotete kasutamist.

1)
2)
3)
4)
S)
6)

7)

8)

9)

Ava joonis 07_Design Check Set.dwg.

Kliki Jordan Court FGCL profiilil ning seejérel vali riba pealt Profile Properties.
Dialoogis Profile Properties kliki paanil Design Criteria.

Vali kastike Use Criteria-Based Design.

Vali Use Design Check Set ning seejirel Subdivision.

Kliki OK, et sulgeda dialoog Profile Properties. Vajuta ESC klahvi, et tiihistada profiili
objektipunktide valik. Sa peaksid niilid nigema kahte hoiatust profiili parempoolses
servas.

Suurenda joonist hoiatuspunktide ldhedusse. Liigu hiirega {ile vasakpoolse hoiatuse.
Pane téhele, et probleem on puutuja kaldega.

Vali profiil, et ndha selle objektipunkte. Vali seejirel probleemsest kohast vasakule jadv
PVI punkt ning nihuta seda iilespoole. Ehkki see veateade kaob, voidakse kuvada uus
veateade, kuna me muudame iihtlasi teise puutuja kaldenurka, mis vdib osutuda tile 5%.
Nihuta PVI punkti veidi allapoole nii, et molema puutuja veateated kaovad. Sellega oled
sa korvanud disaini puudujiigid.

10) Liigu niitid hiirega jargijaédnud veateatele. Selle juures kuvatakse hoiatus, et kaarjoone

pikkus on vastuolus miinimumndudega, milleks on iihekordne teepikkus vastavalt
kiirusele.

11) Vali profiil, et kuvada selle objektipunkte, seejdrel vali probleemse kaarjoone iiks

ringjoone kujulisest objektipunktist ning nihuta seda eemale, et kaarjoont pikendada.
Pikendamise kdigus peaks iihel hetkel veateade kaduma.

Jargnev néide kisitleb disaini kriteeriumi faile.

1)
2)
3)

Ava joonis 07 _Design Criteria File.dwg.

Vali profiil Jordan Court FGCL, seejirel riba pealt Profile Properties.

Kliki paanil Design Criteria. Vali kastid Use Criteria-Based Design ning Use Design
Criteria File.
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4)

S)
6)
7)

8)

9)

Vali nupp faili raja 18pus ning vali fail Autodesk Civil 3D Metric (2004) Roadway
Design Standards.xml. Kliki Open.

Veendu, et kastike Use Design Check Set ei oleks valitud.

Kliki OK. Uued veateated kuvatakse erinevatel vertikaalsetel kaarjoonte osadel.

Liigu hiirega kdige vasakpoolsemale veasiimbolile. Mirkusena tuuakse vilja, et
tdidetud pole minimaalse ndhtavuse ndue. Samas kuna mé6dumine ei ole lubatud selles
soidutee sektsioonis, vOib seda veateadet ignoreerida.

Liigu hiirega kdige veateatele, mis paikneb profiili madalaimas punktis. Pane téhele, et
siin pole tdidetud minimaalne ndhtavus sdidutulede kasutamise votmes. Seda nduet
tuleks kindlasti disaini kdigus arvesse votta.

Kliki Jordan Court FGCL profiilil, seejirel riba pealt Geometry Editor.

10) Nupupaanil Profile Layout Tools kliki Profile Grid View.
11) Paletil Panorama keri paremale poole, kuni nided veergu Minimum K for Headlight

Sight Distance. Pane téhele, et veateadet kuvatakse komponendi 6 osas ning ndutud K
vaartus peaks olema 9.000.

12) Keri vasakule, kuni nded K Value veergu. Muuda K = 9. Sellega kaob veateade ning

kaarjoone pikkus on niiiid 74.914. Hea disaini tavana sa mdistagi timardad seda véértust
edasistes ndidetes.

13) Muuda komponendi 6 osas ka Profile Curve Length = 75. See mojutab ka K viirtust,

mis on niitid 9.010 ja sestap on ka veateade endiselt kadunud.
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Profiilide kuvamine ning annoteerimine

Uks joon iitleb sinu poolt loodud disaini kohta viiga viihe. Sestap lisaks graafikale vajame me
tekstilist infot selleks, et seda loodud disaini oleks voimalik ellu viia. Nagu me eelnevalt oleme
Oppinud, siis saab ka profiili vaadetele lisada erinevaid stiili valikuid, mis mojutavad profiili
esitust. Lisaks sellele peab profiil suutma esitada ka teisi voimalikke objekte, millega ristutakse,
nditeks torustikud, kivimikihid jne. Profiili stiili seadete juures eristatakse taas komponentide
taset, mille kaudu saame lihtsalt mdirata, kas neid kuvada voi mitte. Seejdrel saame maéérata
neile komponentidele kihi, vérvitooni, joone tiilibi jpm. Profiili stiili kaudu saame méérata
geomeetriliste punktide esitust profiili joonel. Profiili vaate stiili kaudu saame me aga mdjutada
vorgustikku ennast, kus profiili jooni parasjagu kuvatakse. Néiteks saame maddrata, et
vertikaalis on profiili skaala laiendatud, lisaks mdjutada ka vorgustiku joonte vahekauguseid
ning teostada erinevat liiki annoteerimist (sildistamist). Profiili vaadete alumises osas kuvatakse
iisna sageli ka inforiba (tabelina), mille stiili saab Autodesk Civil 3D tarkvaras muuta vastavalt
oma vajadustele. Nii nagu sdidutee telgjoone juures, saab ka profiilile lisada silte. Voimalik on
lisada tervele profiilile korraga voi mingile kindlale osale. Need sildid kuvatakse hetkel kui
selleks on vajadus (nditeks komponent lisatakse). Néiteks kui profiilile lisatakse vertikaalse
kaarjoone silt, mis omab kokku kolme vertikaalset kaarjoont, siis lisatakse automaatselt ka kolm
silti. Juhul kui sa aga peaksid kustutama mdne komponendi, millele oli méaratud silt, siis iihes
komponendi eemaldamisega, kustutakse ka automaatselt see silt. Sarnaselt sdidutee telgjoonele
saab ka profiilide juures luua siltide gruppe, et neid oleks lihtsam edaspidi korraga lisada. Lisaks
profiilide siltidele tuleb ette olukordi, kus sul on vaja annoteerida mingit muud objekti, mis pole
otseselt seotud profiiliga. Nditeks profiili vaates paiknev toru ja selle kaugus. Selleks kasutad
sa profiili vaate silte, mida on kolme pdhitiilipi: positsiooni korgus, siigavus ning projektsioon.
Profiilile on voimalik lisada (projitseerida) ka teisi objekte nagu lineaarseid objekte (3D
poliijooned, tunnusjooni, moddistusjooni), plokke ning punkte (4AutoCAD punktid, Civil 3D
punktid). Projitseeritud lineaarne joon jadb ka profiili vaates lineaarseks jooneks, kuid see on
seal moonutatud (vilja arvatud juhul kui see on paralleelne telgjoonega). Soltuvalt lineaarse
joone tiilibist saad selle kdrgusmirgi votta kas joonelt endalt voi maapinna objektilt (voi
profiililt) lugedes.
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Tooleht - Profiilide kuvamine ning annoteerimine

Jargnev néide kisitleb profiili kuva muutmist stiili imber valimisega.

1)
2)

3)

4)

5)

6)

7)

8)

9)

Ava joonis 08 Profile Styles.dwg.

Jordan Court profiili vaates kliki punasel, olemasoleval profiili joonel ning vali riba
pealt Profile Properties.

Dialoogis Profile Properties, paan Information, muuda stiil kui _No Display. Seejérel
kliki OK. Antud profiil kaob vaatest. See on mairksa efektiivsem viis objektide
(komponentide) kuva muutmiseks ilma, et peaksime tervet kihti peitma, kus voib asuda
ka teisi meile olulisis objekte.

Vajuta ESC klahvi, et tithistada olemasoleva maapinna profiili valik. Vali seejarel must
disain profiili joon (Jordan Court). Parem klikk ning vali Properties.

Properties paletil muuda Style = Layout ning vajuta ESC klahvi, et tiihistada valik.
Niitid pane téhele, et kuvatakse ka pShipunkte, et seeldbi viia lihtsamini 1&bi disaini
muudatusi.

Vali Jordan Court profiil uuesti. Properties paletil muuda Style = Basic. Tegemist on
vaga lihtsa stiiliga, mis kuvab vaid pohigeomeetriat, markeriteta ning virvi erinevusteta.
Vali uueks stiiliks Style = Design Profile with Markers. See stiil kuvab joone ning
kaarjooned standardsel sdidutee kihil, sisaldab ka markereid, mida iildjuhul kaasatakse
annoteerimisel ning kuvab ka joone pikendusi kriipsjoonena. Seda stiili kasutatakse
iisna sageli 16pp-joonise vormistamisel.

Prospector > Alignments > Centerline Alignments > Jordan Court > Profiles. Parem
klikk Jordan Court EGCL peal ning vali Properties.

Vali stiiliks Existing Ground Profile ning kliki OK.

Jargnev nédide kisitleb profiili vaate stiili muutmist.

1)
2)

3)

4)
S)

6)
7)

Ava joonis 08 Profile View Style.dwg.

Vali Jordan Court profiili vaade iihest selle vorgujoonest. Parem klikk ning vali
Properties. Hetkel on profiili vaate stiili nimetus Major Grids 10V.

Muuda stiill kui Major & Minor Grids 10V. Pane tdhele, et kuvatakse niitid
lisavorgujooned.

Muuda stiil kui Major Grids 5V. Vertikaalset skaalat muudetaks.

Muuda stiili kui Major Grids 1V. Niiiid kuvatakse profiil 1:1-le. Eelnevate néidete baasil
tee omad jireldused, millisega on lihtsaim to6tada?

Vali stiiliks DOT. Tegemist on eristandardiga.

Jéta joonis avatuks jargmise niite tarvis.

Jargnev ndide késitleb inforiba lisamist profiili vaatele.

1)
2)
3)
4)
S)

6)

Jétka eelmisest niitest vOi ava joonis 08 Profile View Style.dwg. Vali Jordan Court
profiili vaade selle vorgujoonest ning seejirel riba pealt Profile View Properties.
Dialoogis Profile View Properties, paanil Information, vali Object Style = Major &
Minor Grids 10V.

Vali paan Bands. Veendu, et Band Type = Profile Data.

Sektsioonis Select Band Style, vali Elevations and Stations. Seejarel kliki Add.
Dialoogis Geometry Points to Label in Band, paanil Profile Points, vali Jordan Court
EGCL kui Profile 1. Kliki OK. Uus rida lisatakse riba nimekirja.

Dialoogis Profile View Properties liigu paremale kuniks nded veergu Profile 2. Vali
selle veeru lahter ning seejérel vali Jordan Court FGCL.
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7)

8)
9)

Kliki OK, et sulgeda Profile View Properties dialoog. Profiili vaate alumises sektsioonis
on niilid inforiba, mis kuvab positsioonide sildid, korgusmairgid kindla sammu tagant.
See inforiba on disainitud kahe profiili tarvis. Seega on seal ka kaks erinevat gruppi
korgusmirke. Vasakpoolne kuvab infot Jordan Court EGCL profiili kohta ning
parempoolne Jordan Court FGCL profiili kohta.

Vali profiili vaade ning vali riba pealt Profile View Properties.

Paanil Bands vali Band Type = Horizontal Geometry.

10) Sektsioonis Select Band Style, vali Geometry ning kliki Add.
11) Kliki OK. Uus inforiba kuvab infot telgjoone geomeetria kohta.
12) Vali Jordan Court profiili vaade, seejirel riba pealt Profile View Properties. Paanilt

Bands kliki real Horizontal Geometry ning vajuta punast risti, et see eemaldada.

13)Kliki OK, et naasta joonisele. Eelnevalt lisatud Horizontal Geometry inforiba on

eemaldatud.

Jargnev néide késitleb siltide lisamist profiili vaatele.

1)
2)
3)
4)
)
6)

7)

8)

9)

Ava joonis 08 Profile Labels.dwg.

Vali profiil Jordan Court FGCL, seejirel riba pealt Edit Profile Labels.

Dialoogis Profile Labels — Jordan Court FGCL, vali Type = Crest Curves.

Vali Profile Crest Curve Label Style = Crest Only ning kliki Add.

Kliki OK, et naasta joonisele. Kdik vastavad jooned on profiilil annoteeritud.

Vali Jordan Court FGCL profiil, seejérel riba pealt uuesti Edit Profile Labels. Lisa ka
jargmised profiili sildid:

Type Style

Sag Curves Sag Only

Lines Precent Grade

Grade Breaks | Station over Elevation

Kliki OK, et sulgeda dialoog Profile Labels — Jordan Court FGCL ning naase joonisele.
Profiil on niiiid kaetud erinevate annotatsioonidega. Mdnede siltide paigutust tuleb veidi
muuta, et need oleksid loetavamad.

Suurenda vaadet vasakult kolmandale kdverjoone sildile. Pane téhele, et kaarjoone
pikkuse mdot 16ikab profiili.

Vali silt, et kuvada selle objektipunktid. Vali seejérel teemandi kujuline objektipunkt
(moddu teksti allosast) ning tiri see iilesse poole, kuniks see on loetavam.

10) Korda eelmist sammu ka teiste probleemsete siltide juures.

Jargnev ndide késitleb sildi grupi loomist ning rakendamist joonise profiilile.

1)
2)
3)
4)
5)

6)

Ava joonis 08_Profile Label Set.dwg.

Vali profiil Jordan Court FGCL ning riba pealt Edit Profile Labels.

Dialoogis Profile Labels — Jordan Court FGCL, vali Save Label Set, et avada dialoog
Profile Label Set — New Profile Label Set.

Vali paan Information ning sisesta Name = Curves-Grades-Breaks. Kliki OK (kaks
korda), et viljuda dialoogidest.

Vajuta ESC klahvi, et tiihistada profiili valik. Suurenda Logan Court profiili vaatele.
Vali Logan Court Profile FGCL ning riba pealt Edit Profile Labels.

Dialoogis Profile Labels — Logan Court FGCL, vali Import Label Set.
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7)

Vali dialoogis Select Label Set > Curve-Grades-Breaks ning kliki OK. Sulge dialoog
Profile Labels vajutades OK. Vastav siltide grupp on niiiid lisatud ka Logan Court
FGCL profiilile.

Jargnev néide késitleb profiili vaate silte.

1)

2)
3)

4)
5)
6)
7)
8)

9)

Ava joonis 08 Profile View Labels.dwg. See joonis avaneb suurendatult Jordan Court
FGCL profiili vasakusse serva. Pane tdhele, et seal paikneb iiks PVI punkt, mis seob
uue sdidutee olemasolevaga. Lisaks on profiilil selgelt ndha ka v-kujuline kraav.

Vali iiks vOrgujoontest ning seejérel riba pealt Add View Labels > Station Elevation.
Hoides all SHIFT klahvi, parem klikk ning vali Endpoint.

Vali teise PVI punkti musta ringjoone keskpunkt.

Korda samme, et nédidata ka korgusmérk (sama punkt). Kuvatakse uus silt, kuid see
kattub olemasolevaga.

Vajuta ESC klahvi kaks korda, et tiihistada profiili vaate valik. Vali viimati lisatud silt
ning tiri nelinurksest objektipunktist seda veidi paremale.

Silt on endiselt valitud, vali riba pealt Edit Label Text. Kuvatakse dialoog Text
Component Editor.

Dialoogi paremas eelvaates kliki vahetult enne S74 kirjet ning vajuta ENTER, et see
rida viia jargmisele. Sul on niitid ks tiihi rida.

Tiihjale reale sisesta TIE TO EDGE ning vajuta ENTER.

10) Sisesta OF EXIST ROAD.
11) Kliki OK, et naasta joonisele. Silt viitab niiiid selgelt asja olemusele.
12) Vajuta ESC, et tiihistada sildi valik. Vali iiks vorgujoontest ning seejirel Add View

Labels > Depth.

13) Vali punkt kraavi pdhjast, ning seejérel selle {ilaosast.
14) Vajuta ESC klahvi, et I1dpetada késk tiihistada profiili vaate valik.
15) Vali viimati tehtud silt, seejdrel vali iiks selle objektipunktidest, nihuta seda ning pane

samal ajal téhele selle vdartuse muutumist.

Jargnev ndide kisitleb lineaarse objekti lisamist profiili vaatele.

1)
2)

3)
4)

S)

6)

Ava joonis 08 Object Projection.dwg.

Vali profiili vaate Jordan Court iiks vOrgujoontest ning seejirel riba pealt Project
Objects to Profile View.

Vali sinine 3D poliijoon, mis esitab veetoru ning paigutatud paralleelselt idapoolse
krundipiiriga. Vajuta ENTER.

Dialoogis Project Objects to Profile View veendu, et Style = Basic ning Elevation
Option = Use Object.

Kliki OK. Projitseeritud veetoru paikneb niilid ka profiili vaatel. Pane tdhele kummalisi
nurki positsiooni 0+360 kandis. Need on tingitud asjaolust, et telgjoon liigub veetorust
eemale, mis tekitabki selliseid veidrad esitusi profiilil.

Jata joonis avatuks ka jargmise néite tarvis.

Jargnev ndide késitleb plokkinde ning Civil 3D punktide projitseerimist profiili vaatele.

1)
2)

3)

Vali Jordan Court profiili vaade ning seejdrel riba pealt Project Objects to Profile View.
Vali kolm punkti, mis on margitud kui BORE ning kuvatud Jordan Court telgjoonel.
Vajuta ENTER.

Dialoogis Project Objects to Profile View veendu, et oleks valitud Style = Test Bore
ning Elevation Option = Use Object.
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4)

S)

6)
7)

8)

Kliki OK, et ndha projitseeritud punkte profiili vaatel. Pane tdhele, et need on lisatud
koos markeriga ning sildiga, mis kuvab positsiooni numbri ning maapinna kdrgusmargi.
Vajuta ESC klahvi, et tiihistada eelnev valik. Suurenda Logan Court profiili selle
keskossa ning pane téhele punast proovipuurimise siimbolit. See on AutoCAD plokk
ning mitte Civil 3D punkt.

Vali Logan Court profiili vaade ning seejérel kliki riba pealt Project Objects to Profile
View.

Vali punane proovipuurimise siimbol ning vajuta ENTER. Veendu, et Style = Basic
ning Elevation Opitons > Surface > EG.

Kliki OK ning pane tdhele uut projektsiooni. See ndeb vilja iisna sarnane Civil 3D
projitseeritud punktile, ehkki lahteobjektiks on AutoCAD plokk, millele ei ole lisatud
korgusmarki.
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Disain 3D-s libi koridormudelite

Selles peatiikis me liigume vaikselt lineaarselt disainilt 3D disainile, mida Civil 3D tarkvaras
ka koridormudelina tuntakse. Koridormudel on meie lineaarsete objektide kogum, mis annabki
meie disainile nii-6elda 3D mahu. Enne kui saab 3D disaini kokku panna on vaja iile kdia moned
pohimadisted. Kui sdidutee telgjoon ning profiil omavahel kokku panna, moodustub sellest nii-
oelda soidutee selgroog, mida on vdimalik tdhele panna ka joonise perspektiivvaates (vaikimisi
sinise joonega). Soidutee vormi andmiseks on aga vajalik veel ka kogumite (assembly)
defineerimine, mis sisuliselt tihendab sdidutee ristldigete loomist, kus ndidatakse dra sdidutee
erinevad komponendid sdidutee telgjoone suhtes. Uks kogum vdib koosneda mitmest erinevast
alamkogumist (subassembly). Kuna sdidutee voib oma iilesehituselt telgjoone pikkuse sihis
muutuda, siis lisataksegi need kogumid kindla vahe tagant, mille tagajérjel moodustub skelett.
Seejirel, et moodustuks 3D esitus on vaja veel ka tunnusjoonte (feature line) lisamist, mis
ithendavad kogumid (ristldiked) omavahel iiheks tervikuks. Kd&ik eelnimetatud objektid on
omavahel lingitud. Kui iiks neist peaks muutuma, muutub kogu 3D mudeli esitus.
Koridormudeli 16pp-produkt on koridor pinnaobjekt (corridor surface). Ehkki ka neid
pinnaobjekte kuvatakse Prospector paletil, on tegemist eritliiipi pinnaobjektiga, mis omakorda
on lingitud koridormudeliga. Nendega saab 1dbi viia samasid analiilise, mida ka tavaliste
pinnaobjektidega. Koridormudelid on vdimelised kohanduma vastavalt vajadustele. Selleks
kasutatakse spetsiaalseid alamkogumeid (subassemblies). Tépsemalt Oeldes kaasatakse
koridormudelite sihte (corridor target), mida on kolme pdhitiilipi: surface targets, widths/offset
targets ning slope/elevation targets. Surface target sihte kasutatakse nditeks muldkehade
automaatseks loomiseks kui koridormudel paikneb olemasolevast maapinnast korgemal.
Width/ofset target sihte saab kasutada teelaienduste loomisel. Slope/elevation target sihte saab
kasutada néditeks sdidutee servas oleva kraavi korgusmérgi loomisel, et tagada sademete
voolamine kindlasse punkti ja seda soltumata sdidutee enda kaldest. On oluline réhutada, et
Civil 3D tarkvaraga kaasa tulevad alamkogumid on osaliselt sihtidega varustatud ning osaliselt
mitte. Néites kasutatav BasicLane alamkogum sihte ei oma.

Taiesti omaette valdkond koridormudeli sihtide ning regioonide votmes on ristmike disain.
Kuna nende loomisel kaasatakse mitmeid erinevaid baasjooni, regioone ning sihte. Autodesk
Civil 3D sisaldab endas aga ka toOvahendit Create Intersection, mis aitab luua neid
seoseid/linke. Toovahendi kasutamisel kuvatakse sulle terve rida alamdialooge (juhiseid).
Esmalt General sektsioonis saad méérata pohiseaded (nimetus, kirjeldus, stiilid ning ka
ristmiku tiilip). Seejérel Geometry Details sektsioonis valid sa telgjoonele vastava profiili ning
seadistad ka ddrekivi seaded/profiilid jne. Sektsioonis Corridor Regions miirad sa erinevad
kogumid, mida kaasatakse ristmiku disaini. Seda nimetatakse ka kogumi grupiks (assembly set)
ja uldjuhul on selle eest vastutav iiks kindel inimene firmas. Késu lopetamisel on tulemuseks
terviklik ristmik, mis kaasab endas nii uusi baasjooni, regioone kui ka sihte. Ja mdistagi muutub
ristmiku disain iihes alamkomponentide muutumisega.
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Tooleht - Disain 3D-s labi koridormudelite

Jargnev nédide kisitleb kogumi (assembly) loomist.

1) Avajoonis 09 Creating an Assembly.dwg.

2) Valiriba pealt Home > Assembly > Create Assembly.

3) Dialoogis Create Assembly sisesta nimeks Subdivision Road.

4) Vali Code Set Style > All Codes with Hatching, kliki OK.

5) Kliki iilemise parempoolse vaateaknas keskel, et lisada kogumi baasjoon. Kuvatakse
punane vertikaalne joon.

6) Riba paanilt Home > Tool Palettes.

7) Tool Palettes paletil tee parem klikk paleti nime ribal ning vali Civil Metric
Subassemblies.

8) Seejérel paan Basic.

9) Paanil Basic, kliki BasicLane. Kuvatakse Properties aken ning kisureal palutakse sul
valida sisestuspunkt.

10) Properties paletil veendu, et Side = Right ning seejérel kliki baasjoone keskpunkti
laheduses. Raja alamkogum lisatakse baasjoonele.

11) Basic paletilt vali niiiid BasicCurbAndGutter.

12) Properties aknas muuda véartus Curb Height = 0.15.

13) Vali iilemine punane ringjoone marker viimati lisatud raja alamkogumilt. Lisatakse
adrekivi ning kraavi alakogum.

14) Vajuta ESC, et 1opetada eelnev kdsk. Vali eelnevalt lisatud kaks alamkogumit ning vali
riba pealt Mirror.

15) Vali vertikaalne punane baasjoon. Niilid kuvatakse vastavad alamkogumid molemal
pool baasjoont.

Jargnev ndide kasitleb koridormudeli loomist olemasolevast telgjoonest, profiilist ning
kogumist.

1) Avajoonis 09 Creating a Corridor.dwg.

2) Riba pealt vali Corridor.

3) Kuvatakse dialoog Create Corridor, tee jirgmised muudatused:

Name = Jordan Court

Alignment = Jordan Court

Profile = Jordan Court FGCL

Assembly = Subdivision Road

Eemalda linnuke kastist Set Baseline and Region Parameters.

Kliki OK.

4) Suurenda vaateakna paremasse alaserva ning pane tdhele loodud koridormudelit.

hOe a0 o

Jargnev ndide kasitleb kogumi redigeerimist, mis kaasab alamkogumeid, et need oleksid
vOimelised arvesse votma ka sihte.

1) Avajoonis 09 Adding Target Subassemblies.dwg.

2) Ava Tool Palettes palett, seejérel paan Basic.

3) Parem klikk BasicLaneTransition peal ning vali Apply Tool Properties To Subassembly.

4) Ulemises, parempoolses vaateaknas vali mdlemad sdidutee alamkogumid Subdivision
Road osas ning vajuta ENTER. Kogum muutub veidi veidraks, kuna kdik komponendid
nihutatakse iihele poole.

5) Vajuta ESC klahvi, et tiihistada valik. Vali kogumi vertikaalne baasjoon, seejérel riba
pealt Assembly Properties.
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6) Dialoogis Assembly Properties tee jirgmised muudatused:

a. Kliki paanil Construction. Kliki kaks korda Group (1) peal, et redigeerida selle
nimetust. Sisesta Right ning vajuta ENTER. Kasuta sama protseduuri, et muuda
ara Group (2) = Lefft.

b. Sektsiooni Right all nimeta kaks alamkogumit kui Right Lane ning Right Curb.
Tee seda sama Left grupi osas, nimetades need vastavalt Left Name ning Left
Curb.

c. Vali Right Lane ning muuda selle Side véartus kui Right. Tee seda sama Left
Lane osas kui Side = Left.

d. Nii Left Lane kui ka Right Lane osas muuda vaartust Transition = Hold Grade,
Change Offset.

7) Kliki OK, et sulgeda dialoog Assembly Properties. Niilid ndeb kogum vilja nii nagu
peab.

8) Paletil Basic vali BasicSideSlopeCutDitch.

9) Properties paletil veendu, et Side = Left. Kliki Left Curb alamkogumi {ilemises vasakus
nurgapunktis.

10) Kliki Right Curb alamkogumi {ilemises parempoolses nurgapunktis.

11) Vajuta ESC, et ldpetada aktiivne kdsk. Vali parempoolne BasicSideSlopeCutDitch
alamkogum ning vali riba pealt Subassembly Properties.

12) Dialoogis Subassembly Properties paanil Information muuda nimetus kui Right
Daylight.

13) Korda eelmist sammu alakogumiga vasakul ning nimeta see kui Left Daylight.

Jargnev ndide késitleb sihtide (target) lisamist koridormudelile.

1) Avajoonis 09 _Applying Corridor Targets.dwg.

2) Vali jooniselt koridormudel ning seejirel riba pealt Edit Targets.

3) Kui palutakse valida regioon, kliki vasakpoolse vaateakna koridormudeli peal. Seda
tehes peaksid ndgema sinist perimeeterjoont koridormudeli iimber. Regioon on
vaikimisi terve koridormudel, kuid seda on disaini arenedes vodimalik jagada
alamregioonideks.

4) Dialoogis Target Mapping, sektsioonis Width or Offset Targets, vali Object Name veeru
osas <None> (Left Lane rea osas). See avab dialoogi Set Width or Offset Target.

5) Dialoogis Set Width or Offset Target, sektsioonis Select Object Type to Target, vali
Feature Lines, Survey Figures, and Polylines.

6) Vali Select from Drawing. Seejérel vasakus vaateaknas suurenda vaadet Jordan Court
algusesse, kus see ristub Emerson Road sdiduteega.

7) Kliki punasel poliijjoonel, mis esitab ndutud rajajoont vasaku sdidutee servale ning
vajuta seejirel ENTER.

8) Kliki OK kuniks oled naasnud joonisele. Sellega oleme koridormudelit laiendanud
sissesdidutee osas. Uhtlasi tekitame sellega lisaruumi, et pooret oleks ohutum teostada.

9) Kliki koridormudeli sees, et avada uuesti Target Mapping dialoog.

10) Dialoogis Target Mapping, kliki Surfaces lahtril <Click Here to Set All>.

11) Liigu ringi alumises parempoolses vaateaknas, et ndiha 3D koridormudeli esitust. Vali
EG ning seejdrel kliki OK. Seejérel sulge ka Target Mapping dialoog. Sa peaksid niiiid
ndgema lisageomeetriat koridormudeli servades See kuvab nii-6elda lisamuldkeha, mis
rakendati seoses kdrguste erinevusega. Mdnes kohas on see laiem kui teises.

Jargnev ndide késitleb koridormudeli pinnaobjekti (corridor surface) loomist.
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8)
9)

Ava joonis 09 _Creating a Corridor Surface.dwg.

Vali Jordan Court koridormudel ning seejirel vali riba pealt Corridor Surfaces.
Dialoogis Corridor Surfaces kliki kdige vasakpoolsemal ikoonil, et luua uus
koridormudeli pinnaobjekt.

Redigeeri selle nimetust kui Jordan Court FG.

Veendu, et Data Type = Links ning Code = Top.

Kliki plussmaérgil, et lisada Top kodeeritud lingid pinnaobjektile.

Kliki OK. Kui kuvatakse dialoog Corridor Properties — Rebuild, kliki Rebuild the
Corridor. Vasakus vaateaknas peaksid niitid nigema kontuurjooni ning parempoolses
alumises aknas 7N jooni, samas on krundi keskel iisna suur ala, kus pinnaobjekti infot
nédidatakse valesti.

Vali koridormudel, seejérel Corridor Surfaces (riba pealt).

Vali dialoogis Corridor Surfaces paan Boundaries.

10) Paerm klikk Jordan Court FG peal ning vali Corridor Extents as Outer Boundary.
11)Kliki OK, et naasta joonisele. Kui kuvatakse dialoog Corridor Properties — Rebuild,

kliki Rebuild the Corridor. Niitid kuvatakse kontuurjooned diges mahus.
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Ristloigete loomine

Selles peatiikis tutvume disainist ristldigete tegemisega. Esimese vOimalusena kasutame
Section Editor toovahendit, mis pohimotteliselt voimaldab vaadata igat kogumi sisestust
ristldike vaatena, kaasates muuhulgas ka koikvoimalikud sihid (zargets). Lisaks saad Section
Editor toovahendit kasutada ka koridormudeli disainimiseks. Selleks kasutad sa Parameter
Editor to6vahendit.

Kui profiilide osas iitleb telgjoon ette, mida modda profiili 15igata, siis ristldigetele antakse
sellest teada ldbi valimi joonte (sample lines). Valimi jooni saab lisada gruppidesse ning
maiirata, millised neist seovad ristldikeid. Valimi jooni saab lasta genereerida viga erineval
moel (nt positsioonide jirgi, lihtlase kauguse jirgi, valida suvalisi meelepéraseid punkte voi
olemasolevate poliijoonte jargi).

Peale valimi joonte lisamist saame liitkuda edasi ning luua ristldike vaated. Ristldike vaated on
iisna sarnased profiili vaadetele. Ristldike vaateid saab luua iihekaupa voi grupina. Peale
ristldike vaadete loomist on neile voimalik lisada uut infot ilma, et neid peaks hakkama uuesti
looma.

Raido Puust | Autodesk Civil 3D algkursus VK]



Tooleht - Ristloigete loomine

Jargnev ndide kasitleb Section Editor toovahendit, et vaadata ning redigeerida koridormudeli

disaini.

1)
2)

3)
4)
S)

6)

7)
8)

9)

Ava joonis 10 Using Section Editor.dwg.

Vasakus vaateaknas vali iiks koridormudeli sinistest koridor joonest. Seejirel liigu
parempoolsesse iilemisse vaateaknasse ning vali riba pealt Section Editor. Ulemine
vaateaken kuvab niitid koridormudeli ristldiget sinu poolt valitud punktis, mille valisid
vahetult enne Section Editor kisu valimist.

Vasakus vaateaknas vdhenda vaadet, et ndeksid ka Jordan Court profiili vaadet. Riba
peal vali Go to Next Station, et litkuda jargmisesse koridormudeli sektsiooni. Pane
tahele, et sulle kuvatakse infot nii plaanil kui profiilil, kus sa parasjagu oled.

Riba peal laienda nimekirja Select a Station ning vali 0+050.00 m. Suurenda 16ike
vaatele ning pane tdhele mdlemal pool teed olevaid kraave. Need lisati automaatselt,
kuna sdidutee on 1dike reziimis, samas on 1dige nii tiihine, et seda voiks ignoreerida.
Vali riba pealt Parameter Editor. Kuvatakse aken Corridor Parameters.

Corridor Parameters aknas leia sektsioon Left Daylight ning muuda véértust Backslope
Width ja Foreslope Width = 0.000.

Tee seda sama ka Right Daylight osas.

Kliki riba peal Close, et sulgeda Section Editor. Pane tdhele, et vastav kraav on niitid
eemaldatud, kuid vaid {ihest kohast. Sina soovid seda aga rakendada veel monda kohta.
Vali sinine koridorjoon, kliki {ilemises parempoolses vaateaknas ning seejirel kliki
Section Editor (riba pealt). Vali positsioon 0+050.000 veelkord.

10) Riba peal kliki Parameter Editor. Kuvatakse Corridor Parameters aken.
11) Riba peal kliki Apply to a Station Range.
12) Dialoogis Apply to a Station Range kliki nupul Pick (Start Station korval). Vali punkt

vasakust vaateaknast just kraavidest loodest.

13) Korda eelmist sammu End Station osas, niilid valides kraavidest kagus olev punkt.
14) Kliki OK, et sulgeda dialoog Apply to a Station Range ning seejérel ka Close, et sulgeda

Section Editor.

15) Vali koridormudel ning seejirel riba pealt Rebuild Corridor. Niiiid on kraavid

koridormudelilt eemaldatud.

Jargnev ndide kisitleb valimijoonte (sample lines) loomist.

1)
2)
3)

4)

S)
6)

7)

Ava joonis 10 _Creating Sample Lines.dwg.
Riba Home paanilt vali Sample Lines.
Kui palutakse valida telgjoon, vajuta ENTER ning vali Jordan Court dialoogis Select
Alignment. Kliki OK.
Dialoogis Create Sample Line Group tee jargmist:
a. Name = Design.
b. Sample Line Style = Road Sample Line.
c. Sample Line Label Style = Section Name.
d. Sektsioonis Select Data Sources to Sample, eemalda koik kastikesed vilja
arvatud teisest. Kliki OK.
Nupupaanil Sample Line Tools laienda nupu vaadet, mis esitab erinevad loomise
meetodid ning vali From Corridor Stations.
Dialoogis Create Sample Lines — From Corridor Stations kliki OK, et ndustuda
vaikimisi seadetega ning luua valimi jooned.
Vajuta ESC, et 1opetada késk
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8)

Suurenda vasakpoolsesse vaateaknasse ning pane tahele just loodud valimi jooni.

Jargnev néide késitleb tliksikute ristldike vaadete loomist.

1)
2)

3)

4)

5)

6)
7)

8)

Ava joonis 10 _Creating Single Section Views.dwg.
Vasakus vaateaknas suurenda valimi joonele 0+405.00. Kliki valimi joonel ning
seejarel riba pealt Create Section View > Create Section View.
Dialoogis Create Section View — General, veendu, et oleks valitud:

a. Alignment = Jordan Court

b. Sample Line Group Name = Design

c. Sample Line = 0+405.00

d. Station = 0+405.00 m

e. Section View Style = Design.
Kliki Next, et litkuda edasi sektsiooni Create Section View — Offset Range. Pane téhele,
et sa saad muuta ristloike vaate laiust, muutes ofset range parameetrit.
Kliki Next, et litkuda edasi sektsiooni Create Section View — Elevation Range. Pane
tahele, et sa saad muuda ristloike vaate korgust, muutes parameetrit minimum ning
maximum elevation.
Kliki Next, et liikkuda sektsiooni Section Display Options. Veendu, et stiilina oleks
valitud Jordan Court osas: Design.
Kliki Next, et liikkuda dialoogi Data Bands. Veendu, et sektsioonis Select Band Set oleks
valitud Design Offsets. Kliki Create Section View.
Kui palutakse ndidata ristldike vaate nurgapunkt, vali iilemisest parempoolsest
vaateaknast keskmine punkt. Uus ristldike vaade on sellega joonisele lisatud. Seda
ristldike vaadet saab kasutada disaini muutmiseks teatud kohast.

Jargnev ndide kisitleb mitme ristloike vaate korraga loomist.

1)

2)
3)
4)

S)
6)
7)
8)
9)

Ava joonis 10 Creating Multiple Section Views.dwg. See joonis sisaldab iihte uut
valimi joonte gruppi nimetusega Section Sheets, mis jaotab valimi jooned {iihtlaste
vahedega.

Riba paanilt Home > Section Views > Create Multiple Views. Kuvatakse dialoogide
seeria Create Multiple Section Views Wizard.

Create Multiple Section Views Wizard — General dialoogis vali Sample Line Group
Name = Section Sheets. Kliki Next.

Dialoogis Create Multiple Section Views — Section Placement veendu, et Placement
Options = Production.

Kliki nupul, mis aitab valida faili dialoogis Select Layout as Sheet Template.

Kliki nupul, mille kaudu saad dialoogis Select Layout as Sheet Template valida faili.
Leia fail 10 _Sections.dwt ning kliki Open.

Vali ISO A0 Section 1 to 200 ning kliki OK.

Veendu, et Group Plot Style = Plot by Page.

10) Kliki Next iilejadnud alamdialoogides ning viska pilk peale seal olevatele seadetele.

Kliki Create Section Views.

11) Vali iilemises parempoolses vaateaknas iiks punkt. Luuakse kolm uut ristldike vaadete

lehte.
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Selles ndites lisad sa joonisele uusi andmemahtusid, et Idpptulemusena saaksid kuvada neid ka
ristldike vaadetel.

1) Avajoonis 10 Sampling More Sources.dwg.

2) Vali parempoolsest iilemisest aknast iiks ristldike vaade ning seejérel riba pealt Sample
More Sources.

3) Dialoogis Section Sources vali Available Sources = EG. Seejérel kliki Add.

4) Sektsioonis Sampled Sources, veendu et EG osas on madratud stiilina Existing Ground.

5) Kliki OK, et vidljuda dialoogist. Peale moningast pausi peaksid néigema, et kdikidele
ristloike vaadetele lisatakse punane joon, mis esitab olemasolevat maapinda. Lisaks
sellele on maapinna joonele lisatud vaikimisi siltide grupp, mida hetkel me kiill ei vaja.

6) Ristldike vaade on endiselt valitud, vali riba pealt View Group Properties. Kuvatakse
dialoog Section View Group Properties.

7) Paanil Sections kliki EG osas veerus Label Set: <Edit>.

8) Vali _No Labels ning kliki OK. Sulge ka dialoog Section View Group Properties. Silte
enam ei kuvata.

9) Jirgi jarjekorras koikide ristldike vaadete kulgemist.

10) Riba paanil Insert > LandXML.

11) Vali fail 10 _Preliminary Waterline.xml. Kliki Open.

12)Kliki OK, et sulgeda dialoog Import LandXML. Uus esialgne veetorustik lisatakse
joonisele.

13) Vali iiks ristldike vaadetest ning seejérel kliki riba pealt Sample More Sources.

14) Dialoogis Selection Sources vali Preliminary Waterline ning seejérel kliki Add. Kliki
OK, et sulgeda dialoog.

15) Vajuta ESC, et tiihistada objektide valik. Suurenda ristldike vaadetele, et ndha lisatud
veetoru joont. Jirgi ristloike vaateid ka selle pilguga, kas antud veetoru rajamine on
mones ristldike punktis raskendatud?

16) Kasutades taas LandXML késku, too niitid sisse /0 Subsurface Rock.xml.

17) Kasuta Sample More Sources késku, et lisada uus pinnaobjekt nimetusega Rock ka
ristldike vaadetele. Mééra selle stiil kui Rock.

18) Taaskord pead sa eemaldama lisatud sildid. Vali ristldike vaade, seejérel riba pealt View
Group Properties.

19) Vali Rock rea osas veerus Change Labels = <Edit>. Vali _No Labels ning seejérel OK.
Kliki OK, et naasta joonisele.

20) Uuri taaskord ristldike vaateid. Kui tegemist oleks tegeliku projektiga peaksid ilmselt
peatoovotjat informeerima, et veetoru paigaldamiseks on mdnes kohas vaja teostada
ekstra kaevandusi kivimi kihis. Lisaks pane téhele, et nditeks positsiooni 0+270 juures
on kivimi kiht iisna ldhedal pinnaobjektile. Voib-olla on mdistlik tdsta sdidutee
tasapinda, et viltida kaevandamist kivimi kihis.
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Ristloigete kuvamine ning annoteerimine

Selles peatiikis tutvume ristldike stiilidega. Uhed stiilid mdjutavad ristldiget ennast, samas kui
teised ristldike vaadet. Taas vOib paralleele tommata profiili vaadetega. Ka annotatsioonide
juures saab eristada kahte erinevat tiitipi. On neid, mis seovad end kindla ristldikega ning on ka
neid, mis paiknevad ristldike vaate peal.

Sarnaselt profiilidele saab ka ristldike vaateid annoteerida siltidega voi sildi gruppidega.
Pohilised sildistamise tiilibid on: major offset labels, minor offset labels, segment labels, grade
break labels. Kui kaks esimest lisatakse teatud intervalli tagant, siis kaks viimast kindlatesse
punktidesse.

Kui ristldike vaadetele on siltide lisamine tisna lihtne, siis mOnevorra keerulisem on seda teha
koridormudeli ristldigetele. Selleks kasutame me spetsiaalset moistet nagu code set style. Kui
piitida uuesti lahti seletada, mis asi on koridormudeli ristldige? Tegemist on sisuliselt {ihe
objekti kogumiga, mis omakorda koosneb alamkogumitest. Need viimased aga jagunevad juba
punktideks, joonteks ning kujunditeks. Iga eelnimetatud komponendile on vaikimisi kiilge
poogitud vdhemalt liks kood (code) ja see médrabki, kuidas code set style tervikuna toole
hakkab. Uks tervik code set style kaasab siis erinevate alakogumite/komponentide koode
(stiile).

Ristldike vaate stiilid on lisna sarnased profiili vaate stiilidele. Ainsaks erinevuseks on asjaolu,
et kui profiili vaade esitab x-teljel positsiooni numbrid, siis ristldike vaade nii-Gelda
korvalekalded (nihked).

Ristldike vaadetele saab sarnaselt profiili vaadetele lisada inforibasid. Sul on vdimalik lisada
kahte pohitiilipi inforiba: section data band ning section segment band. Esimene neist on lildine
ning rakendub iile vaate. Teine vaid kindlale 1digule.

Ristloikeid saab paberite peal jaotada 1dbi group plot style sitte.

Juhul kui sa soovid lisada silti, mis ei ole seotud otseselt iihegi objektiga aga paigutada seda
siiski ristloike vaatele, kasutad sa spetsiaalset sildi tiitipi.
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Tooleht - Ristloigete kuvamine ning annoteerimine

Jargnev néide késitleb ristldike stiilide rakendamist.

1)

2)

3)

4)

5)
6)
7)
8)

9)

Ava joonis 11_Applying Section Styles.dwg. Sulle kuvatakse kolm ristldike vaadet,
mille kaudu jérgida kivimikihi paiknemist. See ristldike vaade kuvab koridormudeli
16iget, olemasoleva maapinna 15iget ning kivimikihi 15iget.

Vali koige alumise ristloike vaatelt (positsioonilt 0+260.00) koige alumine ristldike
joon, seejirel vali riba pealt Section Properties.

Dialoogis Section Properties, paanil Information muuda Object Style = Rock. Kliki OK,
et sulgeda dialoog. Vajuta ESC klahvi, et tiihistada valik. Kivimi kiht kuvatakse niitid
halli kriipsjoonena.

Korda eelnevaid samme ka kivimikihist tileval poole oleva ristldike osas. Stiilina vali
niiiid Exissting Ground. Vajuta ESC klahvi, et tiihistada valik. Olemasolevat maapinda
kuvatakse niiiid punase kriipsjoonena.

Vali alumise ristloike positsioon 0+270.00. Parem klikk ning vali Properties.
Properties paletil muuda Style = Rock. Las Properties palett jadb avatuks.

Vajuta ESC klahvi, et tithistada eelmine valik. Vali olemasoleva maapinna ristldige ning
1abi Properties muuda selle stiil kui Existing Ground.

Vajuta ESC klahvi, et tiihistada eelmine valik. Seejérel kliki tihel vorgu joonel ristldike
vaate 0+280.00 osas. Vali riba pealt Section View Properties.

Section View Properties dialoogi paanil Sections muuda Style veerus stiili EG >
Existing Ground ning Rock > Rock. Kliki OK. Kdik kolm ristldike vaadet peaksid
kuvama nii olemasolevat maapinda kui ka kivimikihti.

Jargnev ndide késitleb ristloike siltide lisamist.

1))

2)
3)

4)
5)

6)

7)

Ava joonis 11_Applying Section Labels.dwg. Tegemist on sama joonisega, mida
kasutasime ka eelnevas niites, kuid ristldike vaate stiili on veidi muudetud, et siltide
lisamiseks oleks rohkem ruumi.

Vali alumise ristldike vaate kivimikihi ristldige ning vali riba pealt Edit Section Labels.
Dialoogis Section Labels — Rock tee jargmist:

Type = Grade Breaks.

Section Grade Break Label Style = Rock.

Kliki Add.

Dim Anchor Opt = Graph View Bottom.

Dim Anchor Val = 0.

Kliki OK.

Eelnevalt valitud seadetega peaks kuvatama kolm silti. Samas vdiks neid olla rohkem.
Vajuta ESC klahvi, et tiihistada valikud. Vali iiks siltidest ning seejérel riba pealt Edit
Label Group.

Veerus Weeding sisesta 2. Kliki OK. Selle sittega lubame vahekaugusena 2 meetrit ja
sestap tekib silte juurde (varasemalt oli 25 meetrit).

Rakenda samasid silte ka teistel kahel ristldikel olevale kivimikihile.

mo o o

Jargnev néide késitleb code set style rakendamist.

1)
2)
3)

4)

Ava joonis 11_Applying Code Set Styles.dwg.

Vali koridori 10ige kdige alumiselt 10ike vaatelt. Seejérel riba pealt Section Properties.
Dialoogis Corridor Section Properties, paanil Information vali Object Style = Road
Sections. Kliki OK. Koridormudeli 16ige votab niiiid lihtsama esituse

Proovi eelkirjeldatud viisil niiiid stiili Road Sections — Top Highlighted.
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S)
6)
7)

8)
9)

Liilita sisse joonepaksuse kuva (Lineweight). Sa peaksid niiiid nigema, et koridormudeli
16ige on esile tostetud punase joonena.

Vali niiiid stiilina Presentation. Niilid on konnitee viirutatud teistmoodi kui dérekivi.
Vajuta ESC klahvi, et tithistada valik. Liigu niilid ristldike vaadete lehtede juurde. Vali
tiks ristldike vaadetest ning riba pealt View Group Properties. Kuvatakse dialoog View
Group Properties.

Vali paan Sections. Veerus Style muuda stiili Jordan Court = Presentation.

Kliki OK, et sulgeda dialoog. Pane tdhele, et koodi grupi stiili on rakendatud kogu
ristldike vaate grupile.

Jargnev ndide késitleb siltide lisamist koridormudeli 16ikele 14bi koodi grupi stiili (code set

style).

1)
2)

3)

4)
5)

6)
7)

8)
9

Ava joonis 11_Labeling with Code Set Styles.dwg.

Vali koige alumise ristloike vaate koridormudeli 15ige ning seejérel riba pealt Section
Properties.

Muuda Object Style = Design with Labels ning kliki OK. Niitid kuvab koridormudeli
ristldige ka kallete silte, korgusméarke ning kujundite koode (tunnuseid). Jargnevalt
redigeerid sa seda koodi grupi stiili, et lisatakse ka korgusmérk sdidutee korgemasse
punkti.

Ava Tool Palettes. Vali Basic paan.

Parem klikk BasicLaneTransition ning vali Help. Sulle kuvatakse selle alamkogumi
abiaken.

Liigu lehel allapoole ning jargi koodi legendi. Pane téhele, et puntk P/ on kodeeringuga
Crown. Seda koodi kasutad sina.

Sulge Help aken. Vali koridormudeli ristldige ning seejdrel riba pealt Section Properties
> Edit Code Set Style.

Dialoogis Code Set Style, paanil Codes, liigu Point sektsiooni ning leia Crown kood.
Kliki veeru Label Style lahtri parempoolsel ikoonil <none> ning vali Crown Elev. Kliki
OK.

10) Kliki OK, et sulgeda ka Code Set Style dialoog. Sdidutee korgemas punktis kuvatakse

niitid marker ning silt. Uhesdnaga leidis code set style niiiid koodi Crown ning kasutas
seda sildina.
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Jargnev néide késitleb ristldike vaate stiilide kasutamist.

1)
2)
3)
4)
S)

6)
7)

8)

9)

Ava joonis 11 _Applying Section View Styles.dwg. Sulle kuvatakse joonis kolme
ristloke vaatega esiplaanil.

Vali kdige alumisem ristldike vaade ning vali riba pealt Section View Properties.
Dialoogis Section View Properties, paanil Information vali stiilina Design 10V Major
and Minor — No Padding. Kliki OK. See stiil aitab sul paremini todtada lébi ristldike
vaate.

Vali niitid stiilina Design 1V Major and Minor — No Padding. Vertikaalset laienemist
sedapuhku ei ole.

Vali niiiid stiilina Design 1V — No Grid. See vaade ei sisalda ka vOrgustiku jooni.

Vali stiilina Design 5V Major Only. Niiiid kuvatakse vaid pdhivorgujooned.

Vajuta ESC klahvi, et valik tiihistada. Liigu niilid ristldike vaate lehtede juurde. Vali
iiks ristloike vaade ning riba pealt View Group Properties. Kuvatakse dialoog Section
View Group Properties.

Paanil Section Views, rea Section View Group — 1 osas, veerus Style = Road Section
Type 2. Kliki OK. Sulge ka dialoog Section View Group Properties. Kuna sellega
laiendatakse vertikaalset skaalat, siis votavad vaated paberilehel ka rohkem ruumi.
Endiselt on {iks ristldoike vaadetest valitud, vali riba pealt Update Group Layout.
Ristldiked paigutatakse timber. Lisatakse ka uus leht, et kdik ristldiked dra mahuksid.

Jargnev nédide kisitleb ristloike vaatele inforiba (band) lisamist.

1)
2)
3)

4)
5)

6)

7)

8)

Ava joonis 11_Applying Section View Bands.dwg.
Vali alumise ristldike vaate vorgujoon ning riba pealt Section View Properties.
Dialoogis Section View Properties, paanil Bands, tee jirgmist:
Band Type = Section Data.
Select Band Style sektsioonis veendu, et oleks valitud Design — EG Elev.
Kliki Add.
Muuda vérskelt lisatud inforiba parameetrit Gap = 0.
Liigu paremale poole ning vali veerus Sectionl = EG.
Kliki OK.
Inforiba on sellega lisatud. Endiselt on ristldike vaade valitud, vali uuesti riba pealt
Section View Properties.
Dialoogis Section View Properties, paanil Bands, vota dra linnukesed Label Start Offset
ning Label End Offset. Niilid ei kuvata inforibal algus- ega 15pusilti.
Lisa inforiba, mis kuvab kivimikihi sligavuse olemasoleva maapinna suhtes:
Type = Section Data.
Style = Rock Depth.
Gap = 0.
Label Start Offset = (valimata)
Label End Offset = (valimata)
Sectionl = EG
g. Section2 = Rock
Lisa inforiba, mis ndidatab nihke vaartuseid.
a. Type = Section Data.
b. Style = Design — Offsets.
c. Gap=0.
d. Label Start Offset = (valitud)
e. Label End Offset = (valitud)
Vali dialoogis Section View Properties, paan Bands. Kliki Save as Band Set.

N

e a0 o
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9) Sisesta Name = Sta-Elev-Rock-Depth ning kliki OK. Kliki OK, et sulgeda Section View
Properties dialoog.

10) Vajuta ESC klahvi, et tiihistada eelmine valik. Vali pdhjapoolseim ristldike vaade ning
seejérel riba pealt Section View Properties.

11) Dialoogis Section View Properties > Bands paan > kliki Import Band Set ning vali Sta-
Elev-Rock Depth. Kliki OK.

12) Vali kahe esimese inforiba tarvis Sectionl = EG. Teise inforiba osas vali Section2 =
Rock. Kliki OK. Inforibad langevad niilid kokku nendega, mida tegid sammudel 2-7.

13) Korda samme 10-12, et lisada inforiba ka jarele jadnud ristldike vaatele.

14) Vajuta ESC klahvi, et tiihistada valik. Liigu niiiid ristldike vaadete lehtede juurde. Vali
tiks ristldike vaade ning riba pealt View Group Properties.

15) Paanil Section Views kliki Change Band Set osas esimese rea peal.

16) Vali Import Band Set ning vali Section Sheets. Kliki OK, kuniks oled viljunud koikidest
dialoogidest. Inforibad on sellega lisatud ristldike vaadetele aga ristloike vaated tuleb
niitid timber jaotada, et paigutust korrigeerida.

17) Endiselt on iiks ristldike vaadetest valitud, vali riba pealt Update Group Layout. Civil
3D uuendab automaatselt ristldike vaadete lehti.

Selles ndites kasutad sa group plot style sitet, et muuta ristldike vaadete paigutust.

1) Avajoonis 11_Applying Group Plot Styles.dwg.
2) Vali iiks ristldike vaadetest (mistahes kolmelt lehelt) ning riba pealt View Group
Properties. Kuvatakse dialoog Section View Group Properties.
3) Paanil Section Views, kliki veeru Group Plot Style esimesel lahtril.
4) Vali Left to Right — Top Down ning kliki OK.
5) Kliki OK, et sulgeda dialoog. Pane tdhele niiiid paigutuse muutust, kuidas ristldike
vaated liiguvad vasakult paremale ning tilevalt alla.
6) Vali iiks ristloike vaadetest, kliki uuesti View Group Properties.
a. Vali kdige iilemine rida veerus Group Plot Style ning vali sealt Bottom Up — Left
to Right with Grid.
b. Vali lilemine lahter veerus Style ning seejirel vali Design 1V — No Grid.
c. Vali nupp veerus Change Band Set.
d. Vali dialoogis Section View Group Bands valik Section Data ning seejirel
kasuta punast risti, et see eemaldada. Kliki OK.
e. Kliki OK, et sulgeda Section View Group Properties dialoog.
7) Niiiid on ristldike vaated jaotatud lehe enda vorgustikule ja seega ristldike vaate stiil
endam vorgustikku ei kaasa. Samuti ei ole niilid enam ka inforibasid.
8) Vali iiks ristloike vaadetest, seejdrel riba pealt Update Group Layout. Niiid peaksid
vaated dra mahtuma kahele lehele.

Jargnev ndide kisitleb ristloike vaate siltide lisamist.

1) Ava joonis I1 Creating Section View Labels.dwg. Selles niites keskendume me
Jordan Court s6idutee sellele osale, kus toimub tee laienemine. Meie soov on niidata
adrekivi paigutust.

2) Riba paanilt Annotate > Add Labels.

3) Dialoogis Add Labels tee jargmist:

a. Feature = Section View.

b. Label Type = Offset Elevation.

c. Offset Elevation Label Style = Offset Over Elevation.
d. Marker Style = Basic.
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4)
S)

6)
7)
8)

9)

e. Kliki Add.
Vali iiks ristldike vaate vorgujoontest.
Hoia all SHIFT klahvi, parem klikk ning vali Endpoint. Kliki vasakpoolsel dérekivi
joonel.
Vajuta ESC, et tiihistada eelnev késk. Vali virskelt loodud silt, ning tiri seda selle
nelinurksest objektipunktist veidi vasakule, et see oleks paremini loetav.
Vali silt ning niitid riba pealt Edit Label Text. Kuvatakse dialoog Text Component
Editor.
Parempoolses aknas kliki just sdna Offset vasakus servas. Sisesta CURB FLOWLINE
ning vajuta ENTER.
Kliki OK, et dialoog sulgeda. Niiiid sisaldab silt ka madrangut.

Mairkus: Oluline on réhutada, et see silt ei ole seotud objektiga. Seega kui niiteks
adrekivi peaks oma asukohta muutma, ei pruugi antud silt enam digesse punkti osutada.
Kui seda soovitakse siduda objektiga, on vaja see liita code set style funktsionaalsusega.
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Piirjoonte disain ning analiiiis ldbi krundi objekti

Selles peatiikis tutvume nii-6elda kinnisvara objektide disainiga. Ehkki sdidutee
projekteerimine ning disain on véga erinev kinnisvara objektide disainist, on need omavahel
seotud kasvai selle kandi pealt, et krundi perimeeter méérab ka sdidutee serva. Kinnisvara
objekte voib vaadelda nii maa-ala objektina kui ka siis vdiksema tiikina, iihe krundina. Lisaks
sellele voivad olla osad maa-alad/krundid tildkasutatavad voi jillegi servituudid (tagamaks
kommunikatsioonide rajamise ndudeid). Kuna kinnisvara iildjuhul miitiakse tiiki kaupa, siis
mida rohkem neid on, seda kasulikum miiiigifirmale. Kuid mitte ainult tiikkide arv ei ole oluline
aga ka nende paigutus, suurus, ligipais.

Krundi objekti loomiseks kasutame me spetsiaalseid todvahendeid nagu ka eelnevates
peatiikkides. Krundi objekti loomisel luuakse esmalt krundi segmendid, mis on lihtsad
jooned/kaarjooned. Neid saab luua nii-6elda nullist voi siis kaasata olemasolevaid jooni. Juhul
kui need krundi segmendid loovad kinnise perimeetri, moodustubki automaatselt krundi objekt.

Kui krundi objektid lisada iihele ja samale maa-alale, siis moodustub tervik. Maa-ala objekt
(site) vOib enda alla koondada siis mitut krundi objekti (parcel) ja need kuvatakse Prospector
paanil. Lisaks krundi objektide omavahelisele koostodle (kui need paiknevad samal maa-alal)
kehtib sama ka niiteks sdidutee telgjoone osas. Sdidutee telgjoon (kuuludes samasse maa-
alasse, mis ka krundid) poolitab automaatselt seda krunti kui see peaks krunti 1abima.

Krundiobjekte saab redigeerida sarnaselt teistele objektidele (Idbi objektipunktide, Edit
Geometry kiskude ning Parcel Layout Tools toovahendite).
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Tooleht - Piirjoonte disain ning analiiiis ldbi krundi objekti

Jargnev néide kisitleb krundiobjektide loomist olemasolevatest AutoCAD objektidest.

1) Avajoonis 12_Creating Parcels from Objects.dwg.

2) Riba pealt Home > Parcel > Create Parcel from Objects.

3) Vali roheline poliijoon, mis esitab iildist krundi perimeetrit.

4) Vali lilla poliijjoon, mis esitab 1dunapoolset ligipddsu krundile (Emerson Road kaudu).
Vajuta ENTER.

5) Dilaoogis Create Parcels from Objects kliki OK, et ndustuda vaikimisi seadetega. Ala
on viirutatud ning krundi silt esitakse krundi keskosas.

6) Prospector > Sites > Lot Layout. Parem klikk Parcels peal ning vali Refresh. Parcels
ees peaks kuvatama niitid “+* ikoon ning ltem sektsioonis peaksid ndgema ka krundi
objekti nimetusega Basic. 1.

7) Juhul kui sa objektide kuva ei née, vajuta Prospector paleti lilaservas nuppu “item
preview'.

8) Parem klikk Parcels peal ning veendu, et seal oleks linnuke kastis “Show Preview*. Kui
ei ole, kliki Show Preview.

9) Laienda Parcels sektsiooni ning vali Basic. 1. Selle krundi eelvaade kuvatakse vastavas
alas.

10) Vali iiks punastest joonise poliijjoontest. Parem klikk, vali Select Similar.

11) Riba pealt Home > Parcel > Create Parcel from Objects.

12) Dialoogis Create Parcels — From Objects muuda Parcel Style = Property, kliki OK.
Sellega luuakse kaks uut krunti..

13) Prospector paani tee parem klikk Parcels peal ning Refresh. Vaata krunte eelvaate
kuvas.

14) Vali iiks sissesdidutee joonest, parem klikk ning Select Similar.

15) Riba pealt Home > Parcel > Create Parcel from Objects. Kliki OK, et sulgeda dialoog
(jddvad vaikimisi seaded).

16) Viérskenda Prospector paanil kruntide vaadet. Niiiid peaks kokku olema 7 krunti.

Jargnev nédide késitleb kruntide loomist 1ébi Lot Line Tools todvahendite.

1) Avajoonis 12 _Using the Lot Line Tools.dwg.

2) Riba pealt Home > Parcel > Parcel Creation Tools.

3) Nupupaanil Parcel Layout Tools vali Add Fixed Line — Two Points.

4) Kliki OK, et ndustuda vaikimisi valikutega Create Parcels — Layout dialoogis.

5) Suurenda vaadet Jordan Court positsioonile 0+100. Hoia all SHIFT klahvi, parem klikk
ning vali Endpoint.

6) Vali lilla joon positsioonil 0+128.13.

7) Hoia all SHIFT klahvi, parem klikk, vali Perpendicular.

8) Vali tagumine lilla joon. Vajuta ESC klahvi kahel korral, et 10petada késk. Sa oled
loonud uue krundi, mida kasutatakse tildotstarbel.

9) Riba pealt Home > Parcel > Parcel Creation Tools.

10) Vali Draw Tangent > Tangent with No Curves ning seejarel OK, et sulgeda dialoog
Create Parcels — Layout.

11) Kasutades Endpoint objektist kinnihaaramise meetodit, jérgi aia joont, mis iimbritseb
olemasolevat farmi. Alusta aia pdhjapoolsest punktist ning liigu 1duna-ladne suunal.
12) Kui oled valinud viimase aia punkti, vali Perpendicular objektist kinnihaaramine ning

vali 1d4nepoolne piirjoon.
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13) Vajuta ESC klahvi, et Parcel késk lopetada. Sa oled loonud uue krundi, mis jadb algse
maa-ala omanikule.

Jargnev ndide késitleb Parcel Sizing Tools toovahendeid krundi loomisel.

1) Avajoonis 12_Using the Parcel Sizing Tools.dwg.

2) Riba pealt Home > Parcel > Parcel Creation Tools.

3) Nupupaanil Parcel Layout Tools, laienda nuppu, mis sisaldab krundi dimensioneerimise
toovahendeid, vali Slide Line — Create.

4) Kliki OK, et sulgeda dialoog Create Parcels — Layout.

5) Kui sinult palutakse valida krundi objekt, vali silt, mis kuvab infot Property: 25, mille
leiad edela osast.

6) Kui sinult palutakse valida esimene punkt esiserval (frontage), vali lidne poolne
otspunkt, mille tegi eelmisel sammul positsioonil 0+728.13.

7) Liigu hiirega niitid kagu suunal, piki eesliini. Pane tdhele oranzi esiletdstmist, mis sinu
kursorit jargib. Vali kaarjoone otspunkt positsoonil 0+360.67.

8) Kui sinult palutakse nurka, sisesta kdsureale 90 ning vajuta ENTER. Krundi eelvaade
kuvatakse sinu poolt valitud alguspunkti 1dheduses.

9) Vajuta ENTER, et ndustuda heke dimensioonidega ning loomaks krundi objekt.

10) Vajuta ESC klahvi, et viljuda hetke késust, kuid jita Parcel Layout Tools nupupaan
avatuks.

11) Vali toovahend Swing Line — Create ning seejérel silt nimetusega Property: 2 (kagu
piirkonnas).

12) Kui sul palutakse valida esiliini alguspunkt, vali Property: 2 pohjapoolseim punkt.

13)Kui sul palutakse valida esiliini 10pppunkt, liign modda krundi joont ning wvali
ladnepoolseim, sama krundi otspunkt.

14) Kui sul palutakse valida poordpunkt (swing point), kasuta Endpoint kinnihaaramisvotet
ning vali Property: 2 ldunapoolne nurgapunkt. Kuvatakse krundi eelvaade, kus
kasutatakse hetke minimaalse krundi suuruse sdtet 1500 m?.

15) Vajadusel laienda Parcel Layout Tools nupupaani (must kolmnurk).

16) Sisesta Minimum Area = 0.4 hectare. Vajuta ENTER. Eelvaadet uuendatakse.

17) Vajuta ENTER, et luua krundi objekt.

18) Vajuta ESC klahvi, et 1opetada hetkel aktiivne késk. Parcel Layout Tools vali Free
Form Create.

19) Liigu kursoriga piki krundi idapoolset joont (Property: 25). Pane tihele, et joone
eelvaade haarab ise kinni krundi segmendist ning pikendab seda véljapoole kuniks
16ikub teise krundi segmendiga.

20) Olles kursoriga ldine poolsel joonel, vali krundi segmendi keskpunkt.

21) Kui sul palutakse ndidata suund, vajuta ENTER, et ndustuda risti olevaga. Luuakse uus
krundi joon ning ka uus krundi objekt.

22) Vajuta ESC klahvi, et 16petada késk ning sulgeda Parcel Layout Tools.

Jargnev néide késitleb krundi dimensioneerimise todvahendeid, et luua korraga mitu krunti.

1) Avajoonis 12 Using Parcel Sizing Parameters.dwg.

2) Riba pealt Home > Parcel > Parcel Creation Tools.

3) Nupupaanil Parcel Layout Tools, vali Automatic Mode = On.

4) Vali Slilde Line — Create ning seejéarel vilja dialoogist Create Parcels — Layout
vajutades OK.

5) Kui sul palutakse valida krunt, vali silt Property: 30.

6) Kui sul palutakse valida eesliini algupunkt, vali Jordan Court sissesdidutee otspunkt.
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7)

8)
9)

Kui sul palutakse valida eesliini 1dpppunkt liigu hiirega esmalt piki Jordan Court tee
serva, seejdrel poora Madison Lane pdhjapoolsele joonele, teosta tagasipdore ning vali
Madison Lane ning Logan Court ristumispunkt.

Kui sul palutakse valida nurk, vajuta ENTER. Kuvatakse kruntide eelvaade.
Nupupaanil Parcel Layout Tools, sisesta Minimum Area = 0.135 hectaresi ning vajuta
ENTER. Eelvaadet uuendatakse.

10) Muuda ka jargmiseid seadeid (pane téhele, kuidas neid reaalajas uuendatakse):

Minimum Frontage = 35

Frontage Offset = 8

Remainder Distribution = Redistribute Remainder

Multiple Solution Preference = Use Smallest Area.

Vajuta ENTER, et luua krundid. Vajuta ESC klahvi, et I6petada kask.

°poos

Jargnev ndide késitleb krundiobjektide redigeerimist 1dbi objektipunktide.

1)
2)

3)
4)
5)
6)

7)

8)

Ava joonis 12_Editing Parcels Using Grips.dwg.

Suurenda vaadet krundile Property: 28. Kliki selle krundi pdhjapoolsel kiiljel, pane
tdhele kuvatavaid objektipunkte (molemal pool joont).

Vali idapoolne, nelinurkne objektipunkt. Liiguta kursorit mddda joonist, ning pane
tahele selle objektipunkti kditumist. Saad seda nihutada mistahes suunas.

Hoia all SHIFT klahvi, parem klikk ning vali Nearest.

Vali punkt piki krundi joont (idapoolne). Pane tihele, et krundi pindala muutub.

Vali 1dunapoolne krundi perimeeterjoon. Pane tihele, et kuvatakse teemandikujuline
objektipunkt.

Vali teemandikujuline objektipunkt ning tiri seda piki krundijoont, mille kiiljes see on.
Liigutades seda niiteks pohja suunal, kaarjoonte sektsioonis, pane téhele, et see jadb
endiselt risti selle krundi servaga, millega on see iihendatud.

Vali uus asukoht, pane tdhele muudatust krundi sildil.

Jargnev ndide késitleb krundi objektide graafilist redigeerimist.

1)
2)
3)
4)
S)
6)

7)
8)

9)

Ava joonis 12_Editing Parcels Using Edit Commands.dwg.

Suurenda farmi ehitiste alale ning pane tdhele iihte kolmnurkse kujuga krunti
nimetusega Property: 26. Need krunt loodi kui lisati uusi krundi segmente piki tara (aia
joont).

Vali silt Property: 26. Juhul kui Edit Geometry tahvel ei ole avatud, vali riba pealt Edit
Geometry.

Vali Edit Geometry > Trim. Kui sinult kiisitakse 16ikavat serva, vali krundi segment,
mis on joonestatud piki aeda. Vajuta ENTER.

Kui sul palutakse valida 1digatavaid objekte, vali kolmnurkse krundi lddanepoolne serv.
Property: 26 krunt kaob ning krunti Property: 27 uuendatakse.

Vajuta ESC klahvi, et lopetada hetkel aktiivne késk. Liigu joonisel 1duna poole ning
kliki Property: 7 sildil. Vali riba pealt Edit Curve.

Vali kaarjoon, mis jdib just Property: 7 sildist pdhja poole.

Dialoogis Edit Feature Line Curve, sisesta 85 raadiuseks nign kliki OK. Krunti
uuendatakse.

Vajuta ESC klahvi kaks korda, et vdljuda hetke kdsust. Suurenda Property: 2 ldéne
serva. Pane tdhele, et seal on véga kitsas riba Property: 2 osas, mis ei ole vdga
otstarbekas.

10) Vali Property: 2 podhja poolne perimeeter ning kliki riba pealt Delete PI. Vali

kolmnurkne marker krundi joone ldédne servas, et kustutada sellest kohast PI.
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11) Vajuta ESC klahvi, et viljuda eelmisest kisust ning seejdrel vali uuesti sama krundi

joon, et ndha selle objektipunkte. Vali kdige lddnepoolsem objekti punkt ning tiri see
punase ringjoone keskele. Krundi geomeetriat on parendatud.

Jargnev nédide késitleb krundi objektide redigeerimist 14bi Parcel Layout Tools todvahendite.

1)
2)
3)
4)

S)
6)

7)
8)

9

Ava joonis 12_Editing Parcels Using the Layout Tools.dwg.

Vali krundi Property: 28 silt ning seejdrel riba pealt Parcel Layout Tools.

Nupupaanil Parcel Layout Tools, sisesta minimaalse alana (minimum area): 0.20
hectares.

Laienda krundi dimensioneerimise tdovahendeid, vali Slide Line — Edit. Kliki OK, et
sulgeda dialoog Create Parcels — Layout.

Kui sul palutakse valida ala joon, vali Property: 28 1dunapoolne joon.

Kui sul palutakse valida krunt, mida soovid redigeerida, siis kliki kuskil Property: 28
sees.

Kui sul palutakse valida eesliini alguspunkt, vali loode nurk krundi Property: 28 osas.
Liigu kursoriga 1duna poole (piki ligipadsuteed) ning kliki ligikaudu 0+210
positsiooni ldheduses.

Kui sul palutakse valida nurk, vajuta ENTER. Suurendatud krundi eelvaade on niiiid
kuvatud.

10) Vajuta ENTER, et Idpetada késk.
11) Vajuta ESC klahvi, et 1dpetada késk ning tiihistada objektide valik. Vali krundi

Property: 27 silt ning seejérel vali riba pealt Parcel Layout Tools.

12) Nupupaanil Parcel Layout Tools, vali Parcel Union.
13) Kui sul palutakse valida sihtkrunt (destination parcel) vali Property: 3 silt. Krundi

Property: 27 silt kaob ning Property: 3 sildi pindala uuendatakse.

14) Laeinda ikooni Parcel Union ning vali Dissolve Parcel Union
15) Vali Property: 3 silt. Luuakse 2 uut krunti, mis asendavad krunte 3 ning 27.
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Kruntide kuvamine ning annoteerimine

Krundiobjektide loomisest on vihe kasu, kui need ei kanna endas tdiendavat infot, mis on
projekti edukaks presenteerimseks olulise tdhtusega. Krundiobjektide valimust saab muuta taas
1abi stiili sétete, neile saab lisada silte ning kuvada laiapdhjalisemat infot ka tabelites.

Juhul kui kdrvuti paiknevad erinevat tiiiipi krundid, siis on voimalik mairata, millist serva joone
stiili kuvatakse dialoogis Parcel Style Display Order, millele pddseb ligi Prospector paletilt.

Kruntide siltidena on kdige levinum selle pindala silt, kuid need ei pea ilmtingimata sisaldama
infot pindala kohta. Silte saab lisada juba tuttava késu Add Labels abil voi rakendada 1dbi Parcel
Properties kisu. Krundi sildi esitusviisi saab muuta 14bi selle stiili.

Krundi segmentide puhul kasutatakse samuti sildistamist, mis iildjuhul kuvab suuna, pikkuse.
Seelédbi on voimalik seda krunti taasluua, kas paberil voi objekti tegelikus asukohas. Segmendi
esitust saab muuta stiili imber valimisega.

Kruntide joonised vdivad iihel hetkel (koos siltidega) muutuda lisna raskesti loetavaks. Sellistel
puhkudel saab jooned/kaarjooned annoteerida lihtsama nimetusega, nditeks L.1 voi C1 ning luua
vastav tabel, mis votab kokku pohiinfo nende joonte kohta. See teeb kiill joonise lugemise
monevorra aeglasemaks, kuid monel puhul on ainuke viis, et joonise lildine (graafiline) loetavus
sailiks.
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Tooleht - Kruntide kuvamine ning annoteerimine

Jargnev nédide késitleb krundi stiilide rakendamist, et muuta nende esitusviisi.

1)
2)

3)

4)
5)

6)

7)

8)
9)

Ava joonis 13 _Applying Parcel Styles.dwg. Selles joonises on kruntide plaan, millele
on rakendatud stiil nimetusega Standard.

Vali silt nimetusega Standard: 3 (farmi hoonete keskel). Vali riba pealt Parcel
Properties.

Dialoogis Parcel Properties, paan Information muuta Object Style = Adjoiner. Kliki
OK. Muutub krundi perimeeter joone esitus. Lisaks muutuvad ka siltide esitusviis, mis
niitid on kujul Adjoiner: 3.

Vajuta ESC, et tiihistada eelnev valik. Vali silt Standard: 6 (Madison Lane
tagasipoordel). Parem klikk ning vali Properties.

Properties paleti vahendusel muuda stiil kui ROW. Muutub nii joone stiil kui ka
viirutus.

Kasutades Parcel Properties voi Properties paletti muuda kruntide Standard: 7 ning
Standard: 4 stiil kui Open Space. Nende kruntide perimeeter on niilid rohelist véirvi
ning viirutatud roheliselt.

Suurenda Jordan Court 90-kraadise poorde juurde ning pane tdhele iihte kitsast krunti
nimetusega Standard: 1. See on sademeveetoru servituut.

Muuda selle stiil kui Easement. Viirutus muutub.

Vali iiks kruntidest, mis on endiselt nimetusega Standard ning muuda selle stiil kui
Lot. Muutub nii perimeeter kui viirutus.

10) Vali Prospector > Sites > Lot Layout. Vali Parcels, et kuvada kdik krundid paleti

allosas.

11) Keri veidi paremale kuniks nded veergu Style. Kliki Style piisel, et sorteerida selle

jérgi.

12) Vali esimene krunt nimetusega Standard. Seejérel hoides all SHIFT klahvi vali

viimane Standard nimega krunt. Niiiid valitakse kdik samanimelised krundid.

13) Parem klikk Style veeru nimel ning vali Edit.
14) Dialoogis Select Style vali Lot ning kliki OK. Kruntide uuendamine vdtab niitid veidi

aega. Seejdrel kajastub valitutel stiili muudatus.

Jargnev nédide késitleb krundi stiili kuvajérjekorda.

1)
2)
3)
4)

5)
6)

7)
8)

9)

Ava joonis 13_Applying Parcel Style Display Order.dwg. Joonis avaneb krundi Lot:
23 vaatest, mille perimeeter on sinist varvi.

Prospector > Sites > Lot Layout.

Parem klikk Parcels peal ning vali Properties.

Dialoogis Site Parcel Properties, paanil Composition vali sektsioonis Parcel Style
Display Order > ROW.

Vali iilesspoole suunatud nool kuniks ROW on kdige esimene.

Kliki OK. Lot: 23 on niiiid iimbritsetud musta joonega Idunast/idast ning sinise
joonega pohjast ning ldénest.

Prospector paletil vali Parcels, parem klikk ning vali Properties.

Jarjesta stiilid Parcel Style Display Order kui: ROW, Adjoiner, Open Space, Lot,
Property, Basic. Kliki OK.

Suurenda joonist ning jélgi tehtud muudatuste moju.
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Jargnev néide késitleb krundi siltide lisamist/seadistamist.

1) Avajoonis 13_Applying Parcel Area Labels.dwg.

2) Vali Adjoiner: 3 silt ning seejérel riba pealt Parcel Properties.

3) Dialoogis Parcel Properties vali Composition paan.Vali Area Selection Label Style =
Existing Description and Area.

4) Vali paan Information, sisesta Description kasti: JOHN SMITH (esimesele reale),
ning teisele reale DBV 1234, PG 567. Kliki OK ning vajuta ESC, et tiihistada valik.
Tegemist on eritiiiipi sildiga, mis kuvab omaniku nime ning néiteks katastri tunnust.

5) Vali krundi silt ROW: 6 (Madison Lane tagasipdordel) ning seejérel riba pealt Parcel
Properties.

6) Dialoogis Parcel Properties > Composition paan, muuda Area Selection Label Style =
<none>. Kliki OK. See eemaldab sildi antud krundi juures.

7) Vali kaks krunti, mis on nii-6elda rohelist vérvi (viirutus). Parem klikk ning vali
Properties.

8) Kasutades Properties akent, vali Parcel Area Label Style = Proposed Description and
Area. Niiiid kuvavad need sildid krundi infot ning pindala (teistmoodi teksti stiili ning
virvitooniga).

9) Vajuta ESC, et tiihistada objektide valik. Riba pealt, tahvel Annotate > Add Labels.

10) Dialoogis Add Labels:

a. Feature = Parcel.

b. Label Type = Replace Area.

c. Area Label Style = Lot Number.
d. Kliki 4dd.

11) Vali nii mdnedki krundid, mis on kirjega Lot ning vajuta ENTER. Neid silte
uuendatakse ning esitusstiil on lihtsalt number ringjoones.

12) Prospector > Sites > Lot Layout. Vali Parcels, et kuvada kdik krundid alumises
sektsioonis.

13) Vali veeru piis Area Label Style, et jarjestada stiili alusel.

14) Vali esimene nimekirjas, mis on stiiliga Standard, kasutades SHIFT klahvi vali
viimane Standard nimetusega.

15) Parem klikk Area Label Style pidisel, ning vali Edit.

16) Dialoogis Select Label Style, vali Lot Number ning kliki OK. Mdne hetke parast
uuendatakse valitud kruntide sildid.
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Jargnev néide késitleb krundi segmentidele siltide lisamist.

1)
2)
3)

Ava joonis I3_Creating Parcel Segment Labels.dwg.

Suurenda vaadet kruntidele 32 ning 33 (projekti keskosas).

Riba pealt Annotate > Add Labels.

Dialoogis Add Labels, vali Feature = Parcel ning kliki Add.

Kliki krundi 33 pdhjaserv. Lisatakse silt koos suuna ja distantsi infoga.

Kliki krundi 33 ida ning ld4ne serv. Lisatakse veel kaks silti.

Nihuta joonist 1duna poole, krundi 69 juurde ning vali kaarjoon, mis on 69
ldunaservas. Lisatakse kaarjoone silt, mis kuvab nurga, pikkuse ning raadiuse.
Dialoogis Add Labels vali Label Type = Multiple Segment ning kliki Add.
Vali krundi 32 pindala silt. Kui palutakse valida suund, vajuta ENTER ning ndustu
paripdeva suunaga. Kdik krundi 32 servad sildistatakse.

Jargnev ndide kisitleb segmendi sildi stiili muutmist.

7)

8)
9)

Ava joonis 13 _Applying Parcel Segment Label Styles.dwg.
Suurenda joonist projekti lddneservale. Hetkel kuvatakse sama infot topelt.
Vali John Smith krundi ld4neserva silt, seejdrel riba pealt Label Properties.
Properties paletil muuda Line Label Style = (Span) Bearing and Distance with Crows
Feet [Existing]. Sildi varvitoon ning teksti stiil muutuvad, ning silt ise kuvab niiiid
terve joone pikkust.
Riba paanil Annotate > Add Labels.
Dialoogis Add Labels:

a. Feature = Parcel.

b. Label Type = Single Segment.

c. Line Label Style = Distance [Existing].

d. Kliki 4dd.
Vali John Smith krundi lddneserv. Lisatakse uus silt, mis kuvab vaid John Smith
krundi serva pikkust.
Sulge Add Labels dialoog. Liigu 16una serva, et ndha krunte 36, 37, 60, 59.
Vali need neli silti, seejirel riba pealt Label Properties.

10) Properties paletil muuda Line Label Style = Distance. Siltide kuva niitab niitid vaid

sisemise segmendi pikkust. Suuna info voib eemaldada, kuna vastaserval on see info
juba olemas.

Jargnev ndide késitleb krundi siltide graafilist redigeerimise voimalust.

1)
2)

3)
4)

5)
6)
7)

8)

Ava joonis I13_Editing Labels Graphically.dwg. Joonis avaneb krundi 68 juurest.
Pane tdhele kruntide 68 ning 62 suuna ning pikkuse silte lddnepoolsetel servadel. Vali
krundi 68 ldadnepoolne silt. Vali riba pealt Label Properties.

Properties paletil muuda Line Label Style = Bearing. Sulge Properties palett.

Silt on endiselt valitud, vali riba pealt Flip Label. Silt kuvatakse niilid joone ldéne
poolsel serval.

Silt on endiselt valitud ning nihuta seda teemandkujulisest objektipunktist kruntide 68
ja 62 eraldusjoone ligidusse. See suunainfo on niitid molema krundi tarvis.

Pane téhele, et kuvatakse NE suund, samas kui ida pool on SW suunaga. Kui silt on
endiselt valitud, vali riba pealt Reverse Label. Niilid ndidatakse suunda SW baasil.
Vajuta ESC, et tiihistada eelnev valik. Korda samme 2-4, et muuta krundi 62
ladnepoolse serva sildi stiili kui Distance.

Kasuta kdsku Add Labels, et lisada krundi 68 lddnepoolsesse serva uus pikkuse silt.
Ara unusta peegeldamast seda, et see kuvatakse krundi siseperimeetril.
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9)

Vali krundi 68 loode poolne kaarjoone silt. Vali nelinurk objektipunkt ning tiri seda
1dunasse ning itta. Paiguta see vabasse alasse. Kuvatakse ka viitjoon.

10) Jétka siltide timberpaigutamist, et parandada joonise loetavust. Vajadusel rakenda uusi

stiile.

Jargnev ndide késitleb pindalade tabeli loomist.

1)
2)
3)

4)

5)
6)
7)

8)

9)

Ava joonis I13_Creating an Area Table.dwg.

Vali tiks krundi numbrilistest siltidest ning seejirel riba pealt Renumber/Rename.
Dialoogis Renumber/Rename Parcels vali kastike Use Name Template in Parcel Style.
Kliki OK.

Kui sul palutakse valida alguspunkt, kliki krundi 24 keskpunkti 1dheduses. Seejérel
vali juba iilejadnud krundid soovitud jarjekorras (nt esmalt modda vilisperimeetrit,
vastupéeva).

Vajuta ENTER (kaks korda), et Idpetada timber nummerdamine. Niilid peaks numbrid
algama 1 ning kuni 40.

Vajuta ESC klahvi, et tiihistada eelnev valik. Suurenda projekti keskel olevatele
kruntidele. Vali iiks krundi siltidest ning seejdrel riba pealt Renumber/Rename.
Dialoogis Renumber/Rename Parcels veendu, et oleks valitud kastike Use Name
Template in Parcel Style. Kliki OK.

Joonesta jooned lébi kruntide samamoodi nagu ka eelnevalt, alustades krundiga 68,
seejarel paripdeva ning l1opetades krundiga 62. Vajuta ENTER (kaks korda), et
1opetada kask. Krundid peaksid olema niiiid nummerdardu 41 kuni 53.

Vajuta ESC klahvi, et tiihistada eelnevad valikud. Vali iiks krundi siltidest, seejérel
riba pealt Add Tables > Add Area.

10) Dialoogis Table Creation:

a. Table Style = Area Only.
b. Sektsioonis Select by Label or Style, vali veerus Apply kastike Lot Number .
c. Kliki OK.

11) Vali punkt joonise tiihjas osas, et lisada tabel(id).

Jargnev ndide késitleb krundi segmentide tabeli loomist aga ka tdhiste imbernimetamist.

1)

2)
3)

Ava joonis I3_Creating a Segment Table.dwg. Joonis avaneb projekti keskosast. See
on liks néide, kus tekstilist infot on omajagu ning see ei mahu dra vastavatele joontele.
Joonise selguse huvides on mdistlik lisainfo koondada tabelisse.
Riba paanil Annotate > Add Tables > Parcel > Add Curve.
Dialoogis Table Creation:

a. Table Style = Length Radius & Delta.

b. Label Style Name sektsioonis, lisa linnuke veergu Apply rea Parcel Curve:

Delta over Length and Radius osas.

c. Kiiki OK.
Vali joonise tiihjas ala moni punkt, et lisada tabel.
Vali krundi 41 kaarjoone silt (loode servas), seejdrel kliki ringjoone kujulisel
objektipunktil, et paigutada see uuesti kaarjoone peale.
Silt on endiselt valitud, vali riba pealt Renumber Tags. Silt kuvab niitid infot C1.
Jatka t60d vastupdeva, kuniks koik tdhised on timber nimetatud.
Riba paanil Annotate > Add Labels.
Dialoogis Add Labels, vali Feature = Parcel, Label Type = Multiple Segment. Kliki
Add.
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10) Vali krundi 17 silt, vajuta ENTER, et ndustuda vaikimisi suunaga (paripdeva). Tee
seda sama krundi 18 osas. Joonisele lisatakse uued joone ning kaarjoone sildid.

11) Nimeta kaarjoonte tdhised timber nii, et need jatkaksid eelmist jada.

12) Kliki tabelil, seejdrel riba peal Add Items. Dialoogis Add Selection, vali kastike Parcel
Curve: Delta over Length and Radius. Kliki OK.

13) Liigu iile tabeli, ning pane téhele, et see kajastab ka uut infot.
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Isevoolsete torusiisteemide disain

Peale kruntide disaini saame liikuda jérgmisesse etappi, torustike disaini juurde. Esmalt
vaatame isevoolsete torusiisteemide disaini, mis ennekdike kaasab sademevee &rajuhtimist
maa-alalt. Isevoolsete torusiisteemide projekteerimisel peab arvestama mitme niiansiga, mida
survetorustike juures ei ole nii oluline jélgida. Niiteks peame tagama piisava kalde olemasolu,
toru 1abimddt peab suutma vastu votta disainkoormuse, kuna torud ei ole pidevalt tdidetud, siis
neid voib ka maapinnale ldhemale ehitada, kuid siiski ei tohi nditeks liikluskoormus nende
struktuurilisi omadusi muuta. Torustikele peab olema tagatud ka ligipdds (nt vaatluskaevude
ndol). Autodesk Civil 3D tarkvaras koosneb torusiisteem toru (pipe) ning kaevu (structure)
komponendist. Kaevul on mdistagi laiem tdhendus, kaasates enda alla nditeks nii vdljavoolu
kaevu, vaatluskaevu, restkaevu jne. Igat komponenti (toru, kaev) kuvatakse Prospector paletil:
Pipe Networks > Networks. Uhes projektis vdib eksisteerida mitmeid erinevaid vorkusid. Vorgu
all motleme iihte loogilist siisteemi (nt iihe piirkonna kuivendussiisteem). Torusilisteemide
loomisel saame paika panna, milliseid toru 1&bimoddtusid saab kasutada ning milliseid kaevu
komponente. Torustike saab projekti lisada, kas olemasoleva graafika teisendamisel voi
joonestades nii-0elda nullist.

Torustiku on vdimalik maha maérkida nii plaanis, isomeetrias kui ka profiili vaates. Profiili
vaates joonestamiseks kasutad sa toovahendit Draw Parts in Profile. Mdistagi ei soltu torude
lisamine vaatest, vaid see sama toru lisatakse mistahes vaatele.

Torusiisteeme saab redigeerida neljas erinevas esituses: ldbi objektipunktide, 14bi
redigeerimistodvahendite, 14bi omaduste ning ka kasutades Pipe Network Vistas tdovahendit.

Kui torussiisteeme redigeerida libi omaduste, siis saab seda teha kahel erineval moel. Uks
variant on nn Civil 3D tiiiipi, kus sa valid to6vahendi riba pealt Pipe Properties voi Structure
Properties. Sealt leiab enamiku siisteemi kohta kdivat infot, kuid selle dialoogi peab kuvama
iga toru/kaevu jaoks eraldi. Teine meetod on nn AutoCAD meetod, kus kasutad Properties
paletti. Parameetrite arv, mida saad muuta, on kiill vaiksem, kuid saad selle muudatuse 14bi viia
korraga mitme toru/kaevu osas.
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Tooleht - Isevoolsete torusiisteemide disain

Jargnev nédide késitleb torusiisteemi loomist olemasoleva graafika teisendamisel.

1)
2)

7)

8)

9)

Ava joonis 14_Creating Pipe Networks from Objects.dwg.

Vasakus vaateaknas suurenda vaadet Jordan Court algusesse. Pane tihele, et seal on
paksem, roheline polijjoon nimetusega SAN. Tegemist on uue, projekteeritud
kanalisatsioonitoruga.

Riba pealt Home > Pipe Network > Create Pipe Network from Object.

Vali roheline poliijjoon. Sulle peaks kuvatama mustad nooled, viitega Iduna poole. Need
nooled niitavad eeldatavat voolusuunda.

Vajuta ENTER, et ndustuda voolu suunaga.

Dialoogis Create Pipe Network from Object:

Network Name = Sanitary.

Network Parts list = Sanitary Sewer.

Surface Name = Road FG.

Alignment Name = Jordan Court.

Vali kastike Erase Existing Entity.

Kliki OK.

e s o

Sellega oleme loonud uue torustiku olemasoleva poliijjoone asemel.

Alumises, parempoolses vaates suurenda joonist iihele kaevule. Plaanilises vaates
ndevad need kaevud vilja iisna lihtsad, aga 3D vaates on tegemist tdies mahus 3D
kujutisega. Nii torud kui kaevud on seega 3D objektid.

Vasakus vaateaknas liigu Madison Lane sdidutee juurde. Pane tdhele iihte rohelist
poliijjoont, mis algab Madison Lane positsioonilt 0+080 ning 16peb Jordan Court
positsioonil 0+660.

Riba pealt Home > Pipe Network > Create Pipe Network from Object.

10) Vali roheline poliijjoon (Madison Lane). Sulle kuvatakse taas mustad nooled, mis

viitavad 16una poole. Jillegi esitavad need voolamise suunda.

11) Vajuta ENTER, et ndustuda suunaga.
12) Dialoogis Create Pipe Network from Object:

Network Name = Sanitary-2.

Networ Parts List = Sanitary Sewer.

Surface Name = Road FG.

Alignment Name = Madison Lane.

Vali kastike Erase Existing Entity.

Kliki OK.

13) Korda samme 9-12, et teisendada ka teine poliijoon, mis algab Madison Lane
tagasipoordel. Vorgu nimetusena kasuta niiid Sanitary-3. Niitid on kodik varem
lisatud poliijjooned teisendatud.

14) Vaata joonist alumisest paremast vaateaknast ning pane téhele, et liks torudest
Madison Lane ténaval paikneb mirksa madalamal korgusmaérgil kui iilejadnud.
Sellega me tegeleme hiljem.

e a0 o
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Jargne néide kasitleb torusiisteemide loomist nii-6elda nullist 1abi Pipe Network Creation Tools
toovahendite.

1) Ava joonis 14_Creating Pipe Networks by Layout.dwg. Selles joonises on varasemalt
lisatud punased ringjooned, mis esitavad restkaevude paigutust. Need on lisatud
maapinnamudeli madalamatesse punktidesse, et koguda sinna valguvat sademevett.

2) Riba pealt Home > Pipe Network > Pipe Network Creation Tools.

3) Dialoogis Create Pipe Network:

a. Network Name = Storml.

b. Network Parts List = Storm Sewer.
c. Surface Name = Road FG.

d. Alignment Name = Jordan Court.
e. Kliki OK.

4) Sul palutakse valida kaevu sisestuspunkt. Vasakus vaateaknas suurenda vaadet Jordan
Court 0+170 juurde. Nupupaanil Network Layout Tools:

a. Vali esimesest hiipikust: Rectangular Junction Structure NF SI > Curb Inlet.
b. Toru valimiseks vali Concrete Pipe SI > 400mm Concrete Pipe.
5) Parem klikk tarkvara alumisel ribal, Osnap > Object Snap Settings.
6) Dialoogis Drafting Settings > Object Snap paanil:
a. Aktiveeri Object Snap On (F3)
b. Vali Clear All.
c. Vali kastike Center.
d. Kliki OK.

7) Vali punase ringjoone keskpunkt positsioonist 0+1770 idas.

8) Vali punase ringjoone keskpunkt positsioonist 0+170 laénes.

9) Liigu pohja poole, kuniks nded kahte punast ringjoont positsooni 0+073.28 ldheduses.
Vali ringjoon sdiduteest 1duna pool.

10) Nupupaanil Networ Layout Tools, vali Concrete Pipe SI > 450mm Concrete Pipe.

11) Vali punase ringjoone keskpunkt positsioonist 0+073.28 pohjas.

12) Nupupaanil Network Layout Tools:

a. Vali Cylindrical Junction Structure NF SI > Storm Manhole.
b. Vali Conrete Pipe SI > 600mm Concrete Pipe.

13) Vali punase ringjoone keskpunkt, mis asub iildkasutatavast alast 14énes.

14) Nupupaanil Network Layout Tools > Concrete Rectangular Winged Headwall SI >
Winged Headwall for 600mm Pipe.

15) Vali punase ringjoone keskpunkt Emerson Road vastaskiiljel.

16) Vajuta ESC klahvi, et Iopetada késk. Sa oled loonud sademeveetorustiku, mis juhib
sademeveed Emerson Road punkti.

Jargnev ndide kasitleb torustiku lisamist profiili vaates.

1) Avajoonis 14_Drawing Pipe Networks in Profile View.dwg.

2) Vasakus vaateaknas vali uus sademeveekaev iildkasutatavast alast lddnes, seejirel vali
riba pealt Draw Parts in Profile.

3) ValiJordan Court profiili vaate iiks vorgujoontest. Kaev lisatakse profiili vaatele.

4) Vajuta ESC klahvi, et tiihistada kaevu valik ning seejdrel vali toru, mis ithendab kaevu
kagus.

5) Vali riba pealt Draw Parts in Profile, seejirel kliki Jordan Court profiili vaate
vorgujoon.

6) Korda samme 2-3 ka restkaevu osas, mis paikneb positsoonist 0+073.28 pdhjas.

7) Korda samme 2-3 ka toruga, mis algab positsioonilt 0+073.28 ning 16peb 0+170.
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8)
9)

Korda samme 2-3 ka restkaevuga, mis asub positsioonist 0+/70 ldénes.
Profiili vaade peaks niiiid sisaldama kahte toru, kolme kaevu.

Jargnev ndide késitleb torude/kaevude redigeerimist 1dbi objektipunktide.

1)
2)
3)
4)

5)
6)
7)
8)

9)

Ava joonis 14_Editing Pipe Networks Using Grips.dwg.

Vasakul, plaanilisel vaatel suurenda positsooni juurde 0+170.

Vali mdlemad restkaevud, seejérel vali ringikujuline objektipunkt idapoolsel restkaevul.
Vali lddnepoolse restkaevu nelinurkne objektipunkt. See pdorab idapoolset restkaevu,
et joondada see lddnepoolse kaevuga. Sellega seonduvalt joondatakse idapoolne kaev
ka konniteeservaga.

Aktiveeri tarkvara alumisel nupuribal Dynamic Input.

Suurenda joonist toru juurde, mis paikne positsioonil 0+170, vali see.Vali toru keskel
olev, kolmnurkne objektipunkt.

Tiri objektipunkt torust eemale ning kui Dynamic Input kuvab sulle 0.450, tee klikk. Sa
vOid vastavasse kasti ka sisestada védrtuse 0.450.

Alumisel, parempoolsel vaateaknal suurenda vaadet lildkasutatava ala lddneserva. Vali
kaev ning seejérel selle keskelt nelinurkne objektipunkt.

Veendu, et OSNAP oleks aktiivne.

10) Vali kaevust lddnepoole jddva punase ringjoone keskpunkt. Pane tihele, et ka profiili

vaates muutub kaevu paigutus veidi.

11) Kliki iilemisel parempoolsel vaateaknal. Seejérel vali toru Jordan Court profiili vaatel,

mis jadb koige vasakule.

12) Vali toru vasakus servas teemandkujuline objektipunkt. Vahenda joonist, nii et ndeksid

diinaamilist vaadet (modtu), kasti. Sisesta kasti 54.864 ning vajuta ENTER.

13) Liilita Dynamic Input vélja. Vali niitid kaev, mis jadb Jordan Court profiili vaate kdige

vasakusse serva.

14) Vali kaevu allosas kuvatav kolmnurkne objektipunkt ning tiri seda iilesse poole, kuniks

kuvatakse siimbolina punane ringjoon (lébiva diagonaaliga). Kliki kuniks seda stimbolit
kuvatakse. Kaevu pohja korgusmérki veidi tostetakse, kuid Autodesk Civil 3D ei luba
olukorda, kus kaevu pohi on kdrgemalt kui seda ithendav madalaim toru.

Jargnev néide késitleb Network Layout Toolbar ning riba peal paiknevate toovahendite kaudu
tehtavaid redigeerimisi.

1)
2)

3)
4)
5)
6)
7)
8)

9)

Ava joonis 14_Editing Pipe Networks Using Editing Tools.dwg.
Vali mistahes kaev v0i toru joonisel, seejérel riba pealt Edit Pipe Network. Kuvatakse
nupupaan Network Layout Tools.
Nupupaanil Network Layout Tools:

a. Vali kaev Cylindrical Junction Structure NF SI > Storm Manhole.

b. Vali must kolmnurk, et laiendada nupupaani vaadet. Vali Structures Only.
Liilita OSNAP vilja.
Kas plaanilisel voi 3D vaatel kliki toru keskpunkti ldheduses, mis algab positsioonilt
0+073.280 ning 16peb 0+170. Torule lisatakse uus kaev.
Vajuta ESC, et tiihistada aktiivne kdsk. Vali viimati tehtud kaev, seejérel vali selle
nelinurkne objektipunkt (keskelt).
Tiri see punase ringjoone keskpunkt, mis asub Jordan Court positsiooni 0+110
laheduses.
Vajuta ESC klahvi, et eelmine valik tiihistada. Plaanilisel vaatel kliki torul, mis siseneb
uude kaevu ldunast. Vali riba pealt Swap Part.
Dialoogis Swap Part vali Concrete Pipe SI > 450mm Concrete Pipe ning kliki OK.
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10) Korda samme 8-9 toru osas, mis viimati lisatud kaevust vélja (pdhja suunda). Sa oled
niitidseks lisanud uue kaevu ja suurendanud sellega iihenduvate torude 14bimootusid.

11) Sulge nupupaan Network Layout Tools. Vajuta ESC klahvi, et tiihistada eelmine valik.
Vali iiks kanalisatsioonitorudest, seejirel riba pealt Merge Networks.

12) Esimese dialoogis vali Sanitary-2 ning kliki OK. Siin valid sa torustiku, mis liidetakse
teise torustikuga. Peale tegevuse ldbiviimist ei eksisteeri enam sellise nimega
torustikku.

13) Teises dialoogis vali Sanitary ning kliki OK. Siin valid sa torustiku, millega eelnev,
Sanitary-2 liidetakse.

14) Prospector paanil laienda Pipe Network > Networks. Pane téhele, et torustikku
Sanitary-2 enam ei eksisteeri.

15) Korda samme 11-13, seekord vali Sanitary-3 ning liida see Sanitary torustikuga.

Jargnev nidide késitleb torusiisteemide omaduste pohist redigeerimist.

1) Ava joonis 14 Editing Pipe Networks Using Properties.dwg. Selles niites me
keskendume torusiisteemile, mis paikneb Madison Lane timbruses. Profiili vaates pane
tdhele, et toru paigutuse juures on kdrguslikud ebakdlad.

2) Ulemises, parempoolses vaateaknas suurenda Madison Lane profiili vaatele ning pane
tahele silti, mis kuvab: ELEV = 55.160. See korgusmérk esitab tagasipoorde keskpunkti
kdrgusmaérgi, mis on ka kaevu asukohaks.

3) Vali vasakpoolne vaateaken, seejirel suurenda vaadete, et saaksid valida selle kaevu
Madison Lane tagasipoorde keskel. Vali riba pealt Structure Properties.

4) Dialoogis Structure Properties, paanil Part Properties:

a. Automatic Surface Adjustments = False.
b. Insertion Rim Elevation = 55.160.
c. Kliki OK.

5) See parandab kaevu iilemise korgusmirgi, kuid toru vajab endiselt redigeerimist. Vajuta
ESC klahvi, et tiihistada valik. Plaanilisel vaate vali toru, mis algab Madison Lane
tagasipoordelt. Parem klikk, ning vali Properties.

6) Properties paletil, muuda Start Invert Elevation = 53.941.

7) Toru on endiselt valitud, vali riba pealt Pipe Properties.

8) Dialoogis Pipe Properties, paanil Part Properties, sisesta Pipe Slope (Hold Start) = -
1.5. Kliki OK. Toru korrigeeritakse, kuid kaevu pohi on endiselt vale.

9) Vajuta ESC klahvi, et tiihistada toru valik. Vali kaev, mis asub Madison Lane
tagasipoorde keskosas, parem klikk ning vali Structure Properties.

10) Ehkki Sump Depth = 0.6, sisesta see vairtus uuesti. Vajuta ENTER. Kliki OK. Profiili
vaade kahaneb niiiid oluliselt, sest vertikaalis on see niiiid mérksa kompaktsem. Kaevu
pohja uuesti sisestamine pdhjustas ka iilejaidnud modtude timberarvutuse.

Jargnev ndide kisitleb toovahendit Pipe Network Vistas ja selle kaudu torustiku redigeerimist.

1) Avajoonis 14 Editing Pipe Networks Using the Pipe Network Vistas.dwg.

2) Vali mistahes toru/kaev jooniselt, seejérel riba pealt Edit Pipe Network.

3) Nupupaanil Network Layout Tools, vali Pipe Network Vistas. Kuvatakse Panorama, mis
kuvab paanid torude/kaevude osas.

4) Vali paan Structures. Hoia all CTRL klahvi ning vali neli rida, mis kaasavad enda
kirjelduses Rectangular Junction Structure NF SI kirjet.

5) Parem klikk Description veeru péisel ning vali Edit.

6) Sisesta INLET ning vajuta ENTER. Kdigi nelja kirjeldused peaksid niiiid olema INLET.

7) Description veerus muuda Cylindrical Junction Structure NF SI kui MANHOLE.
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8) Viimase kaevu kirjeldus muuda kui ENDWALL.

9) Vali paan Pipes. Hoia all SHIFT klahvi ning vali esimene ja viimane toru. Kdik read
peaksid olema sellega valitud.

10) Parem klikk Style veeru péisel ning vali Edit.
11) Dialoogis Select Pipe Style vali C-STRM — Walls in Profile. Kliki OK. Profiili vaates
muutub niilid torude esitus, mis esitab need {ihes toru seina paksusega.
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Survetorusiisteemide disain

Survetorussiisteemide disaini juures kasutame me monevdrra teisi komponente kui seda tegime
isevoolsete juures. Survetorustike juures me iildjuhul moistame veetorustikke, kuid ka
sademevee- ning kanalisatsioonitorustike teatud 16igud vdivad todtada surve all. Survetorustike
juures on komponentide (liitmike) valik laiem kui seda isevoolsete siisteemide juures. Uldjuhul
peavad need torustikud paiknema ka sligavamal (pdhjamaades), et vilistada nende
labikiilmumise ohtu. Survetorusiisteemide komponendid kuvatakse Prospector paanil omaette
sektsioonis: Pressure Networks. Nii nagu ka isevoolsete torusiisteemide juures paneme me
paika torude/liitmike valiku, mida soovime kaasata.

Survetorusiisteeme saab rajada kahel erineval moel: konverteerida olemasolevat graafikat voi
lisada komponent komponent haaval.

Komponent komponent haaval lisamiseks kasutame riba paani Pressure Network by Layout.
See kuvatakse kui valida toovahend Pressure Network Creation. Torustike lisamise kdigus
kuvatakse sulle kompass, mis aitab valida liitmike nurkasid.

Survetorustike saab redigeerida samuti neljal pohimeetodil: 14bi objektipunktide, 14bi
omaduste, 1dbi spetsiaalsete todvahendite ning kaasates Pipe Network Vistas tdvahendit. Neist
neljast meetodist objektipunkti ning spetsiaalsete toovahenditega teostavad muudatused
erinevad isevoolsete torusiisteemide redigeerimisest oluliselt.

Survetorustike disaini juures saab kasutada todvahendeid Design Check ning Depth Check, mis
on leitavad Pressure Networks riba paanil ning mille kaudu saab kontrollida probleeme toru
painderaadiusega vOi omavahel mittesobivaid toru ldbimddtusid. Lisaks saab ka kontrollida
vastuolu paigaldusiigavuse 1dikes.
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Tooleht - Survetorusiisteemide disain

Jargnev néide késitleb survetorusiisteemi loomist olemasoleva graafika alusel.

1)
2)

Ava joonis 15 _Creating Pressure Networks from Objects.dwg.

Suurenda vaadet Madison Lane juurde. Pane tdhele sininst poliijoont nimetusega W, mis
esitab kavandatud veetoru paigutust.

Riba paanil Home > Pipe Network > Create Pressure Network from Object.
Vali sinine poliijjoon, vajuta ENTER, et ndustuda vaikimisi suunaga.
Dialoogis Create Pressure Pipe Network from Object:

Network Name = Madison Lane Water.

Parts List = Water Supply.

Size and Material = 100mm Ductile Iron.

Surface Name = Road FG.

Alignment Name = Madison Lane.

Depth of Cover osas veendu, et oleks valitud 1.000m.

Vali kastike Erase Existing Entity.

Kliki OK.

SR e a0 o

Ehkki sulle voib tunduda, et midagist viga ei muutunud, konverteeriti olemasolev poliijjoon
3D objektiks lihes vajalike liitmikega. Vaata 3D vaadet, kus paistab uus objekti ka paremini
vilja.

6)
7)

8)

Vali riba pealt Modify > laienda Design tahvlit > vali Pressure Pipe Network.

Vali riba pealt Draw Parts in Profile. Vali liks virskelt tehtud veetoru liitmik ning vajuta
ENTER maérkimaks, et soovid tervet vorku lisada.

Vali Madison Lane profiili vaate vorgujoon. Veetoru osad kuvatakse niitid profiili
vaatel.

Jargnev nédide késitleb survetorustike lisamist komponent-komponent haaval.

1)

2)
3)

4)

S)
6)

8)

9)

Ava joonis 15 Creating Pressure Networks by Layout.dwg. Selles joonise on mérgitud
punaste ringjoontega liitmike asukohad.
Riba pealt Home > Pipe Network > Pressure Network Creation Tools.
Dialoogis Create Pressure Pipe Network:

a. Network Name = Water Main.

b. Parts List = Water Supply.

c. Surface Name = Road FG.

d. Alignment Name = Jordan Court.

e. Kliki OK.
Kuvatakse riba paan Pressure Network Plan Layout. Tee jargmist:

a. Network Settings > Cover = 1.5.

b. Sektsioonis Selec a Size and Material > 150mm Ductile Iron.
Vali Pipes Only. Vali punase ringjoone A keskpunkt, seejirel ringjoone B keskpunkt.
Pane tdhele kompassi, mis luba sul teatud méédral painutada toru.
Kaésureal vali Curve, et rakendada Curve site. Vali ringjoone C keskpunkt.
Késureal vali Straight, et rakendada Straight séte. Vali ringjoone D keskpunkt.
Riba pealt, sektsioonis Add Fitting = 150 Elbow 90 Deg. Kliki Add Fitting. Vali viimati
lisatud toru 16pupunkt. Uus liitmik peaks sellega olema ka lisatud, kuid see on pooratud
vales suunas.
Vajuta ESC klahvi, et tithistada hetke kdsk. Alumises paremas vaateaknas liigu samasse
punkti, kus sinu disain on hetkel pooleli. Vasakus vaateaknas vali uus liitmik ning
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seejarel vali ringjoonekujuline, et muuta liitmiku pooret (Idunasse). Vajuta ESC klahvi,
et tiihistada liitmiku valik.

10) Vali riba peal Pipes & Bends. Vasakus vaateaknas vali 90° pdlv ning seejdrel vali

ringjoone E keskpunkt. Pane tihele kompassi erinevust, niilid kuvatakse voimalikke
nurki ning mitte painutusi. Voimalikud nurgad soltuvad liitmike andmebaasist, mida
hetkel kasutatakse.

11) Késureal vali Curve, et rakendada Curve site. Vali punkt ringjoonte £ ning F vahel,

seejérel ringjoone F keskpunkt.Vajuta ESC klahvi, et 10petada kédsk. Uus 90° pdlv on
sellega lisatud ning punktide E ning F vahel on kaarjoon.

Jargnev nédide késitleb objektipunkti pohist redigeerimist.

1)
2)

3)
4)

5)

6)
7)
8)

9

Ava joonis 15 _Editing Pressure Networks Using Grips.dwg.

Vasakus vaateaknas suurenda ringjoone D/ juurde, vali 90° polv selle 1dhedusest. Vali
liitmik ning seejdrel vali nelinurkne objektipunkt.

Vali ringjoone D2 keskpunkt. Liitmik muudab enda asukohta. Samas peaks selle esitust
niitid muutma kui 45°. Seda teeme monevorra hiljem.

Alumises parempoolses vaateaknas vali £ ning F/ vahel olev toru, seejirel F/
kolmnurkne objektipunkt. Liiguta see ringjoone F2 keskele.

Vali ringjoone F2 juures olev “+*“ mirgi kujuline objektipunkt. Riba peal vali
maapinnana £G ning muuda Cover = 1.5. Vali toruna /50mm Ductile Iron ning seejérel
haara kinni punkti G keskpunktist.

Vajuta ESC, et 16petada hetke kdsk ning ka tiihista objektide valik. Vali toru E ja F2
vahel. Seejdrel riba pealt Pipe Networks: Water Main > Draw Parts in Profile.

Vali iiks Jordan Court profiili vorgujoontest. Veetoru peaks sellega olema kuvatud ka
profiili vaatel.

Vajuta ESC, et tiihistada hetke valikud. Vali kdik torud/liitmikud, mis jadvad E ning 4
vahele. Seejérel kasuta toovahendit Draw Parts in Profile, et lisada need profiili vaatele.
Profiili vaatel vali vasakult poolt teine liitmik (positsiooni 0+080 liheduses). Vali
teemandikujuline objektipunkt. Aktiveeri Dynamic Input.

10) Vdhenda joonist, kuniks nded Dynamic Input poolt esitatud kdrgusmarki. Sisesta 55.45

ning vajuta ENTER.

11) Vali parempoolsest servast toru. Vali ringjoonekujuline objektipunkt, seejérel vali punkt

veidi veetorust iileval pool. Toru on painutatud kergelt iilesse poole, et 1dbida sinu poolt
valitud punkti.

Jargnev niide késitleb todvahendite Design Check ning Depth Check kasutamist survetorustike

juures.

1)
2)
3)
4)
S)

6)

Ava joonis 15 _Checking Design and Depth.dwg.

Vali toru, mis on punktide D2 ning E vahel. Seejérel vali riba pealt Design Check.
Dialoogis Run Design Check, eemalda linnukesed vélja arvatud kastist Deflection ning
kliki OK. Kuvatakse kaks hoiatussiimbolit, mdlemal pool toru.

Suurenda veateadete juurde ning liigu kursoriga iile nende. Sulle peaks kuvatakse, et
probleem on toru kdverusraadiusega.

Vajuta ESC klahvi, et tiihistada hetke valik. Seejérel vali Jordan Court profiili vaatel
toru, mis paikneb méie all. Vali riba pealt Depth Check.

Vali sama toru uuesti ning vajuta ENTER. Dialoogis Run Depth Check > Minimum
Depth of Cover = 1.5 ning Maximum Depth of Cover = 3. Vali kastike Maximum Depth
of Cover. Kliki OK.
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7)

Ulemises parempoolsest vaates peaksid nigema niiiid veateadet toru osas, mis paikneb
mae all. Kui litkuda selle peale, siis hoiatatakse, et maksimaalne toru paigaldussiigavust
on iiletatud.

Jargnev niide kisitleb Plan Layout Tools kasutamist, et redigeerida olemasolevat
survetorustikku.

1)
2)

3)

4)

5)

6)

7)
8)
9)

Ava joonis 15_Editing a Pressure Networks Using the Plan Layout Tools.dwg.
Nii vasakus kui alumises paremas vaateaknas suurenda ringjoone D2 juurde. Vali polv,
mis paikneb punase ringjoone D2 keskel ning vajuta Delete klahvi, et see kustutada.
Vali liks torudest, et kuvada Pressure Networks riba paan. Seejdrel vali Edit Network >
Plan Layout Tools.
Riba paanil Pressure Network Plan:

a. Veendu, et maapinnana oleks valitud Road FG.

b. Cover = 1.5.

c. Vali toruna /50mm Ductile Iron.

d. Vali liitmikuna /50mm Elbow 45 Deg.
Kliki Add Fitting, seejirel emba-kumba toru ringjoone D2 sees. Vajuta ESC klahvi, et
16petada kisk ning tiihistada objektide valik. Juhul kui liitmikku kuvatakse vales suunas
kasuta noolekujulisi objektipunkte, et see podrata diges suunas.
Vali toru, mis ei ole ihendatud, et kuvada selle objektipunktid. Vali teemandikujuline
objektipunkt, seejérel vali viimati lisatud liitmik, et toru sellega ithendada. Vajuta ESC
klahvi, et tithistada toru valik.
Kustuta liitmik 90 ringjoone E juures. Korda samme 5-6, et asendada see liitmikuga 45.
Riba peal vali hetke liitmikuna: /50mm Tee.
Kustuta ringjoone F2 juures liitmik 90. Korda samme 5-6, et lisada sinna liitmik /50mm
Tee.

10) Vasakus plaanilises vaates vali viimati lisatud kolmik, seejérel vali pdhjapoolne

plussmaérgi kujulisel objektipunktil. Haara kinni ringjoone H keskpunktist, et luua uus
toru. Vajuta ESC klahvi, et 10petada kask ning tiihistada objektide valik.

Jargnev ndide késitleb Profile Layout Tools todvahendeid, et redigeerida olemasolevat
survetorustiku disaini.

1)
2)
3)

4)
S)

6)

7)

Ava joonis 15 Editing a Pressure Network Using the Profile Layout Tools.dwg.

Vali uus toru, mis paikneb ringjoonte H ja F2 vahel ning ka kolmik ringjoone F2 juures.
Vali riba pealt Draw Parts in Profile, seejarel vali Jordan Court profiili vaate
vorgujoon. Uus toru ning liitmik lisatakse ka profiili vaatele

Endiselt on iiks liitmik voi toru valitud, vali riba pealt Edit Network > Profile Layout
Tools.

Add Bend = 150mm Elbow 45 Deg. Seejarel kliki Add Bend.

Ulemises paremas vaateaknas paiguta kursor punase ringjoone allosas paiknevast
liithikese toru paremasse serva. Kui kuvatakse indikaator (liitmaks olemasoleva
objektiga) tee klikk torul. Vali kdsureal COunterclockwise. Uus 45° kraadine liitmik
peaks kuvatama. See voib vertikaalse kokkusurumise tottu néha vilja veidi veider. 3D
vaates peaks see aga mirksa parem vilja ndgema.

Veendu, et hetke toruna (riba peal) oleks valitud 7150mm Ductile Iron, seejérel kliki Add
Pressure Pipe. Kui palutakse valida esimene komponent, vali viimati lisatud polv.

Kui palutakse valida viimane komponent, vali toru, mis jddb punasest ringjoonest
paremale. Vasta Yes, kui kiisitakse, kas soovid jitkata.
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8) Vali viimati tehtud polv, seejirel haara kinni selle liitmiku iilaosas oleva ringjoone
keskpunktist.

9) Vali Add Bend, vali viimati lisatud toru otspunkt (veendudes, et indikaator on kuvatud).
Kaésureal vali Clockwise. Uus 45° liitmik on lisatud.

10) Vali toru, mis jdéb viimati lisatud liitmikust paremale. Vali toru vasakus servas olev
iilespoole suunatud kolmnurkne objektipunkt ning tiri seda lisatud uue liitmiku suunas.
Vali lisatud liitmik, et ithendada toru sellega. 3D vaates peaksid ndgema olemasoleva
toru iithendust uue disainitud toruga.

11) Vali riba pealt Break Pipe. Leia kaks vertikaalset punast joont esimese toru juures. Kliki
vasakpoolse punase joone ja toru lilemise osa ristumispunktis.

12) Korda samme ka parempoolse punase joonega.

13) Riba pealt vali Delete Part. Vali toru segment, mis jadb kahe punase joone vahele.

14) Vali riba pealt Add Appurtenance, vali niitid kustutatud osa vasakus servas. Profiili
vaates kuvatakse siibri stimbol.

15) Vali toru kustutatud osa paremas servas, et kuvada selle objektipunktid. Vali
iilessepoole suunatud kolmnurkne objektipunkt ning tiri seda vérskelt lisatud siibi
suunas. Kliki kui kuvatakse indikaator. Vaata loodud disaini 3D vaates (all paremal).

16) Vajuta ESC klahvi, et tiihistada objektide valik. Profiil vaates nihuta seda paremale ning
vali pikk toru. Riba paanil Pressure Network Profile Layout > Follow Surface.

17) Vajuta ENTER, seejirel sisesta kdsureale 1.5 (kui palutakse sisestada sligavus). Vajuta
ENTER, et 1opetada kdsk. Toru jagatakse segmentideks, et sdiliks ndutud siigavus
maapinna all.
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Torusiisteemide kuvamine ning annoteerimine

Toruslisteemide disaini juures on nende annoteerimine (sildistamine) sama oluline nagu
mistahes teises, eelnevalt késitletud disaini valdkonnas. Kuna annoteerimine ei soltu otseselt
torusiisteemi tiiiibist (isevoolne, surve-), siis vaatame seda teemat {iildisemas plaanis.
Toru/kaevu visuaalse esituse muutmiseks kasutame me endiselt stiili mdistet. Kaevu/liitmiku
juures saame valida, kas esituskuva on ploki pdhine, tegelik 3D komponent voi
vilisperimeetrina. Naiiteks ploki kasutamisel saame maddrata ploki skaala. Soltuvalt vaate
tiitibist on need eelnimetatud valikud veidi erinevad. Torude puhul on kaks olulisemat
esitusstiili: ihe joonega vai lihes toru seina paksusega.

Enne kui kasutame torude/kaevude sildistamise todvahendeid on moistlik veenduda, et need
oleksid nimetatud loogiliselt (jarjestatult).

Siltide lisamiseks plaanis kasutame taas Add Labels todvahendit. Saad sellega sildistada
ithekaupa voi korraga terve vorgu. Peale paigutamist voib tekkida vajadus nende asukohta
korrigeerida (l&dbi objektipunktide). Profiili vaates saame samuti kasutada Add Labels
toovahendit.

Varasemalt oleme kasutanud tabelite lisamise funktsionaalsust, et kuvada lisainfot objektide
kohta tabelina, et joonist mitte liialt koormata. Ka torusiisteemidele saame lisada tabeleid. Siin
on tabelite lisamine monevorra lihtsam, kuna me ei pea tegema vahepealset sammu nagu
kruntide juures, kus lisasime esmalt tdhise. Samas on torude/kaevude sihipdrane nimetamine
ikkagi oluline, et neid oleks lihtsam tabelist leida.
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Tooleht - Torusiisteemide kuvamine ning annoteerimine

Jargnev néide kisitleb kaevude kuva esituse muutmist 1dhtuvalt stiilidest.

1)
2)

3)

4)
5)

6)

7)

8)

9)

Ava joonis 16 Applying Structure and Fitting Styles.dwg. Vasakus vaates voiks
justkui aimata, et kaks kaevu on omavahel kokkupuutuvad.

Vasakus vaates vali Sanitary kaev (see, mille siimbolis kasutatakse S téhte), seejirel riba
pealt Structure Properties. Kuvatakse dialoog Structure Properties.

Vali paan Information, vali stiilina C-SSWR — Outline. See kuvab tegeliku 3D objekti
vilisperimeetri. Niilid ndeme, et komponent on tegelikult suurem kui siimbol seda
esitab.

Vajuta ESC klahvi, et tithistada komponendi valik. Vali niiiid sademeveekaev (see,
mille siimbolis kuvatakse D tihte), vali riba pealt Structure Properties.

Vali stiilina C-STRM — Outline. Niiiid kuvatakse mdlemad kaevud tegelikus suuruses
ning need on ilmselt omavahel kattuvad.

Vajuta ESC klahvi, et tiihistada valikud. Vasaskus vaateaknas liigu pohja suunal,
Jordan Court sdiduteel paikneva veetoru ja olemasoleva veetoru liitumispunkti. Vali
kolmik ning kaks pdlve, mis jddvad tihenduspunkti 1dhedusse.

Parem klikk ning vali Properties. Vali stiilina Water 3D. Stiili muudatusega nieme me
niiiid neid objekte 3D-na.

Vajuta ESC klahvi, et tiihistada eelmine valik, kuid jita Properties palett avatuks.. Liigu
nliiid Jordan Court ning Emerson Road ristumispunkti ning vali seal paikne
sademeveekaev.

Properties aknas muuda stiil C-STRM — MH Symbol Plan & Profile. Kuva muutub
kergelt.

Jargnev ndide kisitleb toru stiilide muutmist.

1)

2)
3)

4)

5)

6)

Ava joonis 16 _Applying Pipe Styles.dwg. Vasak vaade on suurendatud Logan Court
soiduteele, kus kanalitoru 16ikab sademeveetoru.

Vasakus vaates vali roheline toru nimetusega SAN. Vali riba pealt Pipe Properties.
Dialoogis Pipe Properties vali paan Information. Muuda stiili kui C-SSWR — Double
Line ning kliki OK. Toru esitust muudetakse, niilid esitatakse ka selle siselabimdotu.
Vajuta ESC klahvi, et tiihistada eelmine valik ning seejérel kliki profiili vaate joonel
(iilemisel parempoolsel vaateaknal). Kliki riba pealt: Profile View Properties.
Dialoogis Profile View Properties, vali paan Pipe Networks. Leia torud, mis kuuluvad
Storm2 alla. Uks torudest on veerus Draw mirgitud kui Yes. Vali kastike veerust Style
Override (sama toru osas).

Dialoogis Pick Pipe Style vali C-PROF-STRM — Crossing ning kliki OK. Sulge ka
Profile View Properties dialoog. Toru kuvatakse niilid ellipsina. Seda ellipsit kuvatakse
asukohas, kus toru 16ikab telgjoont. Selles vaates on ilmne, et torud omavahel l6ikuvad,
mistottu ei ole see aktsepteeritav.

Jargnev ndide kisitleb torude/kaevude timbernimetamist.

2)

Ava joonis 16 _Renaming Pipes and Structurers.dwg.

Vasakpoolses vaateaknas vali restkaev positsioonil 0+1770, mis paikneb Jordan Court
soidutee ida servas. Parem klikk ning vali Properties.

Properties aknas muuda nimetust kui INLET-01.

Vajuta ESC, et tiihistada valik. Vali restkaev, mis jadab INLET-01 vastaspoolele.
Properties aknas muuda nimetust kui INLET-02.
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6)

7)
8)
9)

Vajuta ESC klahvi, et tiihistada valik. Vali toru INLET-01 ning INLET-02 vahel ning
nimeta see kui STM-01.

Nimeta toru, mis véljub INLET-02 kaevust kui STM-02.

Muuda kaevu nimetust positsioonil 0+1170 kui STMH-01.

Jétka imbernimetamisega.

10) Kui jouad viimase kaevuni, viljavoolu kaev, nimeta see kui ENDWALL-01.
11) Prospector paanil laienda Pipe Network > Networks > Storm1. Sektsioonis Storm1 vali

Pipes. Torud voidakse esitada vales jarjekorras.

12) Sektsioonis Storm1, vali Structures. Jalgi kaevude nimekirja.

Jargnev néide késitleb siltide lisamist sademveetoru siisteemile.

1)
2)
3)

4)

Ava joonis 16 _Creating Labels in Plan View.dwg.
Riba paanil Annotate vali Add Labels.
Dialoogis Add Labels:

a. Feature = Pipe Network.

b. Label Type = Entire Network Plan.

c. Pipe Label Style = C-STRM — Pipe Data (One Line).

d. Structure Label Style = C-STRM — Structure Data.
Vali mistahes toru voi kaev sademeveesiisteemi mahus, mis ldhtub Jordan Court
algusest. Sildid lisatakse kdikidele torudele/kaevudele. Need vdidakse lisada iisna
segamini, kuid sellega me tegeleme hiljem.

Jargnev ndide késitleb toru/kaevu siltide iimberpaigutamist joonisel.

1)
2)

3)
4)

S)
6)
7)
8)

9)

Ava joonis 16_Editing Labels in Plan View.dwg.

Vasakus vaateaknas leia kaev INLET-01 (Jordan Court, 0+170). Vali silt, seejérel
nelinurkne objektipunkt. Nihuta silti vabamasse kohta.

Korda sammu 2 ka kaevu INLET-02 osas.

Vajuta ESC klahvi, et tiihistada eelmine valik. Vali toru silt STM-01, parem klikk ning
vali Properties.

Properties paletil muuda Pipe Label Style = C-STRM — Pipe Data (Stacked).

Silt on endiselt valitud, vali nelinurkne objektipunkt ning tiri silt vabamasse kohta.
Nihuta ka silte STMH-01, INLET-03, INLET-04.

Muuda STM-04 osas stiili kui C-STRM — Pipe Data (Stacked). Nihuta silt vabamasse
kohta.

Vajuta ESC klahvi, et tiihistada siltide valik. Vali silt STM-05 ning riba pealt vali Flip
Label. Sellega me muudame sildi paigutust.

10) Endiselt on silt STM-05 valitud, vali selle teemandkujuline objektipunkt ning tiri silt

piki toru, et ndha selle objektipunkti koostddd.

11) Vajadusel nihuta ka teiste siltide paigutust. Muuda STM-06 stiili kui C-STRM — Pipe

Data (Stacked).

Jargnev nédide késitleb torustike siltide lisamist profiili vaatele.

1)
2)
3)

Ava joonis 16 _Creating Labels in Profile View.dwg.
Paanil Annotate > Add Labels.
Dialoogis Add Labels:
a. Feature = Pipe Network.
b. Label Type = Single Part Profile.
c. Pipe Label Style = C-PROF-STRM — Pipe Data.
d. Structure Label Style = C-PROF-STRM — Structure Data (Above).
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4)
5)

6)

7)

e. Kliki 4dd.
Vali iilemiselt, parempoolselt profiililt esimene ning viimane kaev. Kuna vahepealsete
kaevude osas on sdidutee silt meid segamas, siis paigutame uued allapoole.
Dialoogis Add Labels, vali Label Style = C-PROF-STRM — Structure Data (Below).
Kliki Add.
Vali teine ning kolmas kaev. Need sildid paigutakse endiselt kaevust iilesse poole, kuid
pane tdhele, et formaat on veidi teistsugune. Nende iimberpaigutamisega tegeleme
hiljem.
Vali kolm toru profiili vaatelt, et lisada silt iga toru peale.

Jargnev nédide késitleb torustike siltide redigeerimist profiili vaatel.

1)
2)
3)
4)
5)

6)

Ava joonis 16 _Editing Labels in Profile View.dwg.

Ulemises paremas vaateakna vali esimese kaevu silt (STMH-02), seejirel vali
nelinurkne objektipunkt sildist iileval pool ning tiri sellest silt avatumasse kohta. Pane
tahele, et sellega saad liigutada vaid iiles-alla. See on ankurdatud.

Vajuta ESC klahvi, et tiihistada valikud. Vali teine kaev INLET-04 ning seejérel vali
riba pealt Label Properties.

Properties paletil muuda Dimension Anchor Option > Below. Silt on niiiid allosas, kuid
endiselt katab kaevu.

Vali sildi iilemine nelinurkne objektipunkt, vali tarkvara alumisel nupupaanilt Ortho
Mode ning nihuta silti allapoole.

Korda samme 3-5 sildi /NLET-05 osas.

Jargnev néide késitleb torustiku tabeli loomist joonisele.

1)
2)

8)
9)

Ava joonis 16 _Creating Pipe Network Tables.dwg.
Riba paanil Annotate > Add Tables > Pipe Network > Add Structure. Kuvatakse dialoog
Structure Table Creation.
Vali Table Style = C-SSWR — Structure & Pipe Data.
Veendu, et oleks valitud By Network ning Select Network = Sanitary. Kliki OK.
Vali punkt joonise tiihjas alas. Tabel lisatakse joonisele.
Riba peal Annotate > Add Labels.
Dialoogis Add Labels:
a. Feature = Pipe Network.
b. Label Type = Entire Network Plan.
c. Pipe Label Style = C-SSWR — Name Only.
d. Structure Label Style = C-SSWR — Name Only.
e. Kliki 4dd.
Vali mistahes kanalisatsiooni toru vdi kaev. Kogu torustik kaetakse siltidega.
Iga kanalisatsiooni kaevu sildi osas vali selle nelinurkne objektipunkt ning nihuta sildid
vabamasse kohta.

10) Iga kanalisatsiooni toru sildi osas kasuta teemandikujulist objektipunkti ning nihuta see

vabamasse kohta. Juhul kui viimane pole vdimalik, siis kasuta nelinurkset objektipunkti,
et tirida see vabamasse kohta.
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Uue maapinna kujundamine

Selles peatiikis tutvume me kahe olulise maapinna kujundamise téovahendiga: tunnusjoon
(feature line) ning profileerimine (grading). Profileerimine (kujundamine) on monevorra erinev
disainivote kui koridormudelite disain. Viimane on rohkem kasutatav just nimelt lineaarse
disaini juures (sdiduteed). Samas kui profileerimist kasutatakse pigem viiksemas mahus (maa-
alal). Tunnusjooned on aga iisna sarnased varasemalt kisitletud mdddistujoontele (survey
figuures), kuid tunnusjooned ei ole otseselt liles moddistatud, vaid loodud disaini kiigus.
Tunnusjoonte juures tuleb samuti arvestada asjaoluga, et need interakteeruvad omavahel vaid
siis kui kuuluvad iihe ja sama maa-ala alla. Tunnusjoone juures eristatakse kahte tiilipi
objektipunkte: PI ning elevation point. Kui esimest esitatakse nelinurkse objektipunktina ja
saab muuta igas koordinaadi sihis, siis kdrguspunkti (elevation point), mis on ringikujuline, on
liigutamise suhtes monevorra piiratum.

Tunnusjoonte redigeerimiseks saab Civil 3D tarkvaras kasutada kahte gruppi to6vahendeid, mis
molemad leitavad riba paanil Feature Line, tahvlitena Edit Geometry ning Edit Elevations.

Autodesk Civil 3D tarkvaras saab maapinna kujundamisel kasutada ka profileerimise objekti
(grading object) kui soovid, et tarkvara lisaks sinu eest vajalikud tunnusjooned niiteks sinu
poolt ette antud kaldel. Siin vdib paralleele tommata koridormudeliga, kus samuti tarkvara ise
arvutab vajaliku mahu/pinna. Profileerimisobjekti iiksikuid osasid ei saa eraldiseisvalt
redigeerida, ehkki ka need koosnevad néiteks tunnusjoontest jne. Selle asemel lisad sa erinevaid
disainikriteeriumeid, et mdjutada, kuidas profileerimise objekt tekib/muutub. Erinevaid
kriteeriumi saab omavahel grupeerida, et neist moodustuks mingi sarnase, tiilipobjekti
reeglistik. Profileerimisobjekti redigeerimiseks saad kasutada toovahendeid Grading Editor
ning Edit Grading.

Grading Editor avab omaette paani Panorama vaates, milles saad kriteeriume muuta
tabelesituses. Seevastus Edit Grading on kdsurea pdhine redigeerimine.

Raido Puust | Autodesk Civil 3D algkursus [0k



Tooleht - Uue maapinna kujundamine

Jargnev néide késitleb tunnusjoonte lisamist, et disainida krunti.

1) Ava joonis 17 _Creating Feature Lines.dwg. Joonis on suurendatud krundi 25 juurde.
Pane tdhele, et korridormudeli kiht on avatud, et see oleks kuvatud.

2) Riba peal Home > Feature Line > Create Feature Line from Corridor. Kisureal
palutakse sul valida korridormudeli tunnusjoon.

3) Kas iilemises paremas vdi alumises paremas vaateaknas vali koridormudeli serv, mis
kiilgneb krundiga 25 eest otsast. Kuvatakse dialoog Create Feature Line from Corridor.

4) Veendu, et Site = Lot Grading. Style = Lot Grading — ROW ning kliki OK. Uus
tunnusjoon kuvatakse punase paksu joonena.

5) Vajuta ESC klahvi, et 1dpetada eelmine kdsk. Riba paanil Home > Feature Line >
Create Feature Line. Kuvatakse dialoog Create Feature Lines.

6) Vali Style = Lot Grading ning kliki OK. Sul palutakse valida alguspunkt.

7) Ulemises parempoolses vaateaknas kasuta Center objektist kinnihaaramist ning punase
ringjoone keskpunkt, mis asub krundi 25 pdhjanurgas.

8) Kui palutakse miidrata korgus, vajuta ENTER. Sul palutakse seejérel valida jairgmine
punkt.

9) Paremas lilemises vaateaknas kasuta Endpoint objektist kinnihaaramist ning vali krundi
25 ladnepoolne nurk. Sul palutakse méérata kdrgus.

10) Késureal vali Surface. Kuvatakse dialoog Select Surface.

11) Veendu, et EG oleks valitud. Kliki OK. Vaikimisi korgusmérk késureal on niitid 57.930,
mis on selle krundi nurgapunkti korgusmirk £G pinnaobjektilt.

12) Vajuta ENTER, et ndustuda korgusmérgiga. Sul palutakse valida jirgmine punkt.

13) Késureal vali Arc. Sul palutakse valida kaare 16pp-punkt.

14) Késureal vali Secondpoint. Sul palutakse valida teine punkt.

15) Ulemises parempoolses aknas kasuta Nearest objektist kinnihaaramist ning vali krundi
25 tagumise serva peal iiks punkt. Seejérel palutakse valida 16pp-punkt.

16) Ulemises parempoolses vaateaknas kasuta Endpoint objektist kinnihaaramist, et valida
krundi 25 16unapoolne nurk. Sul palutakse seejdrel méiérata korgus.

17) Késureal vali Surface site, vajuta ENTER, et ndustuda vaikimisi kdrgusmérgiga 58.027.
Sul palutakse valida kaare 16pp-punkt.

18) Késureal vali Line. Sul palutakse valida jargmine punkt.

19) Ulemises parempoolses vaateaknas kasuta Center objektist kinnihaaramist ning vali
krundi 25 idapoolne nurk.

20) Kui palutakse médérata korgus, vajuta ENTER.

21) Vajuta ESC klahvi, et 10petada kdsk. Sa oled joonestanud tunnusjoone, mis jargib
koridormudeli esiserva ning maapinnamudeli £G korgusi tagumistes servades.

22)Riba paanil Home > Feature Line > Create Feature Lines from Objects. Sul palutakse
valida objekt.

23) Vali krundi 25 keskel olev ristkiilik ning vajuta ENTER. Kuvatakse dialoog Create
Feature Lines.

24) Vali kastike Style ning vali Lot Grading. Kliki OK. Sellega luuakse tunnusjoon, kuid
see paikneb korgus 0. Kui sa vaatad alumist parempoolset vaateakent, siis peaksid seal
ndgema ka sinist ristkiilikut.
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Jargnev nidide kisitleb geomeetria redigeerimise todvahendeid tunnusjoonte juures.

1) Avajoonis 17 _Editing Feature Line Geometry.dwg. Selles joonises on krundi 26 osas
veel kaks tunnusjoont lisatud. Sa tdiendad krundi 26 tunnusjoont, lisades P/ punkte ning
kaarjoone.

2) Vali roheline tunnusjoon. Juhul kui tahvel Edit Geometry pole kuvatud, vali riba pealt
Edit Geometry.

3) Vali Insert PI. Kui sul palutakse valida punkt, kasuta Center sétet ning vali sinise
ringjoone keskpunkt. Sul palutakse niiiid sisesta korgus.

4) Kasureal sisesta § ning vajuta ENTER, et kuvada Surface site. Kuvatakse dialoog
Surface.

5) Veendu, et EG oleks valitud ning kliki OK.

6) Vajuta ENTER, et ndustuda vaikimisi kuvatud korgusmirgiga. Sul palutakse niiiid
valida jargmine punkt.

7) Kasuta taas Center sitet ning vali punase ringjoone keskpunkt. Sul palutakse méiérata
korgus.

8) Kisureal sisesta S, vajuta ENTER, et kasutada sdtet Surface. Vajuta veelkord ENTER,
et ndustuda margitud kdrgusmaérgiga. Sellega oleme lisanud P/ punkte, kuid endiselt on
vajalik lisada ka puuduolev kaarjoon.

9) Vajuta ESC klahvi, et tiihistada eelmine késk. Vali roheline tunnusjoon ning seejarel
riba pealt Fit Curve. Sul palutakse valida punkt.

10) Késureal sisesta P ning vajuta ENTER, et valida Points séte. Sul palutakse niitid valida
alguspunkt.

11) Kasuta sitet Center ning vali sinise ringjoone keskpunkt.

12) Kasuta sétet Center ning vali punase ringjoone keskpunkt. Vajuta ESC klahvi, et tiihista
kdsk ning ka valikust loobuda. Lisatakse kaarjoon, mis jérgib krundi tagumise serva
joont. Jargnevalt poolitad sa krundi 25 tunnusjoone ning iihendad selle krundi 26 omaga.

13) Vali mistahes tunnusjoon jooniselt. Vali riba pealt Break. Sul palutakse valida objekt,
mida jagada.

14) Vali sinine, krundi 25 perimeeter joon. Sul palutakse valida teine murdepunkt.

15) Sisesta F ning vajuta ENTER, et valida séte First point.

16) Kasuta sitet Endpoint, et valida kruntide 25 ja 26 tagumine kokkupuutepunkt. Sul
palutakse valida niitid teine murdepunkt.

17) Korda eelmist sammu, et valida uuesti sama punkt. Vajuta ESC klahvi, et I6petada kisk
ning tiihistada valik. Joonis kiill ei ole teistmoodi, kuid sinine tunnusjoon on niitid
jagatud kaheks eraldiseisvaks tunnusjooneks.

18) Vali sinine tunnusjoon krundi 25 taga, seejdrel vali riba pealt Join.

19) Vali roheline tunnusjoon. Roheline muutub siniseks, markides, et kaks tunnusjoont on
omavahel ihendatud iiheks tunnusjooneks.

Jargnev ndide késitleb korguse redigeerimise todvahendeid tunnusjoonte juures.

1) Avajoonis 17 _Editing Feature Line Elevation.dwg.

2) Vali mistahes tunnusjoon jooniselt. Juhul kui tahvlit Edit Elevation pole kuvatud, siis
vali riba pealt Edit Elevations.

3) Vali Quick Elevation Edit. Liigu kursoriga krundi 25 pdhjanurka. Sa peaksid nigema
korgust 57.695.

4) Liigu ka teiste nurkade peale. Kdige kdorgem nurk on ldunapoolne (58.027). Meie
eesmdirk on, et vesi voolaks ehitisest eemale (sinine ristkiilik). Selleks paigutad sa ehitise
aluse veidi korgemale kui krundi kdrgeim punkt.

5) Vajuta ESC klahvi kuniks objekte pole valitud. Vali krundi 25 ehitise alune osa.
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6) Riba pealt vali Raise/Lower by Reference. Sul palutakse valida referentspunkt.

7) Kasutades Endpoint sitet, paiguta kursor krundi 25 ldunapoolsesse punkti, aga dra kliki.

8) Vaata koordinaatide vdljavotet. Juhul kui kolmas vairtus on 0.000, vajuta 74B klahvi.
Vajuta TAB klahvi kuni véirtus on 58.027. TAB klahv vdimaldab valida krundi
geomeetria (mis on kdrgusel 0) ning tunnusjoonte geomeetria (mis on tegelikult
korgusel) vahel.

9) Kui koordinaatide sektsioonis on kuvatud dige viirtus, vali punkt, et sellest kinni
haarata. Sul palutakse niiiid valida punkt hoone ehitusaluse perimeeterjoonel.

10) Vali ehitusaluse joone 1dunapoolne punkt. Kui palutakse sisestada grade véirtus, sisesta
2 ning vajuta ENTER. See paigutab ehitusaluse pinna kdrgusele nii, et ldunapoolsest
nurgast moodustub 2% kalle krundi 1dunapoolsesse nurka. Koik teised kalded on
monevorra jarsemad, kuna krundi nurgad asuvad madalamal.

11) Vajuta ESC klahvi, et tiihistada eelnevad valikud. Vali tunnusjoon, mis esitab kruntide
tagumist serva, seejdrel vali riba pealt Elevations from Surface. Kuvatakse dialoog Set
Elevations from Surface.

12) Veendu, et EG oleks valitud, ning linnuke oleks kastis Insert Intermediate Grade Break
Points. Kliki OK.

13) Késureale sisesta P ning vajuta ENTER, et valida alamvalik Partial.

14) Vali tunnusjoon, mis esitab kruntide tagumise serva. Sul palutakse valida alguspunkt.

15) Vali krundi 25 ladnepoolne punkt, seejirel krundi 26 1dunapoolne punkt. Tunnusjoonel
kuvatakse niiiid terve rida rohelisi, ringi kujulisi markereid.

16) Vajuta ENTER, et kidsk I0petada. Niitidsest kuvatakse terve rida ringikujulisi
objektipunkte, mis esitavad lisakdrguseid, et tunnusjoon saaks tépselt jirgida
pinnaobjekti.

Jargnev ndide kasitleb profileerimisobjekti loomist.

1) Ava joonis 17 _Creating Grading Objects.dwg. Joonis on suurendatud kavandatava
suurveepidurdusveehoidla juurde. Sa kasutad profileerimisobjekti, et kujundada tiik.
Alustad rohelisest tunnusjoonest, mis esitab tiigi iilemise siseserva.

2) Riba pealt Home > Grading > Grading Creation Tools. Kuvatakse nupupaan Grading
Creation Tools.

3) Kliki Set the Grading Group. Kuvatakse dialoog Site.

4) Vali Pond ning kliki OK. Kuvatakse dialoog Create Grading Group.

5) Sisesta Name = Pond. Veendu, et oleks valitud Automatic Surface Creation ning vajuta
OK. Kuvatakse dialoog Create Surface.

6) Kliki OK, et sulgeda dialoog Create Surface.

7) Laienda kriteeriumite nimekirja ning vali Grade to Relative Elevation.

8) Laienda loomise td6vahendeid ning vali Create Grading. Sul palutakse valida tunnus.

9) Vali roheline tunnusjoon. Kui palutakse valida profileerimise kiilg, kliki tunnusjoone
siseperimeetril.

10) Vajuta ENTER, et lisada profiil iile terve pikkuse. Sul palutakse sisestada suhteline
kdrguse viirtus.

11) Sisesta -2.13 ning vajuta ENTER. Kui sul palutakse valida formaat, vajuta ENTER, et
ndustuda vaikimisi valikuga Slope.

12) Kui sul palutakse sisestada kalle (slope), sisesta 3 ning vajuta ENTER, et lisada kalle
3:1. Peale moningast pausi luuakse uus profileerimise objekt, mis esitab tiigi sisemist
kallet. Samuti luuakse pinnaobjekt ning seda kuvatakse plaanilisel vaatel punaste/siniste
kontuuridega.

13) Laienda loomise téovahendite nimekirja ning vali Create Infill. Vali tiigi keskpunkti
laheduses olev punkt. 3D vaates peaksid niiiid ndgema, et tiigil on pdhi.
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14) Vali kriteerium Grade to Distance.

15) Laienda loomise todvahendeid ning vali Create Grading. Kui sul palutakse valida
tunnus, vali see sama roheline tunnusjoon, mida ka sammul 9.

16) Kui palutakse valida profileerimise kiilg, vali tiigist vdljapoole jddv punkt. Vajuta
ENTER, et rakendada profileerimine terves pikkuses.

17) Vajuta ENTER, et ndustuda vaikimisi distantsiga 3.000 m. Kui palutakse valida
formaat, sisesta G, et kasutada Grade sitet ning vajuta ENTER.

18) Vajuta ENTER, et ndustuda vaikimisi Grade = 2% viirtusega. Luuakse uus
profileerimisobjekt, mis esitab tiigi astangu.

19) Nupupaanil Grading Creation Tools, vali Set the Target Surface. Dialoogis Select
Surface vali EG ning kliki OK.

20) Vali kriteerium Grade to Surface. Laienda loomise toovahendeid ning vali Create
Grading.

21) Vali profileerimisobjekti vélimine serv, mille tegid sammul 18. Vajuta ENTER, et
ndustuda jdrjest vaikimisi valikutega. Luuakse kaldega 3:1 muldkeha olemasoleva
maapinna EG objektiga. Sellega oleme loonud samuti tiigi pinnaobjekti Iopp-versiooni.

Jargnev ndide késitleb profileerimisobjekti redigeerimisvatteid.

1) Avajoonis 17 _Editing Grading Objects.dwg.

2) Vali roheline tunnusjoon, mis esitab tiigi astangu sisemist serva. Vali objektipunkt, mis
asub kirde nurgas, seejdrel kasuta Center sitet, et valida iga paikneva punase ringjoone
keskpunkt. Profileerimisobjekt arvutatakse iimber, kuna baasjoon on muutunud. Lisaks
uuendatakse ka profileerimisgruppe pinnaobjektil, et kajastada uusi kontuurjooni.

3) Tunnusjoon on endiselt valitud, vali riba pealt Edit Elevations > Raise/Lower. Sul
palutakse miérata kdrguste vahe.

4) Sisesta -0.3 ning vajuta ENTER, et viia tunnusjoon 0.3m vorra madalamale. Nii
profileerimise grupp kui ka sellega seotud pinnaobjekt uueneb. Niiiid on tiigi pohi liiga
madalal ja seda tuleb tdsta.

5) Vajuta ESC klahvi, et tiihistada objektide valik. Riba peal Modify > Grading.

6) Vali Grading Editor ning vali punkt tiigi muldkeha sisemine punkt. Profileerimisobjekti
servad on esile tostetud, et valik oleks lihtsam.

7) Panorama paleti Grading Editor paanil sisesta Relative Elevation = -1.83 ning vajuta
ENTER. Profileerimise gruppi uuendatakse ning tiigi pohi on sellega seoses tdstetud
0.3m vorra.

8) Riba paanil Grading vali Edit Grading. Vali punkt, mis asub tiigi iilemisel astangu osal.
Kui sul palutakse valida distants, sisesta 3.6 ning vajuta ENTER.

9) Vajuta veelkord ENTER, et ndustuda Grade sittega ning veelkord ENTER, et ndustuda
ka kaldega 2%. Vajuta ENTER, et 10petada kdsk. Niitid uuendatakse profileerimise
gruppi, et mahutada laiemat astangut.
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Maapinna analiiiis, kuvamine ning annoteerimine

Olles kujundanud kdik iiksikud maapinna objektid nagu koridormudel, tiik, krundid — on aeg
need liita {ihte tervikusse — samuti maapinnamudelisse. Seejirel saad sa koondmudeliga lébi
viia erinevaid analiilise ning vastavusi disaini kriteeriumitega. Analiilisi kdigus saad sa
kinnitust, et mdnes osas on vaja disaini muuta — optimeerida. Peale disaini 10plikke muudatusi
saad asuda seda annoteerima, et ka ehitaja on voimeline disainitud mahtusid ellu viima.

Uks mdjuvdimsamaid tddvahendeid erinevate maapinna objektide liitmiseks on nende nii-delda
kokku kleepimine. Sellisel juhul sdilib algse maapinna mdju koondmaapinnamudelis, kui
esimene peaks nditeks muutuma. Selleks kasutame kiskusid, mis on leitavad Prospector paletil
vOi riba paanil oleva Edit Surface tddvahendi alt.

Erinevate pinnaobjektide kleepimisel on oluline nende jérjekord. Ehk siis pind, mis kleebitakse
teise kiilge, kirjutab esimesega kokkulangevad kokkupuutepunktid iile. Jirjekorda on voimalik
muuta Surfaces Properties dialoogis, paanil Definition. Seal ei ole vaid kleepimise tegevused
aga ka muud.

Olles loonud koondpinnaobjektid, saab nendega lédbi viia erinevaid analiilise nagu korguslikke,
kaldel pdhinevaid, kontuuridel pdhinevaid ning ka valgaladel pdhinevaid. Analiiiisi tulemuseks
on vérvikoodis kaart. Analiiis koosneb kahes pohisammust. Esimese sammuna sa lood
andmestiku, mille kuvamiseks on sul seejérel vaja aktiveerida pinnaobjekti stiil, mis analiiiisist
saadud tulemusi (komponente) ka kuvada oskab.

Autodesk Civil 3D tarkvaras on kaks toovahendit ka valgalade analiilisiks: Water Drop ning
Catchment. To0vahend Water Drop kaudu médrad sina punkti ja seejérel tarkvara leiab
rajajoone, kuhu sellesse punkti maha sadanud vesi voolab. Catchment madratleb aga ala, kust
koguneb maha sadanud vesi kokku sinu poolt médratud punkti.

Monel juhul on otstarbekas luua iiks kiire profiil, et ndha oma disaini teises perspektiivis.
Selleks saab kasutada toovahendit Quick Profile. Oluline on rohutada, et neid kuvatakse seni
kuniks sa pole joonist uuesti salvestanud.

T66 muldkehaga on iiks kulukamaid tegevusi maaparandusprojektides. Seega tuleb osata ka
disaini kdigus vastata kiisimustele, kui palju tuleb seda eemaldada/tdita? Kas seda tuleb projekti
alast véljast poolt sisse tuua? Autodesk Civil 3D tarkvara on mahupdhiste analiiliside
labiviimiseks mitu voimalust. Siinkohal vaatame neist tihte, Volumes Dashboard t66vahendit.

Maapinnamudeli annoteerimist on vaadeldud ka varasemates peatiikkides, kuid niitid kasutame
toovahendeid 10pp-disaini juures. To66vahendiks on endiselt Add Labels.

Raido Puust | Autodesk Civil 3D algkursus [tyAE]



Tooleht - Maapinna analiitis, kuvamine ning annoteerimine

Jargnev néide késitleb disainitud pinnaobjektide kombineerimist.

1)
2)
3)
4)

S)

6)

7)

8)
9)

Ava joonis 18 _Combining Surfaces.dwg. Selles joonises on lopetatud kruntide disain,
lisaks on kruntide 73 ja 76 vahel kasutatud profileerimise objekti, et lisada muldkeha.
Prospector paletil laienda Surfaces, pane tihele, et kdik pinnaobjektid on siin kuvatud.
Parem klikk Surfaces peal ning vali Create Surface. Kuvatakse dialoog Create Surface.
Sisesta Name = FG Final ning stiilina Contours 0.5m and 2.5m (Design). Kliki OK.
Uus, lisatud pinnaobjekt kuvatakse ka Prospector paletil.

Prospector > Surfaces > FG Final > Definition. Parem klikk Edits peal ning vali Paste
Surface. Kuvatakse dialoog Select Surface to Paste.

Vali Lots — Exterior ning kliki OK. Vasakus vaateaknas on niiiid ndha vélimiste kruntide
kontuurid. All paremas vaateaknas néded sa ka sisemist profileerimist. Pane téhele, et
osad kontuurid iiletavad sdiduteed.

Vali iiks sinine vOi punane kontuur, et valida pinnaobjekt. Seejirel riba pealt Edit
Surface > Paste Surface.

Vali Road FG ning kliki OK. Sdidutee osas on niilid kontuurid asendatud. 3D esituses
néded niiiidsest ka dérekivi ning kraavi méarksa selgemalt. Sisemine kruntide ala on tiihi,
kuna sellele on lisatud peidetud védlimine perimeeter (Road F'G pinnaobjekti mahus).
Korda samme 6-7 aga niilid vali Pond pinnaobjekt. Niilid nded kontuure ka tiigi objektil.
Korda samme 6-7 ning vali Lots — Interior pinnaobjekt. Pane tdhele, et ehkki sisemised
krundid omavad niitid kontuurjooni, siis kirjutavad need osaliselt iile ka tiigi jooned.
Selle parandame kleepimise jirjekorra muutmisega.

10) Vali iiks punane vdi sinine kontuurjoon ning vali riba pealt Surface Properties.

Kuvatakse dialoog Surface Properties.

11) Paanil Definition vali Add Surface Lots — Interior ning seejérel kliki iilespoole suunatud

noole ikoonil. See nihutab Lots — Interior pinnaobjekti Pond pinnaobjektist lilesse poole
(kleepimise jérjekord).

12)Kliki OK ning seejirel Rebuild the Surface. Niiid kuvatakse ka tiigi osas oiged

kontuurjooned.

13) Korda samme 6-7, vali niitid Lot Daylight pinnaobjekt. Niilid kuvatakse kontuurid ka

kruntide 73-76 vahel. Uhtlasi oleme loonud niiiid {ihe tervikliku pinnaobjekti.

Jargnev ndide kisitleb kaldel pohinevat analiiiisi.

1)
2)

3)
4)
)
6)

Ava joonis 18 Analyzing Surfaces.dwg. See fail sisaldab F'G Final pinnaobjekti,
mille olid loonud varasemas néites.

Vali iiks punastest voi sinistest kontuurjoontest ning seejérel riba peal Surface
Properties. Avaneb dialoog Surface Properties.

Paanil Analysis, vali analiiiisi tiitibina Slopes.

Sektsioonis Ranges, sisesta Number = 4.

Kliki Run Analysis ikoonil. Luuakse neli vahemikku sektsioonis Range Details.
Redigeeri kalde vahemikke jargmiselt:

ID | Minimum Slope | Maximum Slope | Colors
1 0% 2% 2

2 2% 10% 3

3 10% 34% 30

4 34% 1158.7766% 1
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7)

8)

9)

Vali paan Information ning muuda stiil kui Slope Banding (2D). Kliki OK ning
seejérel vajuta ESC, et tiihistada pinnaobjekti valik. Kuvatakse varvikoodis
pinnaobjekti kalded vastavalt virvikoodile. Eraldi tdhelepanu tuleks podrata punasele
alale, kuna sellised kalded ei ole turvalised vastava pinnasetiiiibi korral.

Vali tiks vérvitud aladest, et valida pinnaobjekt. Seejérel parem klikk ning vali Display
Order > Send to Back. Selliselt kuvatakse tunnusjooned ning ka muud joonise
objektid esiplaanil.

Vajuta ESC, et tiihistada eelnev valik. Ulemises parempoolses vaateaknas vali sinine,
nelinurkne tunnusjoon krundi 70 keskelt. Riba paanil Edit Elevation vali Raise/Lower.

10) Kui késureal palutakse valida korguslik erinevus, sisesta -1.524 ning vajuta ENTER.

Mone hetke parast kui pinnaobjekt taasluuakse, eemaldatakse ka punane ala krundi 70
iimbruses. Eesmine osa on endiselt roheline, seega ligipddsutee rajamine on OK.

Jargnev ndide késitleb hiidroloogia toovahendeid, et viia 1dbi pinnaobjekti analiiiise.

1))

2)
3)

5)

6)
7)

8)

9

Ava joonis 18 Using Hydrology Tools.dwg. Selles joonise on tunnusjoonte kiht vélja
lilitatud. Lisaks on ka uus pinnaobjekt EG-FG Composite. See pinaobjekt on saadud
kui uude pinnaobjekti on liidetud EG ning FG Final pinnaobjektid. Selle eesmérk on
voimaldada analiilise, mis oleks siis kui projekt oleks juba ellu viidud.

Vali riba pealt paan Analysis ning seejérel Flow Paths > Water Drop. Sul palutakse
valida pinnaobjekt.

Vajuta ENTER, et valida see nimekirjast. Kuvatakse dialoog Select a Surface.

Vali EG-FG Composite, seejirel kliki OK. Kuvatakse dialoog Water Drop.

Vajuta OK, et sulgeda Water Drop dialoog. Vasakus vaateaknas vali punkt krundi 29
soiduteepoolses servas. Sinine vee valgumise rajajoon joonistub krundi 29 juurest, piki
adrekivi ning peatub restkaevu juures, mis paikneb positsioonil 0+080. See rajajoon
kuvatakse ka 3D vaates.

Endiselt on késk Select point: aktiivne. Vali punkt krundi 23 1dunapoolsest nurgast.
Siit valgub vesi piki Madison Lane sdiduteed ning 16peb ligikaudu positsioonil 0+220.
Vajuta ESC klahvi, et 10petada késk. Riba paanil Analysis > Catchments > Create
Catchment from Surface. Sul palutakse valida véljavoolupunkt.

Vasakus vaateaknas kasuta Center sétet ning vali punase ringjoone keskpunkt (teise,
sinu poolt loodud kokkuvoolu rajajoone 16pus). Kuvatakse dialoog Create Catchment
from Surface.

Vali EG-FG Composite kui pinnaobjekt ning kliki OK. Sinine perimeeter kuvab
valgala piirjoone, millelt valgub vesi sinu poolt médératud punkti.

Jargnev ndide késitleb ajutise profiili lisamist joonisele.

1)

2)
3)

4)

5)

Ava joonis 18 Using a Quick Profile.dwg. Selles joonises on vasakus vaateaknas
kuvatud iiks punane poliijoon.

Riba pealt paanil Analysis > Quick Profile.

Kui sul palutakse valida objekt, vali eelnimetatud punane poliijoon, mis ristub ka
tiigiga. Kuvatakse dialoog Create Quick Profiles.

Veendu, et kastike Select All Surfaces oleks vilja liilitatud, seejdrel vali kastid EG
ning F'G Final. Vali profiili stiiliks FC Final osas Design Profile.

Kliki OK, seejdrel vali lilemises parempoolses vaateaknas alumine vasakpoolne punkt.
Luuakse uus profiili vaade, kus olemasolev maapind on punase joonega ning
kavandatav musta joonega. Kui uurid seda profiili ldhemalt, peaksid suutma eristada
soidutee kulgemist kahes punktis ning ka tiigi vormi.
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6) Vali punane poliijoon, et esitada selle objektipunktid. Vali iiks objektipunktidest ning
nihuta see teise asukohta. Pane tdhele muudatust profiilil. Saad seda poliijoont
kasutada, et analiilisida profiili erinevates asukohtades.

7) Vajuta ESC klahvi, et tiihistada poliijoone valik. Suurenda vaadet sisemiste kruntide
juurde. Pane tihele rohelist poliijjoont, mis moodustab kruntide 68-70 tagumise
perimeetri.

8) Vali riba pealt Quick Profile. Kui palutakse valida objekt, vali roheline poliijoon.
Kuvatakse dialoog Create Quick Profiles.

9) Vali kastike £G korval.

10) Veendu, et site Draw 3D Entity Profile oleks valitud, seejéarel 3D Entity Profile Style
= Design Profile.

11) Kliki OK ning seejdrel vali punkt eelmisest profiilist paremal pool. Luuakse uus
profiil, mis esitab olemasoleva maapinna punase joonega, ning tunnusjoone profiili
musta joonega. Pane tihele, kuidas tunnusjoon jidrgib maapinna joont, vélja arvatud
molemas otsas, kus see on seotud 16petatud pinnaobjektiga.

Jargnev néide késitleb toovahendit Volumes Dashboard, et leida mahtude tasakaal.

1) Avajoonis 18 Calculating Volumes.dwg.

2) Vali riba pealt paan Analyze ning kliki seejirel Volumes Dashboard.

3) Panorama paanil Volumes Dashboard kliki Create New Volume Surface.

4) Dialoogis Create Volume Surface:

a. Name = Earthwork.

b. Style = No Display.

c. Base Surface = EG.

d. Comparison Surface = FG Final.
e. Kliki OK.

5) Vastavad mahud kuvatakse Panorama paanil. Pane tdhele, et 1digatav maht (Cut
Volume) on oluliselt vdiksem kui tditele kuluv (Fill Volume). Projekt pole seega
balansis, seega on meil vaja hetkel pinnast projekti maa-alale juurde tuua. Disaini
tuleks muuta, et need kaks vaartust oleksid veidi rohkem tasakaalus. Seda saab teha
nditeks ehitiste aluse kruntide madalamaks viimist (tunnusjoonte kaudu), et saaksime
suurema loigatava mahu.

6) Kliki Earthwork ning seejérel Add Bounded Volume. Kui palutakse valida Bounding
Object vali krundi 1 pindala silt.

7) Korda eelnevat sammu ka kruntide 2 ning 3 osas. Vali plussmirk Earthwork ees. Pane
tahele, et siin kuvatakse krundipdhist mahtude analiiiisi.

8) Muuda dra nimetused: Earthwork.1 = Lot 1; Earthwork.2 = Lot 2; Earthwork.3 = Lot
3. Vali kastid Lots 1, 2 ning 3 kdrval ning seejérel kliki Generate Cut/Fill Report.
Kuvatakse brauseriaknas detaile mahu analiiiisi raport. Seda nii terviku kui ka iiksikute
kruntide ldikes.

Jargnev nidide kisitleb pinnaobjekti annoteerimist (sildistamist).

1) Ava joonis 18 Labeling Design Surface.dwg. Ulemine, parempoolne vaateaken on
suurendatud kruntidele Jordan Court alguses. Sa lisad sildid just sellesse piirkonda.
2) Valiriba pealt Annotate > Add Labels.
3) Dialoogis Add Labels:
a. Feature = Surface
b. Label Type = Contour-Multiple.
c. Kliki 4dd.
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4) Kui sul palutakse valida pinnaobjekt vali liks punastest vdi sinistest kontuuridest. Sul
palutakse seejirel valida esimene punkt.

5) Vali kaks punkti, mis moodustaksid joone iile kontuuride (krundi 2 mahus).

6) Dialoogis Add Labels muuda Label Type = Contour — Single. Kliki Add.

7) Kui sul palutakse valida pinnaobjekt, vali iiks punastest/sinistest kontuuridest. Seejérel
palutakse valida kontuurjoon.

8) Vali mdned kontuurid Jordan Court sdidutee pinnalt.

9) Dialoogis Add Labels muuda Label Type = Slope. Kliki Add. Sul palutakse valida
pinnaobjekt.

10) Vali iiks punastest/sinistest kontuuridest, et valida pinnaobjekt. Sul voimaldatakse
valida One-Point vdi Two-Point sildistamise vahel.

11) Vajutia ENTER, et valida One-Point séte. Vali krundi 2 eesmises servas olev punkt.
Kalle esitab, et see on suurem kui lubatud 10%. Sellega tegeleme mdnevorra hiljem.

12) Dialoogis Add Labels muuda Label Type = Spot Elevation.

13) Kliki Add ning vali iiks punasest/sinisest kontuurjoonest.

14) Kasutades Endpoint sétet vali krundi ehitise alla jddvad neli nurgapunkti. Kuvatakse
nelja nurga korgusmargid.

15) Vajuta ESC klahvi, et I1dpetada késk. Vali sinine tunnusjoon krundi 2 ehitise osas.
Riba paanil Edit Elevations vali Raise/Lower.

16) Kui sul palutakse valida korguslik erinevus, sisesta -0.691 ning vajuta ENTER. Peale
pinnaobjekti uuendamist uuendatakse ka koikide lisatud siltide infot. Krundi 2 kalle on
niitid ka vdiksem kui 10%.
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Disaini iilekandmine ehitusse

Olles praeguseks ldbinud kdik olulised disaini etapid on aeg keskenduda dokumentatsiooni
loomisele, mis muuhulgas kaasab ka maksumuse analiiiisi. Selles peatiikis keskendume seega
toovahendile Q70 Manager ning lehtede lisamise toovahenditele.

OTO Manager t66tab pea iga AutoCAD ning Autodesk Civil 3D objektiga. Neid komponente
saab siduda kuluallikaga (pay item). Peale kuluallikate lisamist saab kasutada Takeoff kisku, et
kokku lugeda projekti mahud ning kuvada see info iihe raportina.

Loikesse jadvate mahtude kokkuarvestamiseks saab kasutada ka toovahendit Quantity Takeoff
Criteria. Néiteks saab seda kasutada teeehitusmaterjalide kokkuarvestamiseks, mis kaasab nii
asfalti, liivakihti, ddrekivi jne. Need kriteeriumid saab eelsalvestada joonise malli, misjérel saad
edasistes projektides lihtsamini kéivitada Compute Materials késu.

Projekti lopp-faasis on meil vaja disain paigutada paberilehtedele, et seda siis jagada
valjatriikitud kujul voi digitaalselt. Lehti saab luua iihe kaupa voi grupina.
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Tooleht - Disaini iilekandmine ehitusse

Jargnev ndide késitleb mahtude analiiiisi.

1)

2)

3)
4)

S)
6)

7)

8)

9)

Ava joonis 19 Calculating Quantities Using QTO.dwg. Pane tihele, et joonis avaneb
parkla alalt. Samuti pane tdhele valgustite poste. Asfalteeritud alal kasutatakse omaette
viirutust.

Vali riba pealt paan Analyse ning seejarel QTO Manager. Kuvatakse Panorama ning
paan QTO Manager.

Parem klikk Lumen Type A peal ning vali Assign Pay Item.

Paremas iilemises vaateaknas vali kuus valgusti posti ning vajuta ENTER. Joonisel ei
muutu midagi, kuid kuluartikkel on niitid lisatud objektidele.

Panorama > QTO Manager, parem klikk Pavement ning vali Assign Pay Item to
Area.

Kaésureal vali Select Object. Vali viirutus, mis esitab asfalteeritud pinda. Vajuta
ENTER. Késureal peaks kuvatamse, et kuluartikkel 003 lisati pinnale.

Parem klikk Concrete Curb peal, vali Assign Pay Item. Suurenda vaadet parklale ning
vali kaks sinist poliijoont, mis esitavad dédrekivi serva — liks parkla perimeeter ning
teine keskmise saarekese perimeetri.

Vajuta ENTER. Parem klikk Lumen Type A peal, vali Select Objects with Pay Item.
Kontrolli, et kdik 6 valgustiposti oleks valitud.

Korda sammu 8 ka 450mm Concrete Pipe osas. Vasakus vaateaknas pane tdhele, kus
450mm toru on kasutusel.

10) Riba paanil Analyse, vali Takeoff. Kuvatakse dialoog Compute Quantity Takeoff.
11) Veendu, et Report Type = Summary ning vota édra linnuke Report Selected Pay Items

Only. Kliki Compute.

12) Dialoogis Quantity Takeoff Report vali Summary (HTML).xsl. Kuvatakse kokkuvdttev

raport, mis sisaldab nii sinu poolt lisatud kui ka varem lisatud kuluartiklid.

Jargnev ndide késitleb materjalide mahu arvestust Jordan Court sdidutee 1dikes.

1))

2)
3)

4)
5)

6)
7)

8)
9)

Ava joonis 19_Calculating Quantities Using Sections.dwg. See joonis sisaldab
Subdivision Roads koridormudelit ning valimijoonte gruppi Quantities. Sa kasutad just
seda valimijoonte gruppi, et viia ldbi materjalide mahu analiiiis.

Riba pealt vali paan Analyse. Seejarel Compute Materials. Kuvatakse dialoog Select a
Sample Line Group.

Kliki OK, et ndustuda vaikimisi valikutega. Kuvatakse dialoog Compute Materials —
Quantities.

Vali Quantity Takeoff Criteria > Basic Road Materials.

Vali Map Objects with Same Name. Object Name veerg on seejirel tdidetud
koridormudeli kujundite nimetustega.

Kliki OK. Peale pausi kuvatakse kédsureal Command.:. Arvutused on 14bi viidud, kuid
joonisel ei ole miskit muutunud.

Riba paanil Analyse > Volume Report. Kuvatakse dialoog Report Quantities.

Vali kataloogi ikoonil Select a Style Sheet. Kliki Select Material.xsl ning kliki Open.
Kliki OK, et sulgeda dialoog Report Quantities. Sinu brauser avaneb, ning vdidakse
kuvada hoiatus skriptide kdivtamise osas. Kliki Yes, et jitkata. Raport kuvatakse sinu
brauseri aknas, kus nédidatakse iga materjali pindala, mahtu, kogumahtu koikide valimi
joonte juures.

10) Liigu raporti 10ppu ning vaata véartuseid Cum. Vol. Veerus. Tegemist on nelja erineva

materjali summaarsete mahtudega, mis on vajalikud, et ehitada Jordan Court soidutee.
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Jargnev nédide késitleb iildplaani lehe loomist.

1) Avajoonis 19 Creating Individual Sheets.dwg.

2) Tee parem klikk Layoutl peal ning vali From Template. Kuvatakse dialoog Select
Template from File.

3) Vali ndidisfailide kataloog ning seejérel vali Civil 3D (Metric) Plan Only.dwt ning
kliki Open. Kuvatakse dialoog Insert Layout(s).

4) Vali ISO A0 Plan Only I to 750 ning seejarel OK.

5) Vali ISO A0 Plan Only 1 to 750 paberiruum, et teha see aktiivseks. Seejérel tee nime
peal topelt-kldps, muuda kui Overall Plan. Tegemist on hetkel tiihja paberiruumiga.

6) Tee topeltklikk lehe keskel, et aktiveerida vaateaken.

7) Kaésureale triiki ZE ning vajuta ENTER, et suurendada iile terve mudeli. Joonise
objektid peaksid niilid olema néhtaval.

8) Nihuta vaadet nii, et plaaniline vaade tdidaks vaateakna. Pane tdhele kruntide silte, mis
on hetkel liiga suured valitud joonise skaalale.

9) Vali vaateakna skaalaks /:750 (tarkvara akna alumiselt nupuribalt). Vaateakna skaala
muutub kergelt ning kdik sildid kohanduvad uue skaalaga.

10) Riba paanil Home > Layer Properties. Kuvatakse palett Layer Properties Manager.

11) Sektsioonis Filters, kliki All. Seejdrel parem klikk {ihel kihtide nimedest (Name
veerus), vali Select All.

12) Liigu paremale ning kliki ikoonil VP Freeze. See kiilmutab koik kihid antud
vaateaknas.

13) Sektsioonis Filters vali Overall Plan. Parem klikk tihel kihtide nimedest (Name
veerus), vali niitid Select All.

14) Vali mistahes rea ikoon veerus VP Freeze, seejirel sulge Layer Properties Manager
palett. Sul on niitid veidi lihtsustatud vaateakna esitus, mis annab projektist koige
tilevaatlikuma pildi.

Jargnev néide kisitleb plaaniliste ning profiili lehtede loomist Jordan Court mahus 1dbi vaate
raamide.

1) Avajoonis 19 _Creating View Frames.dwg.

2) Vali riba paan Output, seejarel Create View Frames. Kuvatakse dialoogide jada.

3) Esimeses dialoogis: Create View Frames — Alignment vali telgjoon Jordan Court,
seejarel kliki Next. Kuvatakse dialoog Create View Frames — Sheets.

4) Vali nupp Template for Plan and Profile Sheet real. Kuvatakse dialoog Select Layout
as Sheet Template.

5) Vali nupp Drawing Template File Name. Kuvatakse dialoog Select Layout as Sheet
Template.

6) Vali néidisfailide kataloog ning seejérel fail Civil 3D (Metric) Plan and Profile.dwt.
Kliki Open.

7) Vali leht ISO A0 Plan and Profile 1 to 250 ning kliki OK. Taas oled dialoogis Create
View Frames — Sheets.

8) Kliki Next. Jargi sétteid dialoogis Create View Frames — View Frame Group. Vajuta
Next.

9) Jargi sitteid dialoogis Create View Frames — Match Lines. Kliki Next.

10) Jargi sétteid dialoogis Create View Frames — Profile Views. Kliki Create View
Frames. Luuakse neli vaate raami, mis paiknevad Jordan Court telgjoone iimber.

11) Vali iiks vaate raamidest, seejdrel vali teemandikujuline objektipunkt, mis paikneb
raami keskosas. Liiguta kursorit piki telgjoont ning pane téhele, kuidas raam piiiiab
jargida telgjoone kulgemist.
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12) Katseta ka nelinurkse ning ringjoone kujulist objektipunkti. Nelinurkne objektipunkt
voimaldab raami muuta mistahes suunas. Ringjoone kujuline objektipunkt voimaldab
pOdrata vaate raami selle keskpunkti suhtes. Jargnevas ndites on vaate raame veidi
korrigeeritud, et lehtede loomine oleks optimaalseim. Just neid eelnimetatud
objektipunkte kasutati ka jdrgneva ndite ettevalmistamisel.

Jargne niide kasitleb plaaniliste ning profiili lehtede loomist olemasolevate vaate raamide
baasil.

1) Avajoonis 19 _Creating Sheets.dwg.

2) Vali riba pealt paan Output. Seejérel Create Sheets. Kuvatakse dialoogide jada, millest
esimene on: Create Sheets — View Frame Group and Layouts.

3) Veendu, et oleks valitud site All Layouts in Current Drawing (sektsioonis Layout
Creation) ning sektsioonis Choose the North Arrow Block to Align in Layouts =
North. Kliki Next.

4) Vaata sitteid dialoogis Create Sheets — Sheet Set. Pane tihele, et kdsk Create Sheets
sobitub AutoCAD Sheet Set Manager funktsionaalsusega. See vdimaldab sul loodavaid
lehti talletada mdnes lehegrupis nende paremaks haldamiseks.

5) Vajuta Next. Kuvatakse dialoog Create Sheets — Profile Views.

6) Sektsioonis Other Profile View Options vali Choose Settings. Seejérel vali Profile
View Wizard. Kuvatakse dialoog Create Multiple Profile Views — Profile View Height.

7) Muuda Profile View Datum by site kui Mean Elevation. Kliki Next.

8) Dialoogis Create Multiple Profile Views — Profile Display Options keri paremale
poole kuniks nded veergu Labels. Profiili Jordan Court FGCL osas vali Curves-
Grades-Breaks sildigrupp. EG — Surface (11) osas vali _No Labels sildigrupp.

9) Kliki Finish, et naasta dialoogi Create Sheets — Profile Views.

10) Kliki Create Sheets. Kuvatakse hoiatus, et sa pead joonise enne salvestama. Kliki OK.

11) Kui sinult kiisitakse profiili vaate alguspunkti, vali punkt joonise {ilemises tiihjas alas.
Luuakse neli uut profiili vaadet iihes nelja uue paberiruumi paaniga. Avatakse ka
Sheet Set Manager palett, mis samuti kuvab neli paberilehte koos vastavate
nimetustega.

12) Vali esimene vérskelt loodud paberiruum. Pane téhele, kuidas paberiruum on
automaatselt {iles ehitatud, ndidates {ilemises osas plaanilist vaadet ning alumises osas
vastavat profiili.

13) Vaata ka iilejaénuid paberiruumi vaateid. Pane tdhele, kuidas koikide kruntide sildid
on suunaga lilesse poole ja seda sdltumata nende orientatsioonist plaanilisel vaatel.
Seda reguleerib pindala sildi stiil, mida hetkel kasutatakse.
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